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Important
Urmatoarele functii sunt doar pentru referinta. Este posibil ca unele produse de serie sa nu suporte toate functiile
enumerate mai jos.

Recomandari privind securitatea cibernetica

1. Schimbati parolele si folositi parole puternice

Motivul numarul unu pentru care sistemele sunt "sparte" se datoreaza parolelor slabe sau implicite. Se
recomanda schimbarea imediatd a parolelor implicite si alegerea unei parole puternice ori de cate ori este
posibil. O parola puternica ar trebui sa fie formata din cel putin 8 caractere si o combinatie de caractere
speciale, cifre si litere majuscule si minuscule.

2. Actualizarea firmware-ului
Asa cum este procedura standard in industria tehnologica, va recomandam sa actualizati firmware-ul NVR,
DVR si al camerelor |P pentru a va asigura ca sistemul este actualizat cu cele mai recente patch-uri si solutii

de securitate.

Recomandari pentru imbunatatirea securitatii retelei dvs.

1. Schimbati parolele in mod regulat
Schimbati in mod regulat acreditarile dispozitivelor dvs. pentru a va asigura ca numai utilizatorii autorizati pot
accesa sistemul. https://www.ultramaster.ro /camere-supraveghere-ip

2. Modificarea porturilor HTTP si TCP implicite:

° Modificati porturile HTTP si TCP implicite pentru sisteme. Acestea sunt cele doua porturi utilizate pentru a
comunica si pentru a vizualiza fluxurile video de la distanta.

° Aceste porturi pot fi modificate la orice set de numere intre 1025-65535. Evitarea porturilor implicite
reduce riscul ca persoane din exterior sa poata ghici porturile pe care le utilizati.

3. Activati HTTPS/SSL.:
Configurati un certificat SSL pentru a activa HTTPS. Acest lucru va cripta toate comunicatiile dintre dispozitivele
dvs. si NVR.

4. Activati filtrul IP:
Activarea filtrului IP va Tmpiedica accesul la sistem al tuturor, cu exceptia celor cu adresele IP specificate.

5. Schimbati parola ONVIF:

La firmware-ul mai vechi al camerei IP, parola ONVIF nu se modifica atunci cand schimbati datele de
identificare ale sistemului. Va trebui fie sa actualizati firmware-ul camerei la cea mai recenta revizuire, fie sa
modificati manual parola ONVIF.

www.ultramaster.ro v
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6. Transmiteti numai porturile de care aveti nevoie:

° Transmiteti numai porturile HTTP si TCP pe care trebuie sa le utilizati. Nu redirectionati o gama larga de
numere catre dispozitiv. Nu DMZ adresa IP a dispozitivului.

° Nu trebuie sa redirectionati niciun port pentru camerele individuale daca toate sunt conectate la un
recorder la fata locului; este necesar doar NVR-ul.

7. Dezactivati Auto-Login pe SmartPSS:

Cei care utilizeaza SmartPSS pentru a-si vizualiza sistemul si pe un computer care este utilizat de mai multe
persoane ar trebui sa dezactiveze autentificarea automata. Acest lucru adauga un nivel de securitate pentru a
preveni accesul la sistem al utilizatorilor care nu detin acreditarile corespunzatoare.

8. Utilizati un nume de utilizator si o parola diferite pentru SmartPSS:

in cazul in care contul dvs. de social media, bancar, de e-mail etc. este compromis, nu ati dori ca cineva s&
colecteze parolele respective si sa le incerce pe sistemul dvs. de supraveghere video. Utilizarea unui nume
de utilizator si a unei parole diferite pentru sistemul dvs. de securitate va face mai dificil pentru cineva sa
ghiceasca intrarea in sistem.

9. Limitarea functiilor conturilor de invitati:
Daca sistemul dvs. este configurat pentru mai multi utilizatori, asigurati-va ca fiecare utilizator are drepturi
numai la caracteristicile si functiile pe care trebuie sa le utilizeze pentru a-si desfasura activitatea.

10. UPnP:

° UPNP va incerca automat sa redirectioneze porturile in router sau modem. Tn mod normal, acesta ar fi
un lucru bun. Cu toate acestea, daca sistemul dvs. redirectioneaza automat porturile, iar dvs. |asati acreditarile
predefinite, s-ar putea s& va treziti cu vizitatori nedoriti.

° Daca ati redirectionat manual porturile HTTP si TCP in routerul/modemul dvs., aceasta functie ar trebui
sa fie dezactivata oricum. Dezactivarea UPnP este recomandata atunci cand functia nu este utilizata in aplicatii
reale.

11. SNMP:
Dezactivati SNMP daca nu il utilizati. Daca utilizati SNMP, ar trebui sa faceti acest lucru doar temporar, doar in
scopuri de urmarire si testare.

12. Multicast:

Multicast este utilizat pentru partajarea fluxurilor video intre doud inregistratoare. in prezent, nu exist& probleme
cunoscute care sa implice Multicast, dar daca nu utilizati aceasta caracteristica, dezactivarea va poate spori
securitatea retelei.

www.ultramaster.ro
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13. Verificati jurnalul:

Daca suspectati ca cineva a obtinut acces neautorizat la sistemul dumneavoastra, puteti verifica jurnalul
sistemului. Jurnalul sistemului va va arata ce adrese IP au fost utilizate pentru a va conecta la sistem si ce a fost
accesat.

14. Blocati fizic dispozitivul:

In mod ideal, doriti s& impiedicati orice acces fizic neautorizat la sistemul dvs. Cel mai bun mod de a realiza acest
lucru este sa instalati Tnregistratorul intr-o cutie de blocare, intr-un rack de servere cu inchidere sau intr-o camera
care se afla in spatele unui lacét si a unei chei.

15. Conectarea camerelor IP la porturile PoE de pe spatele unui NVR:
Camerele conectate la porturile PoE de pe spatele unui NVR sunt izolate de lumea exterioara si nu pot fi
accesate direct.

16. Izolati NVR si reteaua de camere IP

Reteaua pe care se afla NVR-ul si camera IP nu trebuie sa fie aceeasi cu reteaua publica de calculatoare.
Acest lucru va impiedica orice vizitator sau oaspete nedorit sa aiba acces la aceeasi retea de care sistemul
de securitate are nevoie pentru a functiona corect.

Siguranta electrica
® Toate operatiunile de instalare si functionare trebuie sa fie conforme cu codurile locale de siguranta
electrica.

® Sursa de alimentare trebuie sa fie conforma cu cerintele standardului SELV (Safety Extra Low Voltage) si
sa furnizeze energie cu tensiune nominala de 12 V DC sau 24 V AC in conformitate cu cerintele privind
sursa de alimentare limitata din IEC60950-1. Va rugam sa retineti ca cerinta privind sursa de alimentare
este supusa etichetei dispozitivului.

® Asigurati-va ca sursa de alimentare este corecta Tnainte de a utiliza dispozitivul.

Un dispozitiv de deconectare usor accesibil trebuie sa fie incorporat n instalatia electrica a cladirii

® FEvitati ca cablul de alimentare sa fie calcat in picioare sau presat, in special fisa, priza si jonctiunea
extrudata din dispozitiv.

® Nu ne asumam nicio raspundere sau responsabilitate pentru toate incendiile sau socurile electrice
cauzate de manipularea sau instalarea necorespunzatoare.

Mediul inconjurator
® Nu indreptati dispozitivul spre o lumina puternica pentru a focaliza, cum ar fi lumina lampii si lumina

soarelui, altfel ar putea provoca luminozitate excesiva sau urme de lumina, care nu sunt defectiuni ale
dispozitivului, si ar putea afecta longevitatea dispozitivului cu cuplaj de sarcina (CCD) sau a
semiconductorului complementar metal-oxid (CMOS).
® Nu amplasati dispozitivul intr-un mediu umed sau prafuit, la temperaturi extrem de ridicate sau scazute
sau in locuri cu radiatii electromagnetice puternice sau iluminat instabil.
® Tineti camera departe de apa sau alte lichide pentru a evita deteriorarea componentelor interne.
www.ultramaster.ro vii
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Pastrati dispozitivul de interior departe de ploaie sau umezeala pentru a evita incendiile sau fulgerele.
Mentineti o ventilatie buna pentru a evita acumularea de céaldura.

Transportati, utilizati si depozitati dispozitivul in intervalul de umiditate si temperaturd permise.

Tn timpul transportului, depozitarii si instalarii nu sunt permise solicitari intense, vibratii violente sau stropi
de apa.

Tmpachetat,i dispozitivul cu ambalajul standard din fabrica sau cu un material echivalent atunci cand
transportati dispozitivul.

www.ultramaster.ro
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1 Prezentare generala a produsului
Modul comun de retea pentru IPC este conectarea IPC la PC prin intermediul unui comutator sau router. Modul
comun de retea este prezentat in figura 1-1.

Cable*""""w’:é
[ Cable

Switch or Router

‘/,.r or i |
= \ 4 o 5

IPC pC

Figura 1-1

Tnainte de a avea acces la camera de retea prin Internet, trebuie sa obtineti adresa IP a acesteia. Utilizatorii pot
cauta adresa IP a camerei de retea prin intermediul Quick Config Tool.

www.ultramaster.ro
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2 Configuratie initiala
Tn acest capitol se introduce operatiunea de configurare initiald a dispozitivului, care include initializarea
dispozitivului, conectarea dispozitivului, deconectarea de la interfata WEB si resetarea parolei.

2.1 Initializarea dispozitivului

Acesta trebuie sa implementeze initializarea dispozitivului atunci cand utilizati dispozitivul pentru prima data. Aici se
va lua ca exemplu operatiunea WEB pentru a introduce initializarea dispozitivului. De asemenea, puteti initializa
dispozitivul prin Quick Config Tool, NVR si platforma etc.

Nota

Pentru a garanta siguranta dispozitivului, va rugam sa pastrati parola de conectare a administratorului Th mod
corespunzator dupa initializarea dispozitivului si sa modificati parola in mod regulat.

Pasul 1

Deschideti browserul IE, introduceti adresa IP a camerei in bara de adrese si faceti clic pe Enter.

Sistemul va afisa interfata de inifializare a dispozitivului dupa ce este conectat cu succes, care este prezentatd in
Figura 2-1.

Nota

Adresa IP implicita este 192.168.1.108.

Device Initialization

Username admin

Password | The minimum pass phrase length is 8 characters

Confirm Password

Use a passwaord that has 8 to 32 characters, it can be a combination of letter(s),
number(s) and symbol{s) with at least two kinds of them.(please do not use
special symbols like "™ &)

[¥] Email Address
Toreset password, please input properly or update in time.

Figura 2-1

Pasul 2
Acesta este pentru a seta parola de conectare a administratorului, consultati Tabelul 2-1 pentru mai multe detalii.

www.ultramaster.ro 2
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Parametru Nota
Numele Numele de utilizator implicit este admin
utilizatorului
Parola Parola are intre 8 si 32 de cifre. Aceasta poate contine litere, cifre si caractere
] ] speciale (cu exceptia "","",";",":","&") . Parola trebuie sa contina cel putin doua
Confirmati categorii. De obicei, recomandam parola puternica.
parola
Introduceti o adres& de e-mail pentru resetarea parolei. In cazul in care uitati parola
E-mail in viitor, introduceti codul de securitate pe care I-ati primit pe e-mailul atribuit pentru
a reseta parola de administrator.
Tabelul 2-1
Pasul 3

Faceti clic pe Salvare.
Sistemul va afisa interfata Acordului de licenta pentru utilizatorul final, care este prezentata in Figura 2-2.

End-User License Agreement

Zhejiang Diahua Technologies Co. Ltd. Software End User License Agreement -
1. NOTICE
IMPORTANT NOTICE. PLEASE READ CAREFULLY: This Zhejiang Dahua Technology Co. LTD (Dahua) License Agreement
(Agreement) sets forth the terms and conditions under which You are licensed to use the Software. By installing, copying,
downloading the Software or using the same by any other means, you are deemed to have accepted this Agreement. If you do not
agree with itin whole orin par, you do not have the rightto use this Software, in which case you should immediately stop installing,
copying the Software or using the same by any other means.
2. DEFINITIONS
‘Software’ means information management programi(s) or supporting document{s) consisting of several modules or functions.
Supporting document(s) includes all or part of the source codes and object codes of the Software, as well as the images,
photographs, icons, animations, audio, video, music, words and codes incorporated therein; it also includes all relevant paper or
| electronic information and technical documentation which describe the functions, characteristics, contents, quality, tests, customer

manuals nseranreemente pte MSofiware Prodoct o 'Sofhaare’

|

[7] I have read and agree to all terms

Figura 2-2

Pasul 4
Selectati Am citit si sunt de acord cu toti termenii si faceti clic pe Urmatorul.
Sistemul va afisa interfata Easy4iP, care este prezentata in Figura 2-3.
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Easy4ip

V] Easydip
Register device to EASY4IP and then suitable for user to apply for cloud account. It can realize cloud service such as remote

surveillance, device record, alarm, cloud storage, using device to manage cloud.

Scan and Download EASY4IP APP

Figura 2-3

Pasul 5
Selectati Easy4iP in functie de nevoile reale si realizati inregistrarea Easy4iP pentru dispozitiv, faceti clic pe
urmatorul. Sistemul va afisa interfata de actualizare online, care este prezentata in Figura 2-4

Online Upgrade

[] Auto-check for updates

Motify automatically when updates available. The system checks for updates every day.
Online Upgrade is a service that provides you with firmware updates by cloud. This senvice will collect device information in order to

infarm you about available firmware updates. Such information may include your device name, firmware version and device
identification numbers. Such information is processed for the sole purpose of informing you about firmware updates.

Save

Figura 2-4

Pasul 6
Este de a stabili metoda de actualizare in functie de cerintele reale.
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TECHNOLOGY

Selectati Auto-check for upgrade (Verificare automaté pentru actualizare) si sistemul va verifica o data pe zi in
mod automat atunci cand exista o solicitare de actualizare a sistemului. Nota

Dupa conectare, puteti face setarile in "Configurare > Sistem > Actualizare > Actualizare online".

Pasul 7
Faceti clic pe Salvare si initializarea dispozitivului este finalizata.

2.2 Conectare si deconectare

Aici se introduce conectarea dispozitivului si deconectarea interfetei WEB prin intermediul browserului, luand IE

Explorer 8 ca exemplu pentru a face introducerea.

2.2.1 Autentificare in interfata WEB

Utilizatorii pot efectua operatiuni precum live, redare si configurare pe dispozitiv dupa conectarea la interfata WEB

a dispozitivului prin intermediul browserului.

Nota

® Se poate conecta la interfata WEB dupa finalizarea initializarii dispozitivului.

® Se va solicita instalarea plug-in-ului atunci cand va conectati la sistem pentru prima data, va rugam sa
descarcati si sa instalati plug-in-ul conform solicitarii.

Pasul 1

Deschideti browserul IE, introduceti adresa IP a camerei in bara de adrese si faceti clic pe butonul Enter.

Dupa conectarea cu succes, sistemul va afisa interfata Login, prezentata in Figura 2-5.

Lisername:
FPassword; Forgot password?
Login Cancel
Figura 2-5
Pasul 2
Introduceti parola utilizatorului admin.
Pasul 3
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Faceti clic pe Conectare.

Acesta va afisa interfata Live dupa ce s-a conectat cu succes, care este prezentata in Figura 2-6.
Nota

Functiile si interfata pot varia in functie de dispozitiv; consultati interfata dispozitivului pentru detalii exacte.

Figura 2-6

2.2.2 lesire

Faceti clic pe Logout si reveniti la interfata de conectare WEB. Dupa conectarea la dispozitivul WEB, sistemul va
intra automat Tn hibernare daca nu functioneaza dispozitivul pentru o perioada de timp. Acesta poate reveni rapid
la starea normala de functionare dupa introducerea parolei.

2.3 Resetarea parolei

Utilizatorii pot reseta parola prin e-mail rezervat atunci cand uita parola de utilizator admin.

Pasul 1

Deschideti browserul |IE, introduceti adresa IP a camerei in bara de adrese si faceti clic pe butonul Enter.
Dupa conectarea cu succes, sistemul va afisa interfata Login, prezentata in Figura 2-7.
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TECHNOLOGY

LIsername:

Fassward; Forgot password?

Login Cancel

Figura 2-7

Pasul 2
Faceti clic pe Parola uitata?
Sistemul va afisa interfata de resetare a parolei, care este prezentata in Figura 2-8.

Reset the password(1/2)

SN 2C04ABIYAZO0019

QR code;

Note(For admin only):

Option 1. Please download Easydip and then from
Me-Setlings-Reset device password, scan the left
OR code

Option 2. Please use an APP to scan the lefl QR
code to get special strings. And then send the
strings to support_rpwd@global.dahuatech.com

The security code will be delivered to 1***@qqg.com

Security code;

Cancel | | Mext |

Figura 2-8

Pasul 3
Resetati parola de conectare.
Scanati codul QR Tn conformitate cu solicitarea interfetei si obtineti codul de securitate, apoi introduceti codul de

securitate primit prin e-mailul rezervat.
Atentie

www.ultramaster.ro
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® Varugam sa utilizati codul de securitate pentru a reseta parola in termen de 24 de ore de la primirea codului
de securitate prin e-mailul dvs. rezervat. In caz contrar, codul de securitate va fi invalidat.

® Daca nu reusiti sa utilizati codul de securitate de doua ori in mod continuu, atunci sistemul va indica faptul ca
nu reuseste sa obtina codul de securitate pentru a treia oara. Acesta are nevoie de hardware pentru a restabili
setarile implicite ale dispozitivului si pentru a achizitiona din nou codul de securitate sau pentru a astepta 24 de
ore si pentru a-l achizitiona din nou daca trebuie sa utilizeze dispozitivul ih mod normal.

Pasul 4
Faceti clic pe urmatorul.
Sistemul va afisa interfata in care puteti seta noua parola, care este prezentata in Figura 2-9.

Reset the password(2/2)

Username admin

Password

Use a password that has 8 to 32 characters, it
can be a combination of letter(s), number(s) and
symbol(s) with at least two kinds of them.

(please do notuse special symbols like "™, &)

Confirm Password

Cancel | | Save

Figura 2-9

Pasul 5

Resetati parola si Confirmati parola.

Parola variaza intre 8 si 32 de cifre. Aceasta poate contine litere, cifre si caractere speciale

(cu exceptia "",""",";",":","&") . Parola trebuie s& contina cel putin doua categorii. De obicei, recomandam o parola
puternica.

Pasul 6

Faceti clic pe Salvare si finalizati resetarea parolei.

Sistemul va afisa interfata de conectare.

3 Live

Dupa ce v-ati conectat, puteti vedea fereastra monitorului live. Consultati Figura 3-1.

www.ultramaster.ro 8
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@Jhua

supsream1 | ubsreams [ACEmyTce |

oo 3 $o & ©

Figura 3-1

Exista patru sectiuni:

Sectiunea 1: Bara de configurare a codarii
Sectiunea 2: Meniul sistemului

Sectiunea 3: Bara de optiuni a functiei ferestrei
Sectiunea 4: Bara de reglare a ferestrei
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3.1 Configurarea codarii

Nota: Unele serii nu accepta sub stream 2.
Interfata de configurare a codarii este prezentata in Figura 3-2.

Sub Stream 1 Sub Stream 2 REfdoles] m

Figura 3-2

V& rugdm sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru

Functia

Flux principal

Faceti clic pe acesta pentru a activa monitorizarea video a fluxului
principal si faceti clic din nou pentru a o dezactiva. In general, pentru
stocare si monitorizare.

Sub fluxul 1

Faceti clic pe acesta pentru a activa monitorizarea video Sub Stream1
si faceti clic din nou pentru a o dezactiva. Atunci cand latimea de banda
a retelei este insuficienta, aceasta inlocuieste fluxul principal pentru
monitorizare.

Sub fluxul 2

Faceti clic pe acesta pentru a activa monitorizarea video Sub Stream 2
si faceti clic din nou pentru a o dezactiva. Atunci cand latimea de banda
a retelei este insuficientd, aceasta inlocuieste fluxul principal pentru
monitorizare.

Protocol

Puteti selecta protocolul media stream din lista derulanta. Exista trei
optiuni: TCP/UDP/Multicast

3.2 Meniul Sistem

Meniul Sistem este prezentat ca in Figura 3-3.

Pentru informatii detaliate, consultati capitolul 2 Live, capitolul 3 PTZ, capitolul 4 Playback, capitolul 5 Setup,

capitolul 6 Alarma, capitolul 7 Log out.

[ e T pm ] pawack | sewp ] aam ] Logour |

Figura 3-3

3.3 Optiunea functiei ferestrei video

Interfata este prezentatd mai jos. A se vedea figura 3-4.

1 2 3 4 5 6 789

™ B 8®

Figura 3-4

www.ultramaster.ro
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Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

SN Parametru Functia
1 Relay-out Acesta arata daca exista vreo iesire de alarma, descrierea starii este
dupa cum urmeaza:
® Rosu: inseamna ca exista iesire de alarma.
® Gri: Inseamna ca alarma s-a incheiat.
Faceti clic pe buton pentru a forta activarea sau dezactivarea
alarmei.
2 Digital ® Cand videoclipul se afla in starea originala, faceti clic pe el si
Zoom puteti selecta orice zona pentru a mari. In starea non-originala,
puteti glisa zona de zoom in intervalul specificat. Faceti clic
dreapta pe mouse pentru a restabili starea anterioara.
® Faceti clic pe el; puteti utiliza butonul din mijloc al mouse-ului
pentru a mari sau micsora dimensiunea videoclipului.
3 Instantaneu Faceti clic pe butonul pentru instantanee, salvati imaginea in cale in
Cap. 5.1.2.5.
4 Triplu Dati clic pe acesta pentru a realiza o fotografie instantanee a
Instantaneu imaginii video la frecventa de o imagine pe secunda. Toate imaginile
sunt salvate in calea din cap. 5.1.2.5.
5 Inregistrare Faceti clic pe acesta pentru a inregistra inregistrarea video. Toate
inregistrarile video sunt salvate in calea din capitolul 5.1.2.5.
6 Focalizare Faceti clic pe el, puteti vedea ca existd doi parametri pe
usoara previzualizarea video : AF Peak si AF Max.
AF Peak: Afiseaza definitia video n timpul procesului de focalizare.
AF Max: Este cea mai potrivita valoare pentru definitia video. Cu cat
AF Peak si AF Max sunt mai apropiate, cu atat efectul de focalizare
este mai bun.
7 Audio Activati sau dezactivati audio atunci cand monitorizati.
8 Discutii Faceti clic pe acesta pentru a ihcepe sau a incheia conversatia
bidirectionala.
9 Ajutor Faceti clic pe acesta pentru a deschide fisierul de ajutor.

3.4 Configurarea ferestrei video

Interfata este prezentata ca in Figura 3-5.

www.ultramaster.ro
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Figura 3-5

3.4.1 Ajustarea imaginii
Consultati Figura 3-6 pentru ajustarea imaginii.

mage Adjustment

Figura 3-6

Faceti clic pe acest buton pentru a afisa/ascunde interfata de control al imaginii. Faceti clic pe acesta pentru a
deschide interfata de configurare a imaginii. Aceasta interfata este in panoul din dreapta sus.
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru Functia
Configurare Se regleaza luminozitatea Nota:
video p video a monitorului. ® Toate operatiunile de aici se

aplica numai capatului WEB.
® Vi rugam sa accesati
Configurare>Camera->Conditii
pentru a regla elementele
corespunzatoare.

Se regleaza contrastul video
al monitorului.

Acesta este pentru a regla
nuanta video a monitorului.

Acesta este pentru a regla
saturatia video a monitorului.

www.ultramaster.ro
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Resetare| Restaurati luminozitatea,
saturatia contrastului si nuanta
la setarile implicite ale
sistemului.

3.4.2 Dimensiunea originala
Faceti clic pe acest buton pentru a trece la dimensiunea originala. Acesta afiseaza dimensiunea reala a fluxului
video. Aceasta depinde de rezolutia fluxului de biti.

3.4.3 Ecran complet

Faceti clic pe el pentru a trece la modul ecran complet. Faceti dublu clic pe mouse sau faceti clic pe butonul Esc
pentru a iesi din modul ecran complet.

3.4.4 Raportul dintre latime si inaltime
Faceti clic pe acesta pentru a restabili raportul original sau fereastra corespunzatoare.

3.4.5 Ajustarea fluentei
Exista trei niveluri de fluenta pe care le puteti selecta (Timp real, Normal si Fluent&). Nivelul implicit este normal.

3.4.6 Informatii despre reguli

Faceti clic pe buton, imaginea de previzualizare va afisa regulile inteligente dupa activare; ih mod implicit este
"activat".

3.4.7 Zoom si focalizare

Faceti clic pe acest buton si interfata de marire a focalizarii apare in partea dreapta a interfetei de previzualizare,
dupa cum se arata in Figura 2-7, faceti clic pe butonul stang al mouse-ului pentru a regla configurarea maririi
focalizarii.

Nota:

- Seria de produse care accepta zoom motorizat, focalizare sincrona si focalizare Thapoi are acest buton.

- Focalizare automata dupa reglarea zoom-ului si a focalizarii.

3.4.8 Fisheye/Trigger Track

Faceti clic pe buton, modul de instalare si interfata modului de afisare vor aparea in partea dreapta a interfetei de
previzualizare, a se vedea Figura 3-7 si Figura 3-8, si un singur clic pentru a comuta diferite moduri de instalare si
moduri de afisare pentru fisheye, sau pentru a comuta diferite moduri de afisare pentru pista de declansare, este
activat implicit.

Nota:

Acesta este acceptat doar de unele modele.
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ZLoom and Focus

Speed

Mear

&+ Auto Focus
Restore All
Refresh

Regional Focus

Figura 3-7
Parametru Functia
Reglati distanta focala a obiectivului facand clic sau apasand lung butoanele "+""-".
Zoom Viteza este utilizatd pentru a regla lungimea unui pas in timpul unui singur clic.
Reglati claritatea obiectivului facand clic sau apasand lung butoanele"+", "-"
Concentrare Lungimea pasului este utilizatd pentru a regla lungimea unui pas cu un singur clic.
Faceti clic pentru a ajusta automat definitia imaginii.
Autofocus Nota:

Tn timpul procesului de autofocus nu sunt permise alte operatii ale obiectivului.

Resetati toate

Resetati lentila la pozitia zero pentru a elimina eroarea acumulata a lentilei.

Nota:

Va rugam sa resetati atunci cand ajustarea imaginii nu este clard sau cand operati focalizarea
zoomului de mai multe ori.

Reimprospatare

Sincronizati locatia glisorului de glisare a obiectivului si a focalizarii zoomului dupa focalizarea
zoomului hardware.

Focus regional

Faceti clic pe el si utilizati mouse-ul pentru a selecta o zona, apoi dispozitivul se poate focaliza
automat in regiunea specifica.
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Montare in tavan Montare pe perete Montare la sol

Installation Mode
o

-

Display Mode

m

o

Installation Mode Installation Mode

-
oSO

NI

Figura 3-8

parametru

Nota

Mod de instalare

Trei moduri care sunt montare pe tavan, montare pe perete si montare la sol.

Modul de afisare

Reprezintd modul de afisare a imaginii curente (implicit accepta modul de imagine
originald), modurile de afisare pot fi diferite in functie de diferitele moduri de instalare.
Acesta este prezentat dupa cum urmeaza:

e Plafon: 1P+1, 2P, 1+2, 143, 1+4, 1P+6, 1+8,
o Perete: 1P, 1P+3, 1P+4, 1P+8,

e Ground: 1P+1, 2P, 143, 1+4, 1P+6. 1+8,
Nota:

Modul implicit afiseazéd modul imagine originala atunci cand se schimba modul de
instalare.

Plafon/perete/gazon

O Mentioneaza imaginea originala fara dewarpping
Imagine

originala

www.ultramaster.ro 15
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n tavan/Ground

1P+1

360° Panorama dreptunghiulara extinsa + subimagine
independentd, subimaginea si subboxul din panorama
dreptunghiulara extinsd suportd zoom si miscare, pentru
panorama dreptunghiulara extinsa suporta, de asemenea,
miscarea punctului de plecare stanga si dreapta.

il

2P

Doua imagini dreptunghiulare extinse la 180°, doua ferestre
secundare formeaza o panorama de 360° in orice moment,
care se mai numeste si "panoraméd dublad". Doud imagini
dreptunghiulare extinse suporta ambele puncte de plecare ale
miscarii stanga si dreapta, care sunt, de asemenea, legate
intre ele.

Q]

1+2

Imagine originala + 2 imagini secundare independente, atat
imaginea secundara, cat si caseta secundara din imaginea
originald suportd zoom si miscare. Imaginea originala
accepta, de asemenea, schimbarea punctului de plecare prin
rotatie (nu exista un astfel de mod de afisare pentru instalarea
la sol).

143

Imagine originala + 2 imagini secundare independente, atat
imaginea secundara, cat si caseta secundarad din imaginea
originald suportd zoom si miscare. Imaginea originala
suporta, de asemenea, schimbarea punctului de pornire prin
rotatie

1+4

Imagine originala + 4 imagini secundare independente, atat
imaginea secundara, cat si caseta secundara din imaginea
originald suportd zoom si miscare. Imaginea originala
suporta, de asemenea, schimbarea punctului de pornire prin
rotatie

1P+6

360° panorama dreptunghiulara extinsa +6 subimagini
independente, atadt subimaginea, cat si subboxul din
panorama dreptunghiulara extinsa suportd zoom si miscare,
pentru panorama dreptunghiulara extinsa suporta, de
asemenea, miscarea punctului de plecare stanga si dreapta.

parametru

Nota

o

1+8

Imagine originala + 8 imagini secundare independente, atat
imaginea secundara, cat si caseta secundara din imaginea
originald suportd zoom si miscare. Imaginea originala
suporta, de asemenea, schimbarea punctului de pornire prin
rotatie

Perete

1P

De la stédnga la dreapta Panorama dreptunghiulara extinsa la
180°, care accepta miscarea in sus si in jos si modifica
unghiul de vizualizare vertical.
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Panorama dreptunghiulara extinsa la 180° + 3 imagini
secundare independente, atat imaginile secundare, cat si
caseta secundara din panorama dreptunghiulard extinsa
suportd zoom si miscare, panorama dreptunghiulara extinsa
suportad miscare in sus si in jos si modifica unghiul vertical de
vizualizare.

1P+4

Panorama dreptunghiulara extinsa la 180° + 4 imagini
secundare independente, atat imaginile secundare, cat si
caseta secundara din panorama dreptunghiulara extinsa
accepta zoom si miscare, panorama dreptunghiulara extinsa
accepta miscare in sus si in jos si modifica unghiul vertical de
vizualizare.

1P+8

Panorama dreptunghiulara extinsa la 180° + 8 imagini
secundare independente, atat imaginile secundare, cat si
caseta secundara din panorama dreptunghiulara extinsa
accepta zoom si miscare, panorama dreptunghiulara extinsa
accepta miscare Tn sus si In jos si modifica unghiul vertical de
vizualizare.

Display Mode

B R

PSS

Figura 3-9

Activati urmarirea declansarii pe interfata firului declansator sau a intruziunii si trasati regula firului declansator sau
a intruziunii, scena ferestrei de urmarire a declansarii se va schimba in functie de obiectul in miscare atunci cand
declanseaza alarma regulii pana cénd obiectul Th miscare dispare din raza de vizibilitate a camerei. V& rugam sa
consultati "5.3.4 IVS" pentru mai multe detalii despre trasarea regulilor si configurarea parametrilor pentru fir de
declansare si intruziune. Pista de declansare include trei moduri care sunt 1P, 1P+3 si 1P+5.

= 1 1P: Imagine originala

o . 1P+3: Imagine originala si trei ferestre de urmarire a declansatorului, poate ajusta locatia si

dimensiunea a trei ferestre de urmarire a declansatorului pe imaginea originala.

o | 1P+5: imaginea originala si cinci ferestre de urmarire a declansarii, se poate regla locatia si

dimensiunea

cinci ferestre cu sine de declansare pe imaginea originala.
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4 Control PTZ

Aici puteti vizualiza tastele de directie, viteza, zoom, focalizare, diafragma, presetare, tur, scanare, model, aux
on, off si butonul de configurare PTZ. Nota

Tnainte de operarea PTZ, va rugam sa va asigurati c& ati setat corect protocolul PTZ. (Va rugdm sa consultati Cap.
5.5.3).

Tn prezent, numai produsele din seriile IPC-HFXXXX si -PT pot suporta functia PTZ.
Parametru Nota

Directia PTZ P'[Z accgpta opt directii: stinga / dreapta / sus / jos / sus stdnga / sus dreapta / jos
’ stanga / jos dreapta.

Acesta controleaza viteza de rotatie. Cu cat este mai mare lungimea pasului, cu atat este

Viteza mai mare viteza. Lungimea pasului controleaza PTZ, zoomul, focalizarea si irisul.
Utilizati mouse-ul pentru a desena o cutie In video de monitorizare, PTZ se va roti si se
. ... | vaconcentra pentru pozitionarea rapida.
Pozitie rapida

PTZ Seftings

Scan

Figura 4-1
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FTZ Settings

Figura 4-2

Interfata de setare PTZ este prezentata ca in Figura 4-3.
Aici puteti seta scanare, presetare, tur, model, functie de asistent si lumina si stergator plus coordonate de
vizualizare.

Preset

Tour
Pattemn
Asgsistant
Light Wiper

Figura 4-3

www.ultramaster.ro
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4.1 Scanare

Interfata de scanare este prezentata in Figura 4-4.

PTZ Settings

P Start B Stop

Set Left Set Right

Figura 4-4

Pasii pentru scanare sunt:

Pasul 1. Faceti clic pe butonul Set (Setare), se afiseaza pictogramal petiel Salitint

Pasul 2. Deplasati-va prin tasta de directie pentru a selecta stanga, faceti clic pe Set Left pentru a seta
marginea stanga a camerei. Deplasati-va prin tasta de directie pentru a selecta dreapta, faceti clic pe
Set Right pentru a seta marginea din dreapta a camerei. Pasul 4. Finalizati configurarea caii de
scanare.

4.2 Preselectie

Interfata de presetare este prezentata in Figura 4-5.
PTZ Settings

Preset

Figura 4-5

Pasii pentru presetare sunt:

Pasul 1. In caseta de presetare, introduceti valoarea presetata.

Pasul 2. Faceti clic pe Go to, camera se roteste la pozitia prestabilita.

Pasul 3. Utilizati tasta de directie pentru a roti camera, iar in caseta de presetare introduceti
valoarea presetata. Pasul 4. Faceti clic pe Add pentru a adduga o presetare. Gama de
presetari se refera la protocolul PTZ.

www.ultramaster.ro
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4.3 Tur

Interfata turului este prezentata in Figura 4-6.

PTZ Settings

P Start W Stop

Figura 4-6

Pasii catre tur sunt:

Pasul 1. In caseta tur, introduceti valoarea traseului turului.

Pasul 2. Faceti clic pe Adaugare. Gama de tururi se refera la protocolul PTZ.
Pasul 3. in caseta de presetare, introduceti valoarea presetata.

Pasul 4. Faceti clic pe Add as pentru a adduga o presetare in acest tur. Daca faceti clic pe Del, se sterge aceasta
presetare din tur.

Nota:
Aici puteti adduga mai multe presetari sau puteti sterge mai multe presetari.

4.4 Model

Interfata modelului este prezentata in figura 4-7.

PTZ Settings

5
EXIECR

Figura 4-7

Pasii pentru setarea modelului sunt prezentati dupa

cum urmeaza: Pasul 1

Introduceti valoarea numarului de serie al modelului in caseta, faceti clic pe "Add" (Adaugare) si se va afisa "Start
Rec" (Pornire Tnregistrare) si "Stop Rec" (Oprire inregistrare).
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Pasul 2

Faceti clic pe "Start Rec" pentru a implementa o serie de operatii precum zoom, focalizare, diafragma, directie si

asa mai departe.

Pasul 3

Faceti clic pe "Stop Rec" pentru a finaliza setarea unui traseu de model.
Pasul 4

Faceti clic pe "Start" si va incepe modelul in conformitate cu calea de model care a fost setata; faceti clic pe "Stop"

si modelul se termina.

4,5 Asistent

Interfata asistentului este prezentata in figura 4-8.

PTZ Settings

Figura 4-8

Pasii catre asistent sunt:

Pasul 1. In caseta asistent introduceti valoarea asistentului.

Pasul 2. Faceti clic pe Aux On pentru a activa functia Aux.
Faceti clic pe Aux off pentru a dezactiva functia Aux.

4.6 Lumina / stergator

Interfata stergatorului de lumina este prezentata in figura 4-9.

PTZ Settings

Light Wiper

Enable Disable

Figura 4-9

Pasii pentru stergatorul de lumina sunt:
® Faceti clic pe Activare pentru a activa functia de stergere a luminii.

®  Faceti clic pe Dezactivare pentru a dezactiva functia de stergere a luminii.

5 Redare

Redarea clientului web accepté redarea video si redarea imaginilor. Nota:
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Inainte de redare, utilizatorul trebuie sa seteze gestionarea stocarii ca la cap. 5.4.

5.1 Redare
Interfata de redare este prezentata ca in Figura 5-1.

(S ST T S ST

Fra e
[S=EES N SD Card [~}

<

Sun Mon Tue Wed Thu Fri Sat

1
213456 7]8
Q21314415
1617 18 20 | 21 | 22 (R
2324 25[ 2627 28 29

30

L=
1 00000 O 1= €S

(|
Record Type El Al Bl General M [ Moton M B Aam [ Manual B

Figura 5-1

Exista patru sectiuni:

Sectiunea 1: Functia butoanelor de redare
Sectiunea 2: Fisier de redare

Sectiunea 3: Reducerea timpului
Sectiunea 4: Tip de inregistrare

Sectiunea 5: Bara de progres

Sectiunea 6: Functia de asistent

5.1.1 Functia de redare
Functia butoanelor de redare este prezentata in Figura 5-2 si Figura 5-3.
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OC0000 O =0

O e 6 6 O 61

Figura 5-2

00000 O 1 =@

© e 6 & 6 ©® O 62

Figura 5-3
Parametru Functia
Cand acest buton este afisat, inseamna pauza sau redare intrerupta. Faceti clic pentru
© Play a reda normal.
(2 oprire Faceti clic pe acest buton pentru a opri redarea.

(3 Redare dupé cadru

Faceti clic pe acest buton pentru a trece la urmatorul cadru.
Nota:
Trebuie sa intrerupeti inregistrarea atunci cand utilizati aceasta functie.

@) incet Faceti clic pe acest buton pentru a reda lent.
(5 Rapid Faceti clic pe acest buton pentru a juca rapid.

Cand acest buton este afisat, inseamna ca sunetul este silentios. Faceti clic pe acest
@ Silentios buton pentru a reveni la normal.
@ Volum Faceti clic cu butonul stang al mouse-ului pentru a ajusta volumul..

Faceti clic pe acest buton si dispozitivul fisheye poate ajusta modul de afisare in functie
-1 Fisheye de diferitele moduri de instalare in timpul procesului de redare.

-2 Regul4 Info

Faceti clic pe acest buton pentru a reda videoclipul si a afisa regulile inteligente
fmpreuna cu caseta de detectare a obiectelor, daca acestea sunt configurate. Functia
este dezactivata implicit si trebuie activata pentru a putea fi utilizata.
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5.1.2 Figier de redare
In calendar, casuta albastra reprezinta datele care au in prezent o inregistrare video sau un instantaneu. A se

vedea figura 5-4.
REIEE vl S Card

< [ EXE

Sun Mon Tue Wed Thu Fri

Figura 5-4

Parametru Functia

e  Selectati "dav", ca redare video.

Tip fisier e Selectati "jpg" ca redare a imaginii.

Sursa de date Implicit este card SD.

Pasul 1. Faceti clic pe datele in albastru, axa timpului afiseazé bara de progres a fisierului de inregistrare in culori.
in timp ce verdele reprezinta inregistrarea normala, galbenul reprezinta inregistrarea de detectare a miscarii,
rosu reprezinta inregistrarea de alarma, iar albastru reprezinta inregistrarea manuala.

Pasul 2. Faceti clic pe un anumit moment pe bara de progres, redarea incepe de la acest moment. A se vedea
Figura 5-5.

Figura 5-5

Pasul 3. Faceti clic pe lista de fisiere! #= | selectati data la care fisierul va fi afisat in lista.

Pasul 4. Faceti dublu clic pe fisierul din lista, redati acest fisier si afisati dimensiunea fisierului, ora de inceput si
ora de sfarsit. A se vedea Figura 5-6.
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00 :00:00-23: 59 : 59 |}
General, Event, Alarm, Manual =

Download Format @ dav © mp4

Start Time  File Type
15:49:39 |
15:50:07

4:38

16:54:00

CO0000000

17:00:54

€« 41/1p
Begin Time:
End Time:
File Size:

Figura 5-6
Parametru Functia
H Aceasta inseamna inregistrari in cadrul orei de nceput si de sfarsit a datei ciutate.
Cautare
Format de
descarcare Exista doua formate: dav, mp4.
Parametru Functia
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® faceti clic pe butonul de descarcare si descarcati fisierul precum este prezentat in

cap. 5.1.2.5.
m ® Sistemul nu acceptd descarcarea si redarea in acelasi timp.
Descarcare
- €« Faceti clic pe butonul inapoi pentru a merge la interfata calendarului.
Inapoi

5.1.3 Taierea redarii

Nota:

Functia de taiere a redarii va intrerupe automat redarea Tnregistrarii, deoarece taierea redarii si redarea nu pot fi in
acelasi timp.

Pasul 1. Faceti clic pe ora de incepere pentru a taia pe axa timpului. Aceasta ora trebuie sa fie in intervalul barei de
progres.

Pasul 2. Mutati mouse-ul la pictograma de téiere'55 . Vi se va cere sa selectati ora de incepere. Faceti clic pe

pictograma 5’5 pentru a termina taierea.

Pasul 3. Faceti clic pe ora de sfarsit a intreruperii redarii pe axa timpului. Acest timp trebuie sa fie in intervalul barei
de progres.
p———

.24

Pasul 4. Mutati mouse-ul pe pictograma de taieres====_ si vi se va cere sa selectati ora de terminare. Faceti clic pe
—

-4

pictograma de tdieres=—_Z_ pentru a termina taierea.

Pasul 5. Faceti clic pe butonul Save (Salvare) pentru a salva fisierul taiat in calea din cap. 5.1.2.5. A se vedea
figura 5-7.

00:00:00-00:00:00 D

Figura 5-7

5.1.4 Tip de inregistrare

Dupa verificarea tipului de fisier de inregistrare, numai fisierul selectat va fi afisat Th bara de progres si in lista de
fisiere. De asemenea, utilizatorii pot selecta tipul de Tnregistrare care urmeaza sé fie afisat prin intermediul casetei
derulante care se afla deasupra listei de fisiere. A se vedea figura 5-8.

Record Type Al [ General M Motion B Alarm [ Manual W

Figura 5-8
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30min
Figura 5-9
Parametru Functia
) 24hr b4 Faceti clic pe el pentru a vizualiza un video din ultimele 24 de ore.
e ore
O zhr R Faceti clic pe el pentru a vizualiza videoclipuri din ultimele 2 ore.
ore
O 1hr 1 or Faceti clic pe el pentru a vizualiza un video din ultima ora.
ora
(O z0min 50 mi Faceti clic pe el pentru a vizualiza un video din ultimele 30 de minute.
min

5.1.6 Functia de asistent

Functia asistent de redare video este prezentata in Figura 5-10.

Figura 5-10

Parametru

Functia

d Zoom digital

e  Faceti clic pe el, video in stare de redare dacé este in dimensiunea originala,

utilizatorul poate mari in orice zona, Daca nu este in dimensiunea sa
originala, faceti clic dreapta pe mouse pentru a restabili dimensiunea sa

originala.
e  Faceti clic pe acest buton, puteti derula pentru a mari imaginea.

E] Instantaneu

Faceti clic pe acest buton, puteti face un instantaneu video in stare de redare.

Instantaneuul va fi salvat in calea din cap. 5.1.2.5.

5.2 Redarea imaginilor

Interfata de redare a imaginilor a clientului web are urmatoarele trei functii:

Parametru Functia

www.ultramaster.ro
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1 Bara de functii de redare
2 Bara fisierului de redare
3 Bara tip instantaneu

A se vedea Figura 5-11.

@lhua

(>

Snapshot Type B Al [ General m B Event ®m B Alam

5.2.1 Redare

Figura 5-11

oo

Figura 5-12

Playback

L T P T

Data Src SD Card E

Sun Mon Tue Wed Thu Fri Sat

Pictograma implicita estem si inseamna pauza sau imagine intrerupta. Faceti clic pe butonul de redare

pentru a trece la stare normala de redare. Pictograma devine m Faceti clic pe buton pentru a intrerupe.
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5.2.2 Figier de redare

< 2013 |

Sun Mon Tue Wed Thu

Figura 5-13

Pasul 1. Faceti clic pe lista de fisiere *= | selectati fisierul instantaneu al datei.

Pasul 2. Faceti dublu clic pe fisierul din lista, pentru a reda instantaneu videoclipul.

Parametru

Functia

www.ultramaster.ro
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n Cautare

Aceasta inseamna toate fisierele snapshot in timpul de inceput si de sfarsit al datei
selectate.

Parametru Functia
m Faceti clic pe butonul de descarcare pentru a deschide fisierul instantaneu sau pentru a
descarca direct in local in functie de tipurile de browser.
Descarcare
&= Faceti clic pe butonul Tnapoi pentru a reveni la interfata calendarului si pentru a selecta din
fnapoi nou ora.
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00 - 00 : 00 - 23 : 59 - 59 |fe]

General, BEvent, Alarm -

Start Time  File Type

O

u
o

L
i (NN eleReNeleleRele)

M a1/1p p

Figura 5-14

5.2.3 Tip instantaneu
Dupa verificarea tipului de fisier instantaneu, in lista de fisiere se afiseazd numai fisierul de tip selectat. Utilizatorii
pot selecta, de asemenea, tipul de instantaneu care urmeaza sa fie afisat prin intermediul casetei derulante de

deasupra listei de fisiere. A se vedea figura 5-15.

Snapshot Type All General Event W Alarm

Figura 5-15
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6 Configurare

Configurarea clientului web accepta vizualizarea camerei, retelei, timpului, stocarii, sistemului si a informatiilor
despre sistem.

6.1 Aparat foto

Setarea camerei include conditii, gestionarea profilului, zoom si focalizare.

6.1.1 Conditii

Nota:

Parametrul camerei poate fi diferit in functie de diferite modele, va rugdm sa consultati produsul real pentru mai

multe detalii. 6.1.1.1 Imagine Nota:

Dispozitivul care accepta WDR adevarat nu accepta expunerea lunga atunci cand WDR adevarat este activat.

Pasul 1

Selectati "Configurare > Camera > Conditii > Imagine" si sistemul va afisa imaginea "Imagine" care este prezentata

in Figura 6-1.
o\

ua

Conditions  JProfile Management§ Zoom and Focus

Profile Day E|
> Video
> Audio g | Style Standard E|
Network = == o — AEEE Brightness [=- 0 [F] 50
ST - |  Backignt Contrast [=] 0 50
Storage 5 N L Saturation [=] {0 50
System » Day & Night Sharpness [=] U 50
Information ¥R Lot Gamma [=]- 0 50
Wirror ©) ON @ OFF
Flip|0° El
Default H Refresh H Save
Figura 6-1
Pasul 2
Setati parametrii imaginii; consultati urmatoarea fisa pentru mai multe detalii despre setarea parametrilor.
Parametru Nota
Stil
Acesta permite setarea stilului imaginii, care include standard, moale si viu.
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Parametru

Nota

Luminozitate

Este vorba de ajustarea luminozitatii generale a imaginii prin modul de ajustare
liniara. Cu cat numarul este mai mare, cu atat imaginea este mai luminoasa, iar
invers. Imaginea devine usor neclaré atunci cand valoarea este setatd prea mare.

Contrast

Acesta este pentru a regla contrastul imaginii. Cu céat valoarea este mai mare, cu
atat contrastul luminos devine mai mare, iar invers este mai mic. Zona intunecata
devine mai intunecata si zona luminoasa devine supraexpusa cu usurintd atunci
cand valoarea este setata prea mare. Imaginea devine neclara atunci cand valoarea
este setata prea mica.

Saturatie

Aceasta permite ajustarea intunericului si a luminozitatii culorii. Culoarea devine mai
inchisa atunci cand valoarea este mai mare; dimpotriva, devine mai deschisa.
Valoarea nu determina nicio influenta asupra luminozitatii generale a imaginii.

Sharpness

Permite ajustarea nivelului de acuitate al marginii imaginii. Cu cat este mai mare
valoarea de acuitate, cu atat devine mai evidenta marginea imaginii, imaginea este
susceptibila de a genera zgomot mai usor atunci cand valoarea este setatd prea
mare.

Gamma

Se modifica luminozitatea imaginii si se imbunatateste gama de afisare dinamicéa a
imaginii prin modul de ajustare neliniara. Cu cat valoarea este mai mare, cu atat
imaginea devine mai luminoasa, iar dimpotriva este invers.

Oglind

Dupa activarea oglinzii, imaginea de monitorizare va fi afisata invers.

Flip

Aceasta permite schimbarea directiei de afisare a imaginii de monitorizare.
Acesta include urmatoarele optiuni:
e Normal: Imaginea de monitorizare este afisatd ih mod normal.

e  Modul Flip 1: Imaginea de monitorizare este afisata in sensul acelor de
ceasornic
rotatie 90° ¢ Modul Flip 2: Imaginea de monitorizare este afisata cu o rotatie

de 90° in sens antiorar

e  180°: Imaginea de monitorizare este afisatd cu susul Tn jos.

Nota:

Va rugam sa setati rezolutia video ca 1080P sau mai mica atunci cand aplicati modul
flip pentru unele dispozitive.

SIE

Acesta poate realiza functia electronica anti-flicker prin intermediul algoritmului de
comparare a diferentei de imagine, care poate rezolva in mod eficient problema
trepidatiei imaginii in timpul aplicarii si poate face imaginea mai clara.
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Faceti clic pe "Save" (Salvare) si finalizati configurarea parametrilor de imagine ai camerei.

6.1.1.2 Etapa de

expunere 1

Selectati "Setup > Camera > Conditions > Exposure". Sistemul va afisa interfata "Exposure" (Expunere) care este

prezentata in Figura 6-2.

> Audio
Network
Event
Storage
System

Information

Profile Management§ Zoom and Focus

Prafile Normal =]
» Picture Anti-flicker  Outdoor

» Backlight

Autolris @ ON ) OFF
» WB = =
3DNR®@ ON ) OFF

» Day & Night
heng Grade (] 0 50

» IR Light

Figura 6-2
Pasul 2
Acesta este pentru a seta parametrul de expunere, consultati urmatoarea fisa pentru mai multe detalii.
Parametru Nota
® Puteti comuta la modul de expunere atunci cand este in modul
exterior, acesta poate realiza rezultatul in modul de expunere
corespunzator.
® 50Hz: Cand curentul este de 50Hz, sistemul poate regla automat
o expunerea in functie de luminozitatea mediului Tn cazul Tn care
Anti-flicker exista vreo dunga.
® 60Hz: Cand curentul este de 60Hz, sistemul poate regla automat
expunerea in functie de luminozitatea mediului in cazul Tn care
exista vreo dunga.
Parametru Nota
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Acesta este modul de expunere al
aparatului foto. Nota:
® Cand "Anti-flicker" este "Outdor", "modul de expunere" poate fi setat
ca mod "prioritate castig" sau "prioritate obturator”.
® Dispozitivele diferite au moduri de expunere diferite; va rugam sa
consultati interfata reala.
Acesta include urmatoarele optiuni:
® Auto: Poate regla automat luminozitatea imaginii in functie de mediu.
® Prioritatea castigului: Dispozitivul se poate regla automat in functie de
intervalul de castig care este stabilit prin prioritate in timpul intervalului
de expunere normala in functie de luminozitatea diferitd a scenei.
Dispozitivul va regla automat valoarea obturatorului daca
luminozitatea imaginii nu reuseste s& atingd efectul si valoarea
castigului a ajuns la limita superioara sau la limita inferioara, pentru a
face ca imaginea sa atinga cea mai buna luminozitate.
Modul ® Prioritatea obturatorului: Dispozitivul se poate regla automat in functie
de intervalul obturatorului care este setat prin prioritate in timpul
intervalului normal de expunere in functie de luminozitatea diferita a
scenei. Dispozitivul va regla automat valoarea obturatorului daca
luminozitatea imaginii nu reuseste s& atingd efectul si valoarea
obturatorului a ajuns la limita superioara sau la limita inferioara,
pentru a face ca imaginea sa atinga cea mai buna luminozitate.
® Prioritatea irisului: Valoarea irisului este fixa, dispozitivul poate regla
automat valoarea obturatorului daca luminozitatea imaginii nu atinge
efectul si valoarea obturatorului a atins limita superioara sau limita
inferioara, dispozitivul poate regla automat valoarea castigului pentru
a face ca imaginea sa atinga cea mai buna luminozitate.
® Manual: Seteazd manual valoarea castigului si valoarea
obturatorului, regleaza luminozitatea afisata a imaginii.
Acesta poate seta parametrul atunci cand camera instaleaza iris
automat.
® Irisul obiectivului poate regla automat dimensiunea in functie de
Iris automat mediu dupa activarea irisului automat, apoi luminozitatea imaginii se
va modifica in consecinta.
® \Valoarea irisului atinge valoarea maxima atunci cand dezactivati
irisul automat, irisul obiectivului nu se va modifica in functie de
luminozitatea mediului.
Acesta proceseaza imaginea cu mai multe cadre (cel putin doua cadre),
3D NR poate realiza reducerea zgomotului imaginii prin utilizarea informatiilor
interframe dintre cadrul anterior si cel ulterior.
Acesta poate seta parametrul atunci cand "3D NR" este activat.
Grad Cu cat gradul este mai mare, cu atat efectul NR pe care il poate realiza
este mai bun.
Pasul 3

www.ultramaster.ro

36



Cayhua Manual de utilizare Dahua Network Camera Web 3.0

TECHNOLOGY

Faceti clic pe "Salvare" pentru a finaliza configurarea parametrilor de expunere a camerei.

6.1.1.3 Lumina de fundal

Modul de iluminare din spate poate fi impartit in BLC, WDR si HLS.

BLC: poate evita fenomenul cucoloris al zonei mai intunecate in mediul cu lumina de fundal.

WDR: Poate suprima zona prea luminoasa si compensa zona intunecata prin activarea WDR, ceea ce poate face
ca imaginea generala sa fie clara.

HLC: slabeste lumina puternicd, care poate fi aplicata in zone precum poarta de taxare, intrarea si iesirea din
parcare etc. in ceea ce priveste lumina extremd, aceasta poate surprinde chipul uman in mediul intunecat si poate
realiza un efect mai bun pentru detaliile numarului de inmatriculare.

Pasul 1
Selectati "Setup > Camera > Condition > Backlight", sistemul va afisa interfata "Backlight" care este prezentata in

Figura 6-3.

alhua

TECHHOLOGY.

Conditions  JProfile Management] Zoom and Focus

Profile | Normal

> Audio e Mods | OFF

» Exposure

» Backlight

r WB

Network
Event

Storage
System » Day & Night

Information » IR Light

Figura 6-3
Pasul 2
Setati parametrul luminii de fundal.

® (Cand "Mod" este setat ca "Autoadaptare scena", sistemul va regla automat luminozitatea imaginii in functie de
luminozitatea mediului, pentru a face ca obiectul sa fie afisat clar in scena.

® Cand "Mod" este setat ca "BLC", acesta poate selecta modul implicit sau modul personalizat.

€ La selectarea modului "Implicit", sistemul poate realiza expunerea automata in functie de mediu, pentru
a face ca imaginea din zona cea mai intunecata sa fie vizibila.

€ Atunci cand selectati modul "Personalizat", sistemul poate realiza expunerea pe zona selectata dupa
ce a setat zona personalizata, ceea ce face ca imaginea din zona selectata sa atinga luminozitatea
corespunzatoare.
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®  Atunci cand "Mod" este setat ca "WDR", acesta va reduce luminozitatea zonei cu luminozitate ridicata si va
spori luminozitatea zonei cu luminozitate scazuta, ceea ce face ca obiectele din zonele cu luminozitate
ridicata si cu luminozitate scazuta sa fie afisate clar.

Nota:

Este posibil sa existe o pierdere video de cateva secunde atunci cand camera este comutata de la modul non

WDR la modul WDR.

® Cand "Mod" este setat ca "HLC", sistemul va constrange luminozitatea zonei cu luminozitate ridicata si va
reduce dimensiunea zonei halo, ceea ce inseamna scaderea luminozitatii intregii imagini.
Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea modului de iluminare din spate.

6.1.1.4 BM

WB este utilizat pentru a restabili obiectul alb din scena de catre camera, dupa ce modul WB este setat, acesta
poate face ca obiectul alb sa para alb in diferite medii. Pasul 1

Selectati "Setup > Camera > Conditions > WB", sistemul va afisa interfata "WB", care este prezentata in Figura 6-

Profile  Normal

> Audio - ¢ HAe Mode | Auto |z|

Network : Z e 3 . 4 » Exposure

Event - — » Backlight

System » Day & Night

Information » IR Light

‘ Default ‘ ‘ Refresh | ‘ Save |

Figura 6-4
Pasul 2

Setati modul WB.

® (Cand "Mod" este setat ca "Auto", sistemul poate compensa automat balansul de alb Tn functie de diferite
temperaturi ale culorii, ceea ce face ca culoarea imaginii sa fie normala.

® Cand "Mod" este setat ca "Natural", sistemul poate compensa automat balansul de alb pentru scena fara
lumina artificiala, ceea ce face ca culoarea imaginii sa fie normala.

® Cand "Mod" este setat ca "Lampa stradala", sistemul poate compensa automat balansul de alb pentru scena
exterioara pe timp de noapte, ceea ce face ca culoarea imaginii sa fie normala.
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® Cand "Mod" este setat ca "In aer liber", sistemul poate compensa automat balansul de alb pentru majoritatea
scenelor Tn aer liber cu lumina naturala si lumina artificiald, ceea ce face ca culoarea imaginii sa fie normala.

® Cand "Modul" este setat ca "Manual", se poate seta manual valoarea castigului rosu si a castigului albastru;
sistemul poate compensa temperaturile de culoare diferite din mediu in conformitate cu setarile.

®  Atunci cand "Mod" este setat ca "Personalizat regional", se stabileste o zona personalizata, sistemul poate

compensa balansul de alb la temperatura de culoare diferita a imaginilor din zona, ceea ce face ca culoarea
imaginii sa fie normala.

Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea modului WB.

6.1.1.5 Zi si noapte

Acesta este pentru a seta comutatorul intre modul color si modul alb-negru.
Pasul 1

Selectati "Setup > Camera > Conditions > Day & Night" si sistemul va afisa interfata "Day & Night", care este
prezentata in Figura 6-5.

@lhua

Conditions

Profile Management§ Zoom and Focus

Profile. Normal El
>
> Audio Pt Made Auto El
Network 2 Sensitivity| Middle El
Event b Baction: Delay| 65 =]
Storage »WB
Information » IR Light
Figura 6-5
Pasul 2
Setati parametrul zi si noapte; consultati urmatoarea fisa pentru mai multe detalii.
Parametru Nota
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Acesta este pentru a seta imaginea camerei afisata in modul color sau alb-negru.

Nota:

Setarea "Mod zi/noapte" nu este afectata de setarea "Profil

Management".

Modul Acesta include urmatoarele optiuni:

® Culoare: Imaginea camerei este afisatd ca imagine color.

® Auto: Camera poate selecta automat imaginea color sau imaginea alb-negru
pentru a fi afisata in functie de luminozitatea mediului.

® Alb si negru: Imaginea camerei este afisatd ca imagine alb-negru.

Parametrul poate fi setat atunci cand "Mod zi/noapte" este "Auto".
Sensibilitate Seteaza sensibilitatea comutatorului intre afisarea imaginii color si afisarea alb-negru,

Parametrul poate fi setat atunci cand "Mod zi/noapte" este "Auto".

Acesta permite setarea intarzierii de comutare intre afisarea color a imaginii si
afisarea alb-negru. Cu cat intarzierea este mai mica, cu atdt comutarea intre
afisarea color si afisarea alb-negru devine mai rapida.

Intarziere

Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea modului zi/noapte.

6.1.1.6 Dezaburire
Calitatea imaginii va deveni slaba atunci cand dispozitivul se afla in mediul cu ceata sau ceata, puteti activa
functia de dezaburire pentru a regla definitia imaginii. Pasul 1

Selectati "Setup > Camera > Conditions > Defog" si sistemul va afisa interfata "Defog" care este prezentata in
Figura 6-6.

Profile| Day
> Video

> Alkko 7 > | e Mode OFF [=]
Network B = — ’ | + Exposure

Event — » Backiight

Storage 2 ] - » WB

System » Day & Night

Information

‘ Default J | Refresh | ‘

Figura 6-6
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Pasul 2

Acesta este pentru a seta modul de dezaburire Tn functie de scena reala.

®  Atunci cand "Mod" este setat ca "Manual", acesta este pentru a seta manual intensitatea si modul de lumina
de aer, sistemul va ajusta definitia imaginii in functie de intensitatea si modul de lumina de aer care au fost
setate anterior. In ceea ce priveste modul air light, puteti seta manual sau automat.

® (Cand "Mod" este setat ca "Auto", sistemul va ajusta automat definitia imaginii in functie de scena reala.

®  Atunci cand "Mod" este setat ca "Oprit", functia de dezaburire este dezactivata.

Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea modului de dezaburire.

6.1.1.7 Lumina IR
Puteti seta direct modul de lumina IR daca dispozitivul este echipat cu lumind IR.
Pasul 1

Selectati "Setup > Camera > Conditions > IR Light" si sistemul va afisa interfata "IR Light", care este prezentata in
Figura 6-7.

Conditions  [Profile Managemeni Zoom and Focus

Profile | Normal

+ Picture Wode | SmartiR

Network » Exposure

Event » Backlight
Storage !

System

» Day & Night

Information

Figura 6-7
Pasul 2

Acesta este pentru a seta modul de lumina IR in functie de scena reala.

® Cand "Mod" este setat ca "Manual", se poate seta manual luminozitatea luminii IR; sistemul va realiza
compensarea luminii imaginii in functie de intensitatea luminii IR.

® (Cand "Mod" este setat ca "IR inteligent”, sistemul poate regla luminozitatea in functie de scena reala.

Cand "Mod" este setat ca "Zoomprio", sistemul poate regla automat lumina IR in functie de schimbarea
luminozitatii scenei reale.
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¢ Sistemul va activa lumina apropiata cu prioritate atunci cand scena reala devine intunecata, sistemul
va activa lumina indepartata atunci cand lumina apropiata nu indeplineste cerintele de luminozitate a
scenei, chiar daca este reglata la cea mai puternica.

€ Sistemul va regla luminozitatea luminii indepartate cu prioritate la oprit si apoi va regla luminozitatea
luminii apropiate atunci cand scena reala devine luminoasa. Sistemul va dezactiva intotdeauna lumina
indepartata atunci cand distanta focala a obiectivului este reglata la un anumit unghi larg, pentru a
evita supraexpunerea in apropiere. Intre timp, se poate seta manual compensarea luminii pentru a
ajusta usor luminozitatea luminii IR.

Atunci cand "modul” este setat ca "Oprit", nu va activa lumina infrarosie.

Pasul 3

Faceti clic pe "Salvare" si finalizati configurarea luminii IR.

6.1.1.8 Gestionarea profilului Etapa

1

Selectati "Setup > Camera > Conditions > Profile Management" si sistemul va afisa interfata de

"Gestionarea profilului".
Pasul 2
Setati gestionarea profilului.

> Video

Atunci cand "Gestionarea profilului" este setat ca "Normal", sistemul va monitoriza in conformitate cu
configuratia normala.

Camera Conditions Profile Management Zoom and Focus

Profile Management @ Normal ¢ Full Time ¢ Schedule

> Audio Default | ‘ Refresh | ‘ Save

Network
Event
Storage
System

Information

Figura 6-8

Cand "Gestionarea profilului" este setata ca "Full Time", puteti selecta "Always Enable" in "Day" sau "Night",
sistemul va monitoriza Tn functie de configuratia "always enable".

www.ultramaster.ro 42



Cayhua Manual de utilizare Dahua Network Camera Web 3.0

TECHNOLOGY

e Lz Jopemec | sewr | asm [ tosou

Conditions Profile Management Zoom and Focus @

Profile Management ¢ Marmal % Full Time (" Schedule

Always Enable IDEY B

Network | Default | ‘ Refresh | ‘ Save

> Audio

Event
Storage
System
Information

Figura 6-9

® Cand "Profile Management" este setat ca "Schedule", puteti seta o anumité perioada ca zi si o alta perioada
ca noapte, de exemplu, daca seteaza 0:00 ~ 12:00 ca zi, 12:00 ~ 24:00 ca noapte, atunci sistemul va
monitoriza prin adoptarea config corespunzatoare in perioade diferite.

Conditions Profile Managementl] Zoom and Focus

Profile Management ¢ Mormal € Full Time ¢ Schedule

> Audio

Network ecazemne (] e e e et et e

Event 0:00 400 8:00 12:00 16:00 20:00 24:00
Storage [ Day M Might
g ‘ Default ‘ | Refresh | ‘ Save ‘

Information

Figura 6-10
Pasul 3
Faceti clic pe "Salvare" pentru a finaliza setarile de gestionare a profilului.
Nota:

Faceti clic pe "Default" pentru a restabili configuratia implicita a dispozitivului; faceti clic pe "Refresh" pentru a
verifica cel mai recent fisier de configurare al dispozitivului.

6.1.1.9 Zoom si focalizare Nota:

Numai dispozitivele vari-focale motorizate accepta functia de focalizare si zoom.

Pasul 1

Selectati "Setup > Camera > Conditions > Zoom and Focus" si sistemul va afisa interfata "Zoom and Focus" care

este prezentata in Figura 6-11.
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Camera Conditions

> Video

> Audio
Network
Event
storage
System
Information

e

zoom wioE (=) 0 TELE Speed [20 - Restore All
Focus NEAR (=) [ [&) FsR  spesd |20 ~| | CAute Focus Refrash

Figura 6-11

Pasul 2

Reglati distanta focala a obiectivului.

Dupa ce este marit, setati "Viteza" si apasati "+", "-" sau trageti direct blocul glisant pentru a regla. Pasul

3

Reglati definitia obiectivului.

Dupa ce este focalizat, setati "Viteza" si apasati "+", "-" sau trageti direct blocul glisant pentru a regla.

Nota:

® \Viteza este utilizatd pentru a seta lungimea prin apasarea "+" si "-".

® Dupa ajustarea distantei focale a obiectivului sau faceti clic pe "Focalizare automata", dispozitivul va ajusta
automat definitia imaginii, nu este permisa punerea in aplicare a altor operatii ale obiectivului Tn timpul
focalizarii automate.

® Dupa mai multe ori de zoom si focalizare, imaginea nu poate fi ajustaté clar, faceti clic pe "Restaurati toate"
pentru a reseta obiectivul la zero si a elimina eroarea acumulaté a obiectivului.

® Faceti clic pe "Actualizare" si dispozitivul va sincroniza automat hardware-ul cu locatia blocului glisant de
zoom si focalizare a obiectivului.

6.1.2 Video
6.1.2.1 Video

Pasul 1

Selectati "Setup > Camera > Video > Video" si sistemul va afisa interfata "Video" care este prezentata in Figura 6-
12 (Non fisheye) sau Figura 6-13 (Fisheye).
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Video Snapshot Overlay Path

Main Stream Sub Stream

Network Enable Sub Stream 2 v
Event Encode Mode H.264H M Encade Mode H.264H v
Storage Smart Codec 'OFF v # Resolution D1 (704*480) v
System Resolution 2304x1296 (2304*1296 v Video Clip g
Information Frame rate(FPS) |30 v Framerate(FPS) 6 v

Bit Rate Type CBR 4 Bit Rate Type CBR. v

Reference BitRate  1702-10240Kb/S Reference Bit Rate  48-886Kb/S

Bit Rate 6144 v Bit Rate | 896 il

| Frame Interval B0 (30~150) | Frame Interval 12 (6~150)

#| Watermark Settings

Watermark Character | Digital CCTV

petaut || Remesn || Save

Video

Snapshot

Conditi
2R Installation Mode Ceiling
= Record Mode 2P El

> Audio

Network Main Stream Sub Stream

Event [¥] Enable Sub Stream 1 E|

Storage Code-Stream Type | General E| Code-Stream Type General

System Enenda Mode H.264 Encode Mode H.264

Information e 230412 (2432°2432) Resolution B40x640 (540'640) [
Frame rate(FFS) 15 [=] Frame rate(FPS) 15 [=]
BitRate Type CBR [=] BitRate Type el [=]
Reference BitRate  2048-11008Kb/S Reference BitRale  256-1792KbiS
Bit Rate 8192 il 1024
e eorrl N (15~150) | Frame Interval 30 (15~150)
sve 1(off) [=] sve 1(off) [=]

[¥] Watermark Settings
Waltermark Character| Digital CCTV
Default | | Refresh ‘ ‘ Save

Figura 6-13 (Fisheye)

Pasul 2

Setati fluxul de biti video, consultati urmatoarea fiséd pentru mai multe detalii despre parametri.
Parametru Functia
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Mod de instalare

Acesta va afisa parametrul atunci cand dispozitivul este
fisheye. Exista trei moduri de instalare pentru fisheye care
sunt tavan, montare pe perete si instalare la sol, va rugam sa
selectati modul de instalare in functie de scena reala de
instalare a fisheye.

Sistemul va incepe sa comute dupa comutarea modului de
instalare, va solicita salvarea cu succes dupa ce este comutat
Cu succes.

Nota:

Capatul dispozitivului va emite fluxul video dewarped dupa
configurarea modului de instalare si inregistrare, atunci cand
dispozitivul este accesat la o platforma terta, acesta va afisa
direct imaginea dewarped pe platforma terta.

Parametru

Functia

Modul de inregistrare

Acesta va afisa parametrul atunci cand dispozitivul este

fisheye. Sistemul va incepe sa comute dupa ce modul de

inregistrare este comutat, acesta va solicita salvarea cu

succes dupa ce este comutat cu succes.

Modul de inregistrare se va schimba in functie de diferitele

moduri de instalare.

® 10: imaginea originala care nu este dewarpata. ®
1P: panorama dreptunghiulara la 360°.

® 2P: Modul poate fi setat atunci cand "Instalare

Mode" este setat ca "Ceiling" sau "Ground". Este vorba
despre 2 imagini dreptunghiulare de 180°, cele doua
ferestre secundare pot forma oricand o panorama de
360°.

® 10+3R: imaginea originala + 3 subimagini independente,
atat subimaginea, céat si subcadrele din imaginea
originaléd pot suporta zoom si miscare.

® 1R: Imagine originala + subimagine independenta,
casetele secundare ale imaginii originale suporta zoom
si miscare.

® 4R:imagine originala + 4 subimagini independente, atat
subimaginea, céat si subcadrele din imaginea originala
suporta zoom si miscare.

® 2R:Imagine originala + 2 imagini secundare
independente, casetele secundare ale imaginii originale
pot suporta zoom si miscare, imaginea secundara
suporta miscarea in sus si in jos, care poate schimba
unghiul vertical de vizualizare.

Nota:

Capatul dispozitivului va emite fluxul video dewarped dupa

configurarea modului de instalare si inregistrare, atunci cand

dispozitivul este accesat la platforma terta, acesta va afisa

direct imaginea dewarped pe platforma terta.
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Activare sub flux

Selectati "Activare" pentru a activa fluxul secundar.
Dispozitivul accepta activarea fluxului secundar 1 si a fluxului
secundar 2 in acelasi timp.

Codec inteligent

Acesta poate Tmbunatati performanta de compresie a
imaginilor si poate reduce spatiul de stocare permitand
codificarea inteligenta.

Nota:

Dupa activarea codarii inteligente, dispozitivul nu va suporta
al treilea flux, ROI sau detectarea evenimentelor inteligente,
consultati interfata reald pentru mai multe detalii.

Parametru

Functia

Modul de codare

Exista cinci optiuni: H.264 (profilul principal standard,

H.264H (high profile standard), H.264B (Baseline Profile),

H 265 (main profile standard) si MUPEG encode.
H.264, H.264H sunt ambele fluxuri de biti H264.
H.264 este codificarea profilului principal si trebuie sa
activati functia de flux secundar in camera dvs. si sa
setati rezolutia ca CIF. Apoi puteti monitoriza prin
intermediul telefonului mobil Blackberry.

® H.265 este modul principal de codare a profilului.

® MJPEG: In acest mod de codare, videoclipul are nevoie
de un flux de biti mare pentru a garanta definitia video.
Puteti utiliza valoarea maxima a fluxului de biti in bitul
recomandat pentru a obtine un efect de iesire video mai
bun.

Rezolutie

Existd mai multe rezolutii. Puteti selecta din lista derulanta.

Pentru fiecare rezolutie, valoarea fluxului de biti recomandat&
este diferita.

Nota: Cand videoclipul este in stare de rotatie, nu puteti seta o
rezolutie mai mare de 1080P (cu exceptia 1080P).

Clip video

Functia este suportatd numai de fluxul secundar 2, va rugam
sa consultati "Clip video" pentru mai multe detalii sub foaie.

Rata cadrelor (FPS)

PAL: 1~25f/s, 1-50f/s NTSC: 1~30f/s sau 1~60f/s.
Rata cadrelor poate varia din cauza rezolutiilor diferite.

Tipul ratei de biti

Exista doua optiuni: VBR si CBR.
Va rugam sa retineti, puteti seta calitatea video ih modul VBR.
Tn modul MJPEG, este disponibil doar CBR.

Bit recomandat

Valoarea ratei de biti recomandata in functie de rezolutia si
rata de cadre pe care le-ati setat.
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Rata de biti

® inCBR, rata de biti este aici valoarea maxima. n video
dinamic, sistemul trebuie sa reduca rata de cadre sau
calitatea video pentru a garanta valoarea.

® Valoarea este nula in modul VBR.

® V3 rugam sa consultati rata de biti recomandata pentru
informatii detaliate.

SvC

Rata cadrelor poate fi codificata pe straturi. Este o metoda de
codare flexibila. Tn mod implicit, este 1 ca 1 strat. De
asemenea, puteti seta 2/3/4 straturi.

| Cadru

Aici puteti seta valoarea cadrului P intre doua cadre I.
Valoarea variaza de la 1 la 150. Valoarea implicita este 50.

Valoarea recomandata este rata cadrelor *2.

Parametru

Functia

Setari filigran

Selectati "Watermark Setting" si activati functia de filigran.
Dupa activarea functiei de filigran, puteti verifica daca
videoclipul este falsificat prin verificarea caracterului
filigranului.

Caracterul filigranului

Este caracterul de verificare a filigranului; este Digital CCTV in
mod implicit.

) Clip video

1. Selectati "Sub Stream 2" in caseta derulanta si faceti clic pe "Activare".

) ’-:
2. Activati "Clip video", faceti clic pe X2

Sistemul va afisa interfata "Area", care este prezentata in Figura 6-14.
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Resolution [lﬁ?ﬂti *480) El Save Cancel

Figura 6-14

3. Selectati rezolutia necesara si clipati imaginea necesara pe interfata, care este prezentata in Figura 5-15.
4. Faceti clic pe "Save" (Salvare). Puteti verifica videoclipul decupat in interfata de previzualizare (interfata de
previzualizare a fluxului secundar 2 afiseazé doar zona decupata), care este prezentata in Figura 6-15.
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Figura 6-15

Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea fluxului video.

6.1.2.2 Instantaneu

Interfata snapshot este prezentata in Figura 6-16.

@Jhua

Video Snapshot

> Conditions

Snapshot Type | General v

- Image Size 1080F (19201080}
> Audio -—

Quality |5 v
Network e

Interval 15 ¥
Event s
Storage Default | ‘ Refresh | ‘ Save ‘
System
Information

Figura 6-16

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
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Tip instantaneu

Exista doua moduri: general (program) si eveniment (activare).

Dimensiunea
imaginii

Este la fel ca rezolutia curentului principal.

Calitate

Acesta este pentru a seta calitatea imaginii. Exista sase niveluri.

Interval

Acesta este de a seta frecventa instantanee. Optional1~7s/picture,
personalizat.

6.1.2.3 Suprapunere video

Interfata de suprapunere video este prezentata in Figura 6-17.

> Audio
Network
Event
Storage
System

Information

‘Snapshot

» Privacy Masking
» Channel Title

() Enable @ Disable

+ Time Title
» Text Overay
» Picture Overlay

» Counting

Delete ‘ (Or Rightclick )

Refresh ‘ | Save

Figura 6-17
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@lhua

Snapshot
> Conditions.

E . » Prvacy Masking @ Enable O Disable
1 i Wl Channei Title Input channel title:
> Audio
" v Time Title IPC
Network T “=
Event - - . » Text Overlay
Storage r = » Picture Overlay
System . + Counting
Information

Snapshot
> Conditi
» Privacy Masking '® Enable Dizable

; 1 i S+ Channel Title || Week Display
> Audio f

Event — - - » Text Overlay

Storage P 8 » Picture Overlay

System » Counting

Information

Default || Refresh || Save I

Figura 6-19
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> Conditions

> Audio
Network
Event
Storage
System

Information

@Jhua

> Conditions.

> Audio
Network
Event
Storage
System

Infermation

Manual de utilizare Dahua Network Camera Web 3.0

» Privacy Masking

(") Enable @ Disable
» Channel Title Input Text:

» Time Title

v Text Overlay

» Picture Overlay

» Counting

Text Align

Right =]

+ Privacy Masking ) Enable @ Disable
» Channel Titie Picture Preview:

» Time Title

» Text Overay

-

» Counting

Upload Picture

Requirement for picture upload
1. Max size is 16k

2. Max resolution is 128x128 pixels.
3. 256 colors, bmp format.
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Figura 6-21

Snapshot

Privacy Masking () Enable @ Disable

» Channel Title Statistics Type
> Audi .
. b Time Title [¥] Enter Number
oy [4] Leave Number

» Text Over,
Event S

Text Ali
Storage » Picture Overlay ign

Information

5 Lef
System , [» corra [ =

Figura 6-22
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
Mascarea ® Aici puteti masca confidentialitatea clipului video specificat in
confidentialitatii monitorul video.

® Sistemul accepta maxim 4 zone de masca de confidentialitate.

informatiile despre timp in fereastra video.
®  Puteti utiliza mouse-ul pentru a glisa pozitia casetei de timp.

Timp Titlu ® Puteti activa aceasta functie astfel incat sistemul sa suprapunéa

informatiile despre canal in fereastra video.
® Puteti utiliza mouse-ul pentru a glisa pozitia placii de canal.

Titlul canalului ® Puteti activa aceasta functie astfel incat sistemul sa suprapuna

video.
® Protocolul privat este conectat la NVR mobil, suporta
suprapunerea informatiilor GPS.

Suprapunere text ® Puteti activa aceasta functie pentru a suprapune textul in fereastra

®  Puteti utiliza mouse-ul pentru a trage caseta de locatie pentru a-i
ajusta pozitia. Alinierea include alinierea la stanga si alinierea la

pentru a o muta.
Nota:
Nu puteti activa suprapunerea textului si a imaginii in acelasi timp.

dreapta.
Suprapunere ® Puteti activa aceasta functie pentru a afisa imaginea suprapusa.
imagine Faceti clic pe dezactivare pentru a o dezactiva.

® Faceti clic pe Incarcare imagine pentru a suprapune imaginea
locala Tn fereastra de monitorizare. Puteti trage caseta galbena
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Numararea [] Bifati "Enable" pentru a afisa datele statistice de numarare in
fereastra de monitorizare video; bifati "Disable” pentru a nu le
afisa.

[] Existd numar de intrare si numar de iesire pentru tipul de statistici
si aliniere la stanga si aliniere la dreapta pentru informatiile OSD.

Reimprospéatare (1 Setati masca de confidentialitate, titlul canalului, titlul orei, locatia,

suprapunerea si salvati modificarea. Puteti face clic pe Refresh

pentru a vedea efectul.

Implicit [ Faceti clic pe acesta pentru a restabili configuratia implicita.

Salvati [ Faceti clic pe acesta pentru a finaliza setarile video.

6.1.2.4 ROI

Nota: Unele serii nu accepta functia de configurare ROI.

Snapshot

Enable (e Disable

- Image Quality | 6(best b
> Audio - b {best)

Network
Event
Storage
System

Information

| Remowal || Delste | orRignteick)

‘ Default || Refresh || Save

Figura 6-23
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Snapshot Overlay

> Conditions

> Audio

Enable (® Disable

Image CQuality | 6(best) v
Network
Event
Storage
System
Information

Remave All Delete {Or Rightclick )

‘ Default || Refresh H Save

Figura 6-24

Parametrii Nota

Bifati "Enable", atunci se va afisa ROI in fereastra de monitorizare video; Bifati "Disable",
Activare atunci nu se va afisa.

0 Setati calitatea imaginii ROI, variind de la 1~6, valoarea implicitd este 6.

Nota:
Imagine . s , N .
Calitate Pentru dispozitivul fisheye, acesta variaza de la 1~6 (cel mai bun),
implicit este 6 (cel mai bun) o Abilitatea de a seta blocul de zone, maxim
4 zone.
6.1.2.5 Cale

Interfata céii de stocare este prezentata ca in figura 6-25.

Aici puteti seta calea de salvare a imaginii snap si calea de stocare a inregistrarii.

® Calea implicita a imaginii monitorului este C:\Users\admin\WebDownload\LiveSnapshot.

® Calea implicita de inregistrare a monitorului este C:\Users\admin\WebDownload\LiveRecord.

® (Calea implicita a instantaneului de redare este C:\Users\admin\WebDownload\PlaybackSnapshot.
Calea implicita de descarcare a redarii este C:\Users\admin\WebDownload\PlaybackRecord. Calea
implicita de taiere a redarii este: C:\Users\admin\WebDownload\VideoClips.

Nota:

Admin este conectat local Tn contul PC.

Va rugam sa faceti clic pe butonul Salvare pentru a salva configuratia curenta.
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Video

Snapshot

» Condifions

> Audio

Live Snapshot C:\Users\admin'WebDownload\LiveSnapshot Browse...
Live Record C:Wsers\admin'WebDownload\LiveRecord Browse...

Playback Snapshot  C:\Users\adminiWebDownload\PlaybackSnapshot Browse...
Network
Evest Playback Download  C:\Users\adminiWebDownload\PlaybackRecord Browse...

Video Clips C:\Users\admin'WebDownload\VideoClips Browse...

Storage

System Default | ‘ Save
Information

Figura 6-25

6.1.3 Audio
Va rugam sa retineti ca unele dispozitive din serie nu accepta functia audio.

6.1.3.1 Audio
Interfata audio este prezentata mai jos. A se vedea figura 6-26.

E) L E]

TECKNOLOGY

Audio

Conditio
— Encode
-
Network [¥] Enable
Event Encode Mode GT11A (=]
Storage Sampling Frequency | 16k E
System
. Sub Stream
Information =
[] Enable Sub Stream 1 [+
Encode Mode [G711A [+
Sampling Frequency | 16k E
— Attribute —
Audioln Type Lineln E
Naise Filter Enable [+]
Microphone Volume [=] O 50
Speaker Volume =1 D 50
Default || Refresh ‘ ‘ Save ‘

Figura 6-26

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru Functia

Activare Puteti activa audio numai atunci cand este activata functia video.

Dupa selectarea "Activare" a fluxului principal sau a fluxului secundar,
fluxul de transmisie de retea este fluxul compozit audio/video, in caz
contrar acesta include doar imaginea video.
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Modul de codare

Modul de codare al fluxului principal si al fluxului suplimentar include
G.711A, G.711Mu, G.726 si ACC. Modul implicit este
G.711A.

Configuratia de aici este pentru modul de codificare audio si
codificarea bidirectionalé a vorbirii.

Frecventa de

Frecventa de esantionare a sunetului. Aceasta include urmatoarele

esantionare optiuni:
e 8K
® 16K
® 32K
® 48K
® 64K
Audioln Tip Doua moduri de selectat: Lineln, Mic.

Dispozitivul trebuie sa conecteze sursa de intrare audio externa in
modul Lineln si nu trebuie s& conecteze sursa de intrare audio externa
in modul Mic.

Filtru de zgomot

Activati functia si aceasta poate filtra zgomotul relevant.

Volumul
microfonului

Reglati volumul microfonului de la 0~100.
Nota:
Suportat de unele dispozitive.

Volumul difuzorului

Reglati volumul difuzorului de la 0~100.
Nota:
Suportat de unele dispozitive.

6.1.3.2 Alarma audio

Network
Event
Storage
System

Information

Alarm Audio

alarmi.pecm

alarm2.pecm (r]

Add Audio File
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Figura 6-27
Add Audio File [ ¢ |
f~ Record  Upload
Audio File | pcm
Fecord
Figura 6-28

Managementul audio accepta in prezent formatul PCM pentru a inregistra si PCM, wav doua forme pentru a
incarca, si poate selecta un fisier audio pentru legatura de alarma audio.
Modul de descarcare a fisierului audio de redare a alarmei web in local este dupa cum urmeaza:

Pasul 1 Utilizati butonul stang al mouse-ului pentru a face clic pe cercul gol ' 1in coloana "alegere" din stanga si

L@ N “ S . .
arata = , ceeaceinseamna alegerea eficienta a alarmei audio.

+
Pasul 2 Utilizati butonul din dreapta al mouse-ului pentru a face clic pe = , selectati "salvati tinta ca" pentru a
descarca.

6.2 Retea
6.2.1 TCP/IP

Interfata TCP/IP este prezentata ca in Figura 6-29. Aceasta accepta IPv4 si IPv6. IPv4 suport3 IP static si DHCP.
IPv6 accepta doar IP static. Atunci cand utilizatorii modifica manual adresa IP, WEB va sari automat la noua adresa

IP.

Camera

[}

Host Name IPC

> Connection Ethernet Card Wire(DEFAULT) 2 Setas Default

> PPPOE lode & Static ¢ DHCP
> DDNS MAC Address 90 . 02

> IP Filter IP Version 1Pvd i

> SMTP(Email)

IP Address 172 . 29 Z 36

Eitkne Subnetmask 256 255 . 0 0
Sl

i Default Gateway 172 . 29 0 1
> Bonjour

Preferred DNS Semver| 8 8 8 8
> Multicast

Alternate DNS Server | 8 8 4 4
> WIFI - - -

¥ Enable ARF/Fing to setIP address service

> 8021
> QoS Default | | Refresh | ‘ Save

Event

Storage

System

Information
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Figura 6-29
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
Nume gazda Permite setarea numelui dispozitivului gazda curent. Suporta maxim

15 caractere.

Card Ethernet

Va rugam sa selectati portul Ethernet. Implicit este cu fir.

Va rugam sa retineti ca puteti modifica cardul Ethernet implicit daca
existd mai multe carduri.

Modul Existéd doud moduri: modul static si modul DHCP. Selectati modul
DHCP, acesta cauta automat IP si nu puteti seta IP/masca de
subretea/poarta de acces. Selectati modul static, trebuie sa setati
manual IP/masca de subretea/poarta de acces.

Adresa Mac Aceasta este pentru a afisa adresa Mac a furtunului.

Versiunea IP Se selecteaza versiunea IP. IPV4 sau IPV6.

Puteti accesa adresa IP a acestor doua versiuni.
Adresa IP Va rugam sa utilizati tastatura pentru a introduce numarul

corespunzator pentru a modifica adresa IP si apoi sa setati masca de
subretea corespunzéatoare si gateway-ul implicit.

DNS preferat

Adresa IP DNS.

DNS alternativ

Adresa IP DNS alternativa.
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Activati serviciul
ARP/Ping de
stabilire a adresei
IP a dispozitivului.

Puteti utiliza comanda ARP/Ping pentru a modifica sau a seta adresa
IP a dispozitivului daca cunoasteti adresa MAC a dispozitivului.

Inainte de operare, asigurati-va ca camera de retea si PC-ul se afla in
acelasi LAN. Aceasta functie este activata in mod implicit.

Puteti consulta pasii enumerati mai jos.

Pasul 1: Obtineti o adresa IP. Setati camera de retea si PC-ul in
acelasi LAN.

Pasul 2: Obtineti adresa fizica de pe eticheta camerei de retea.

Pasul 3: Accesati interfata Run si apoi introduceti urmatoarele
comenzi.
arp -s <Adresa IP> <MAC>

ping -1 480 -t <Adresa IP>

Cum arfi : arp-s 192.168.0.125 11-40-8¢-18-10-11 ping -
480 -t 192.168.0.125 Pasul 4: Reporniti dispozitivul.
Pasul 5: Puteti vedea ca configurarea este OK daca puteti vedea ca
exista informatii de iesire, cum ar fi "Raspuns de la 192.168.0.125 ..."
din liniile de iesire ale comenzii. Acum puteti inchide linia de comanda.
Pasul 6: Deschideti browse si apoi introduceti http:/<Adresa IP>.
Faceti clic pe butonul Enter, puteti accesa acum.

6.2.1.1 Easydip

Faceti clic pe "Enable" pentru a conecta dispozitivul la retea si apoi va puteti conecta la dispozitiv prin intermediul
clientului mobil Easy4ip dupéa ce "Online" este afisat pe interfatd (modul de conectare: adaugati numarul de serie al

dispozitivului sau scanati codul QR). A se vedea Figura 6-30.

@Jhua

Camera TCP/P

e [~ Enable
Ci cli
> Connection Status

> PPPoE
SN

> DDNS

QR Code
> IP Fitter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> M ast

> HTTPs
Event

Storage

System

Information

Easy4ip

Offline
1K037FCPAW00213

Elg:EE

Default ‘ ‘ Refresh | ‘ Save

Figura 6-30
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6.2.2 Conexiune

6.2.2.1 Conexiune

Interfata de conectare este prezentata in Figura 6-31.

@lhua R .co0c... S S

Camera Connection @

Wax Connection (1~20)

TCP Port i (1025~65534)
S UDP Port [37778 (1025~85534)
> DDNS HTTP Port |80
> IP Filter RTSP Port | 554
> SMTP(Email) HTTPs Port (443

> UPnP

Default

> SNMP ‘ | Refresh | | Save

> Bonjour

> M

Event
Storage

System

Information

Figura 6-31

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru  [Functia

Max Este conexiunea Web maxima pentru acelasi dispozitiv. Valoarea variazé de la 1 la
conexiune 20. Valoarea implicitd a conexiunii este 10.

Port TCP Intervalul porturilor este 1025~65534. Valoarea implicita este 37777. Daca este
necesar, puteti introduce numarul de port real.

Portul UDP [Intervalul porturilor este 1025~65534. Valoarea implicita este 37778. Daca este
necesar, puteti introduce numarul de port real.

Portul HTTP [Intervalul porturilor este 1025~65524. Valoarea implicita este 80. Daca este
necesar, puteti introduce numarul de port real.
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Port RTSP | ® Valoarea implicita este 554. Va rugam sa lasati gol daca utilizati valoarea
implicita. Utilizatorul foloseste QuickTime sau VLC poate reda urmatoarele
formate. BlackBerry poate reda de asemenea.

® Formatul URL de monitorizare in timp real, v rugdm sa solicitati server media
RTSP in timp real, sa solicitati nr. canalului, tipul fluxului de biti in URL. Este
posibil s& aveti nevoie de nume de utilizator si parola.

®  Utilizatorul foloseste BlackBerry trebuie sa seteze modul de codare la H.264B,
rezolutia la CIF si s& dezactiveze audio.

Formatul URL este:
rtsp://username:password@ip:port/cam/realmonitor?channel=1&subtype=0
Username/password/IP si port.

IP este IP-ul dispozitivului, iar valoarea implicita a portului este 554. Puteti sa o
lasati Tn alb daca aceasta este valoarea implicita.

Urmati protocolul standard RTP si atunci cand modul de codare este MJPEG,
rezolutia maxima accepta doar 2040*2040.

HTTP Portul de comunicare HTTP, intervalul este 1025~65534, implicit este 443.
Port

Nota:

® 0~1024, 37780~37880, 1900, 3800, 5000, 5050, 9999, 37776, 39999, 42323 sunt toate porturi speciale.
Utilizatorul nu le poate modifica.

®  Evitati utilizarea valorii portului implicit al altor porturi.

6.2.2.2 ONVIF

ONVIF (Open Network Video Interface Forum), acest standard descrie modul video de retea, interfata, tipul de date
si modul de interactiune a datelor. Scopul standardului ONVIF este de a realiza un acord privind cadrul video de
retea si de a face ca produsele video de retea (inclusiv front-end video, echipamente video etc.) de la diferiti
producatori sa fie complet compatibile.

Functia ONVIF este activata in mod implicit.
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alhua

TECHNOLOGY

Camera Connection

Authentication @ ON () OFF

Default ‘ | Refresh ‘ ‘

» DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

Storage
System

Information

Figura 6-32

6.2.3 PPPoE

Interfata PPPOE este prezentata ca in Figura 6-33.

Introduceti numele de utilizator si parola PPPoE care sunt furnizate de ISP (Internet Service Provider) si faceti clic
pe "Enable". Camera de retea va stabili automat conexiunea de retea in modul

PPPoE dupa ce este activat; dupa ce este activat cu succes, IP-ul din "Adresa IP" va fi modificat automat in
adresa IP dinamica a WAN-ului achizitionat. Nota:

Dupa ce apelarea PPPoOE are succes, trebuie sa va conectati la dispozitiv prin IP-ul setat inainte de apelare; in
interfata de configurare PPPOE, se va afisa adresa IP inregistrata, iar apoi puteti vizita adresa IP prin client.

Va rugam sa dezactivati UPnP atunci cand faceti clic pe activarea PPPoE, pentru a evita influentarea dialup-ului
PPPoE.

[] Enable

Usemame
> Connection

Password

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> Qo8

Event

Storage

System

Information

Figura 6-33
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6.2.4 DDNS

Interfata DDNS este prezentata ca in Figura 6-34.
DDNS trebuie setat pentru a conecta diverse servere, astfel incat sa puteti accesa sistemul prin intermediul

serverului. Va rugam sa mergeti la site-ul web al serviciului corespunzator pentru a aplica un nume de domeniu si
apoi sa accesati sistemul prin intermediul domeniului. Functioneaza chiar daca adresa dvs. IP s-a schimbat. Atunci
cand dispozitivul se conecteaza la WLAN, trebuie sa dezactivati UPnP.

@Jhua

Camera DDNS

& [C] semverType Dzhua DDNS [~]

> Connection Server Address

> PPPaE Mode @ Auto () Manual

> IP Filter Username (Optional)Please input the mailbox

Domain Name g E dahuaddns.com

> SMTP(Email)

Default ‘ ‘ Refresh ‘ ‘ Save
> UPnP

> SNMP

> Bonjour

> Mul

Event

Storage

System

Information

Figura 6-34
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
Tip server Puteti selecta protocolul DDNS din lista derulanta: CN99 DDNS, NO-IP
DDNS, Dyndns DDNS si Dahua DDNS. Valoarea implicitd este Dahua
DDNS.

Adresa serverului | Adresa IP a serverului DDNS

CN99 DDNS

Adresa serverului: www.3322.0rg
NO-IP DDNS

Adresa serverului: dynupdate.no-ip.com
Dyndns DDNS

Adresa serverului: members.dyndns.org
Dahua DDNS

Adresa serverului : www.dahuaddns.com

Modul Implicit este automat, cu posibilitatea de a alege manual
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Numele

domeniului

Atat auto cat si manual sunt "MAC addresss.dahuaddns.com"in mod
implicit, putand seta prefixul manual.

Nume utilizator

Numele de utilizator pe care il introduceti pentru a va conecta la server,
optional.

Interfata CN99 DDNS este prezentata ca in Figura 6-35.

> Connection

> PPPoE

> IP Filter

> SMTP{Email)
> UPnP

> SNMP

> Bonjour

> Multicast

> 802.1x

> QoS

Event

Storage
System

Information

] server Type

CNS3 DDNS
Server Address
Domain Name none
Usemame none
Password

Update Period 10 Minute (1~500)

Refresh ‘ | Save

Figura 6-35

Parametru

Functia

Tip server

Puteti selecta protocolul CN99 DDNS

Adresa serverului

In cadrul CN99 DDNS adresa implicita a serverului este "www.3322.org"

Numele
domeniului

Nume de domeniu auto-definit

Nume utilizator

Numele de utilizator pe care il introduceti pentru a va conecta la server.

Parola

Parola pe care ati introdus-o pentru a va conecta la server

Perioada de
reimprospatare

Perioada de actualizare a conexiunii dintre IP-ul dispozitivului si server, implicit 10 minute.

6.2.5 Filtru IP

Interfata filtrului IP este prezentata ca in Figura 6-36.
Puteti activa functia de filtrare IP astfel incat anumiti utilizatori IP/MAC specificati sa poata accesa camera de retea.

Puteti adauga adresa IP sau segmentul IP.
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Daca nu bifati caseta de aici, Inseamna ca exista o limita de acces.
Aici puteti adduga adresa IP si adresa MAC. Trebuie sa adaugati aceste adrese inainte de a activa site-urile de

Tncredere.

Va rugam sa retineti: Trebuie sa setati adresa MAC in acelasi segment de retea.

IP Filter

Trusted Siles
> TCPIP

Trusted Sites
> Connection
> PPPoE
> DDNS

> SMTP(Email)

> UPnP
> SNMP
> Bonjour
> Mullicast

IP address /MAC address

e Add IPIMAG

> QoS

[ et ||
Event

Refresh ‘ | Save

Storage
System

Information

6.2.6 SMTP (e-mail)

Figura 6-36

Interfata SMTP este prezentata ca in Figura 6-37.

SMTP(Email)

SMTF Server

Port
> Connection .
> PPPOE (2], Apanyry
C
> DDNS Username
S IP Filter Password
Sender

s SHIR(EmA),

> UPnP

Authentication

> SNMP

Title
> Bonjour

Mail Receiver
> Muliicast

Interval
Storage [ Health Mail

System

Information

none

25
none
None =]
[¥] Attachment
e
1] Second (0~3600)
Update Period G0 Second (1~3600)
Email Test

[ e || Rewesn || sawe

Figura 6-37

V& rugdm sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru

Functia
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Server SMTP Introduceti adresa serverului si apoi activati aceasta functie.
Port Valoarea implicita este 25. Puteti sa o modificati daca este necesar.
Anonimatul Pentru serverul care accepta functia de e-mail anonim, acesta nu va

afisa informatiile expeditorului.

Nume utilizator Numele de utilizator al contului de e-mail al expeditorului.
Parola Parola contului de e-mail al expeditorului.
Expeditor Adresa de e-mail a expeditorului.

Autentificare (Mod Puteti selecta SSL, TLS sau niciunul.
de criptare)

Titlu (Subiect) Introduceti aici subiectul e-mailului.

Atasament Sistemul poate trimite prin e-mail imaginea instantanee odata ce
bifati caseta de aici.

Destinatarul Introduceti aici adresa de e-mail a destinatarului. Maxim trei

corespondentei adrese.

Parametru Functia

Interval Intervalul de trimitere variaza de la 0 la 3600 de secunde. 0

fnseamna ca nu exista niciun interval.

Va rugam sa retineti ca sistemul nu va trimite e-mailul imediat cand
apare alarma. Atunci cand alarma, detectarea miscarii sau
evenimentul de anomalie activeaza e-mailul, sistemul trimite e-mailul
in functie de intervalul pe care I-ati specificat aici. Aceasta functie
este foarte utila atunci cand exista prea multe e-mailuri activate de
evenimentele de anomalie, care pot duce la o sarcina mare pentru
serverul de e-mail.

Sanatate e-mail Va rugam sa bifati caseta de aici pentru a activa aceasta functie.
permite
Test e-mail Sistemul va trimite automat un e-mail o data pentru a testa daca

conexiunea este OK sau nu.inainte de testul de e-mail, va rugam sa
salvati informatiile de configurare a e-mailului.

6.2.7 UPnP

Aceasta va permite sa stabiliti relatia de corespondenté dintre LAN si reteaua publica.

Aici puteti adauga, modifica sau elimina elemente UPnP. Pentru UPnP pe routere diferite, trebuie sa dezactivati
functia UPnP. A se vedea figura 6-38.

In sistemul de operare Windows, de la Start->Panel de control->Adaug& sau elimin& programe. Faceti clic pe
"Add/Remove

Windows Components" si apoi selectati "Network Services" din Windows Components Wizard. Faceti clic pe
butonul Detalii si apoi bifati "Internet Gateway Device Discovery and Control client" si
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"Interfata utilizator UPnP". Va rugam sa faceti clic pe OK pentru a incepe instalarea.
Activati UPnP de pe Web. Daca UPnP este activat in sistemul de operare Windows, camera de retea o poate
detecta automat prin "My Network Places".

In modul manual, puteti modifica portul extern. in modul automat, selectati portul inactiv pentru maparea automata
a porturilor fara modificarea de catre utilizator.

TN S — e TR T -

UPnF

[C] Enable Mode Manual E‘ Router State Mapping Failed
> TCPAP

Port Mapping List

> Connection Service Name Protocol B

> PPPoE el HTTP WebSenvice:TCP 80 8080 Mapping Failed

> DDNS TCP PrivService:TCP 77T 3T Mapping Failed £
> IP Filter il upP PrivService:UDP 37778 37778 Mapping Failed £
> SMTP(Email) RTSP RTSPService: TCP 554 554 Mapping Failed &

> Bonjour

> Muificast

> 802 1x

> QoS

Event
Storage
System
Information

Figura 6-38

6.2.8 SNMP

Interfata SNMP este prezentata ca in Figura 6-39 si Figura 6-40.

SNMP permite comunicarea intre software-ul statiei de lucru de gestionare a retelei si proxy-ul dispozitivului
gestionat. Va rugam sa instalati un software precum MG MibBrowser 8.0c sau sa stabiliti serviciul SNMP inainte de
a utiliza aceasta functie. Trebuie sa reporniti dispozitivul pentru a activa noua configurare.

SNMP

SNMP Version [ SNMPvi [T SNMP 2 [T SNMPva

> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public

> DDNS Write Community private

> IP Filter Trap Address

> SMTP(Email) Trap Port 162

> UPnP

> Bonjour

> Multicast
> 802.1x
> QoS
Event

Storage

System

Information
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Figura 6-39

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru

Functia

Versiunea SNMP

® \Verificati SNMP v1, dispozitivul proceseaza numai informatii v1.

®  Verificati SNMP v2, dispozitivul proceseaza numai informatii v2.

® Verificati SNMP v3, puteti seta numele de utilizator, parola si
metoda de criptare. Serverul calibreaza numele de utilizator,

parola si metoda de criptare corespunzatoare dispozitivului de
acces si v1/v2 nu sunt disponibile.

Port SNMP Portul de ascultare al programului proxy al dispozitivului. Acesta este
un
Portul UDP nu un port TCP. Valoarea variaza de la 1 la 65535.
Valoarea implicita este 161

Comunitate Este un sir de caractere, ca o comanda intre manager si proxy, care

defineste un proxy si autentificarea unui manager.

Citeste comunitatea

Acces numai pentru citire la toate tintele SNMP, implicit este public.
Nota: Sunt acceptate numai numerele, literele, _ si -.

Scrieti comunitatea

Acces de citire/scriere la toate tintele SNMP, implicit este privat.
Nota: Sunt acceptate numai numerele, literele, _ si -.

Adresa capcana

Adresa de destinatie a informatiilor Trap de la programul proxy al
dispozitivului.

Adresa Trap

Adresa la care se trimite mesajul Trap.

Port capcana

Portul care trimite mesajul Trap, implicit este 162, intervalul
1~65535.

SNMP

> TCPAP

SNMP Version

SNMP v1 SNMP v2 [7] SNMP v3

> Connection SNMP Port 161 (1~65535)
> PPPoE Read Community public
> DDNS Write Community private
> IP Fitter Trap Address
> SMTP(Email) Trap Port 162
> UPnP
Read-only Usemame public
5 > Bonjour Authentication Type @ MD5 () SHA
> Mutticast Authentication Passwerd
> 802.1x Encryption Type @ CBC-DES
> QoS Encryption Password
Event
storage Read&write Usemname private
system Authentication Type @ MD5 () SHA
Information Authentication Password
Encryption Type @ CBC-DES
Encryption Password
Default | ‘ Refresh | | Save
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Figura 6-40

Verificati versiunea SNMP v3 si portul SNMP, comunitatea de citire, comunitatea de scriere, adresa Trap, portul
Trap sunt aceleasi cu versiunile SNMP v1 si SNMP v2. Numai atunci cand versiunea SNMP este SNMP v3,
utilizatorii trebuie sa configureze parametrii in diagrama.

Parametru

Functia

Versiunea SNMP

SNMP v3

Numai citire
Nume utilizator

Valoarea implicita este public.
Nota:
Numele poate fi doar numar, litera si subliniere.

Citire/Scriere
Nume utilizator

Implicit este privat.
Nota:
Numele poate fi doar numar, litera si subliniere.

Autentificare Puteti selecta MD5 sau SHA, implicit MD5.
Parola de

autentificare Parola nu mai mica de 8 caractere.
Criptare Valoarea implicita este CBC-DES.

Parola de

criptare Parola nu mai mica de 8 caractere.

6.2.9 Bonjour

Interfata Bonjour este prezentatd mai jos. A se vedea Figura 6-41.
Bonjour se bazeaza pe serviciul DNS multicast de la Apple. Dispozitivul Bonjour poate difuza automat informatiile

sale de serviciu si poate asculta informatiile de serviciu de la alte dispozitive.

Daca nu cunoasteti informatiile despre camera de retea, cum ar fi adresa IP, puteti utiliza navigarea serviciului
Bonjour in acelasi LAN pentru a cauta dispozitivul camerei de retea si apoi pentru a-l accesa.

Puteti vizualiza numele serverului atunci cdnd camera de retea este detectata de Bonjour. Va rugam sa retineti ca
navigarea safari accepta aceasta functie. Faceti clic pe "Afisati toate marcajele: si deschideti Bonjour, sistemul
poate detecta automat camera de retea a functiei Bonjour Th LAN.
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Camera Bonjour

[@] Enable

> TCPIP

Server Name PZC1EW24200002
> Connection

> PPPOE Default ‘ | Refresh

> DDNS
> IP Filter
> SMTP(Email)

Storage

System

Information

Figura 6-41

6.2.10 Multicast

Interfata multicast este prezentata ca in Figura 6-42.

Multicast este un mod de transmitere a pachetelor de date. Atunci cand exista mai multe gazde care trebuie sa

primeasca acelasi pachet de date, multicastul este cea mai buna optiune pentru a reduce latimea de banda si

sarcina CPU. Gazda sursa poate trimite doar o singura data pentru tranzit. Aceasta functie depinde, de

asemenea, de relatia dintre membrul grupului si grupul exterior.

Nota

® Deschideti previzualizarea, protocolul de streaming media, selectati multicast si monitorizati prin format
multicast.

® Aici puteti seta adresa si portul multicast. De asemenea, trebuie s& mergeti la interfata Live pentru a seta
protocolul ca Multicast.

Multicast

Main Stream Sub Stream

[¥] Enable [¥] Enable
> Connection

Multicast Address 224 » -4 |(224.0.0.0~239 255 255.255) Multicast Address (224.0.0.0~239 255 255 255)
> PPPoE

Port 40000 (1025~65534) Port {1025~65534)
> DDNS

> IP Filter

> SMTP(Email)
> UPnP
> SNMP

> Bonjour
s ..
> QoS

Event

Storage
System

Information

Figura 6-42

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
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Parametru Functia

Activare Selectati pentru a activa functia multicast. Fluxul principal si fluxul secundar nu pot fi
utilizate Tn acelasi timp.

Adresa Multicast Adresa implicita de multicast a fluxului principal/sub fluxului este 224.1.2.4, iar
intervalul sau este 224.0.0.0~239.255.255.255.

Port Portul Multicast. Fluxul principal este 40000, fluxul secundar 1 este 40016, fluxul
secundar 2 este 40032, iar intervalul este 1025~65534.

6.2.11 4G
Nota: Aceastéa functie este disponibila numai pentru seriile cu modul 4G.

4G este un sistem de comunicatii mobile care integreazd comunicatiile fara fir cu internetul si comunicatiile
multimedia.

6.2.11.1 Setarea apelarii

ua

TECHNOLOGY

3

a

Camera Dialing Setting | Mobile Settings

Wireless NetType | Auto EQ; Enable
> Connection APN 3gnet
> DDNS Authorize Mode No
> IP Filter Dial-up Number .*59#
» SMTP(Email) Usermame
> UPnP Password
2 Buriour Update Period 30 Hecaud
> Multicast Time Range
Wireless Network State
IP Address
Storage Wireless Signal WCDMA 0%
System FDD-LTE = 70 %
Information Default | | Refresh ‘ | Save
Figura 6-43
Parametru Functia
Tip retea fara fir Auto, WCDMA, FDD-LTE optional, puteti selecta in functie de
operator.
Activare Verificati pentru a activa modulul 4G.
APN Acesta este achizitionat de la operator in functie de configuratia
operatorului.
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Mod de autentificare Auto, PAP si CHAP, algoritmul de autentificare este diferit in functie
de operatorii diferiti.

Numar dial-up Numarul este diferit Tn functie de operator, acesta poate fi obtinut
de la operator.

Numele utilizatorului Acesta este achizitionat de la operator.

Parola Acesta este achizitionat de la operator.

Perioada de Este perioada dincolo de perioada de dial-up care a fost setata,
actualizare este de 30 de secunde in mod implicit, ceea ce inseamna ca

dispozitivul poate dobandi automat starea de dial-up 4G, intrerupe
dial-up-ul pentru a economisi fluxul.

Interval de timp Este perioada de timp pentru setarea apelarii. Se poate activa
functia prin mesaj pentru a activa/dezactiva functia de apelare
daca perioada de timp este depasita.

Adresa IP Acesta va afisa IP-ul dobandit dupa ce apelarea este reusita prin
4G.

6.2.11.2 Setare mobila
alhua

- TECHNOLOGY

Camera Dialing Setting

Mobile Settings

3T [l Message Send [T] Message Activation [T] Phone Activation

> Connection Receiver I+ Sender i+ Caller |+
> DDNS = = =
> IP Filter

> SMTP(Email)

> UPnP

Title Event Message

Storage

System ‘ ‘

Default Refesn || sawe

Information

Figura 6-44

Va rugdm sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru Functia
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Trimitere mesaj In cadrul evenimentului, dupa activarea mesajului corespunzétor,
acesta va trimite un mesaj catre telefonul destinatarului atunci cand are
loc evenimentul. Trebuie sa activati functia de activare a mesajului in
interfata evenimentului atunci cand utilizati functia.

Mesaj Acesta poate trimite mesajul ON/OFF catre cartela SIM din interiorul

Activare dispozitivului de catre telefonul mobil din lista, care este de a activa /
dezactiva functia de dial-up si trimite REBOOT pentru a reporni
dispozitivul.

Activarea telefonului | Puteti utiliza telefonul mobil din lista de apeluri pentru a apela cartela SIM
din dispozitiv pentru a activa functia de apelare.

6.2.12 WIFI

Nota:

Unele dispozitive din serie nu accepta functia WIFI si WPS.
Functia WPS este acceptata de dispozitivele cu buton WPS.

6.2.12.1 WIFI

WIFI info poate afisa numele, starea, informatiile IP ale Hot Spot-ului curent. De obicei, va rugam sa "Actualizati"
informatiile de lucru WIFI dupa reconectare pentru a asigura afisarea in timp real a starii de lucru, deoarece este
adesea nevoie de ceva timp pentru a conecta WIFI Hot Spot, care depinde de puterea semnalului de retea.

Camera WIF1

I” Enable ‘ Add 8SID H Search SSID ‘
> TCPIP

1D List

> Connedtion

> PPPOE ' - . 5
> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

WIFIINFO

Current Hot Spot
> QoS IP address
Event Subnetmask

Storage Default Gateway

Information

Figura 6-45
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TECHNOLOGY

Metoda de setare WIFI este dupa cum urmeaza:

W Enable o o
, Tnseamna activarea functiei WIFI.

o " Enable
Pasul 1 Faceti clic pe , show as

Pasul 2 Faceti clic pe "Search SSID" (Cautare SSID), iar in lista se afiseaza punctul fierbinte al retelei fara fir din
mediul camerei de retea curente.

Camera

> Connection
> PPPOE

> DDNS

> IP Filter

> SMTP(Email)
> UPnP

> SNMP

> Bonjour

> Multicast

¥ Enable

12345
5370test
TP-LINK_465EF6
AndroidAP
TP-LINK_425796
NETGEARE4

TR-LINK_NIJIAN

Add S3ID

H Search 551D ‘

WPA-PSK-AES
WPAIWPA2-PSK-TKIP+AES
WPA-PSK-TKIP+AES
WPAZ-PSK-AES
WPAIWPA2-PSK-TKIP+AES
NONE

WPAWPAZ-PSK-TKIP+AES

o

b Current Hot Spat  unconnected
> Qos IF address
Event Subnetmask
Default Gateway

Storage

System
.

Information

Figura 6-46

Pasul 3 Faceti clic pe "Add SSID" atunci cand trebuie s& adaugati manual o retea fara fir, scoateti o interfata
n figura de mai jos si introduceti ID-ul retelei in caseta de dialog.

Add Wireless SSID x|

5510

O Cancel

Figura 6-47
Pasul 4 Faceti dublu clic pe unul dintre ele pentru a afisa intensitatea semnalului si autentificarea punctului fierbinte.

- Va rugam sa introduceti parola daca este necesar. Atunci cand introduceti parola, va rugam sa alegeti acelasi
numar de index al parolei ca si routerul.

- Va rugam sa faceti clic pe "conectare" daca nu este necesar sa introduceti parola.

6.2.12.2 WPS
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aQlnaua

Camera WIFI

rk

 Enter FIN
> TCPIP

FIN

> Connection

SsiD

> PPPOE

~
> DDNS Button

> IP Filter Status disconnected

> SMTP(Email) Connecting || Refresh

> UPnP
> SNMP

> Bonjour
> Multicast
> 802.1x
> QoS
Event

Storage

System

Information

Figura 6-48

Numarul PIN si SSID sunt ambele obtinute de la router, va rugam s& "reimprospatati” informatiile de lucru ale WIFI

pentru a asigura afisarea in timp real a starii de lucru dupa completarea corecta.

6.2.13 802.1x

802.1x (protocol de control al accesului la retea bazat pe port) accepta selectarea manuala a metodei de
autentificare pentru a controla daca dispozitivul conectat la LAN poate intra in LAN. Suporté bine cerintele de
autentificare, Tncarcare, siguranta si gestionare a retelei.

802.1x

[C] Enable

> TCPAP

Authentication
> Connection

> PPPoE

Username

 DDNS Password

> IP Filter

> SMTP(Email)

> UPnP

> SNMP

> Bonjour

> Multicast
T

> QoS

Event

Storage

System

Information

Figura 6-49

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru Functia
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Autentificare PEAP (protocol EAP protejat).

Nume utilizator Acesta are nevoie de numele de utilizator pentru autentificare, care

este autentificat de server.

Parola Va rugam sa introduceti parola aici.

6.2.14 QoS

Interfata QoS este prezentata mai jos. A se vedea Figura 6-50.

Qos (Quality of Service) este un mecanism de securitate a retelei. Este o tehnologie de rezolvare a intarzierilor in
retea si a problemelor de bruiaj etc. Pentru serviciul de retea, calitatea serviciului include latimea de banda de
transmisie, intarzierea, pierderea pachetelor etc. Putem garanta latimea de banda de transmisie, putem reduce
intarzierea, putem reduce pierderea pachetelor de date si anti-dither pentru a imbunatati calitatea.

Putem seta DSCP (Differentiated Services Code Point) al IP pentru a distinge pachetele de date, astfel incat
routerul sau hub-ul sa poata furniza servicii diferite pentru diverse pachete de date. Acesta poate selecta diferite
cozi in functie de prioritatea (64 de niveluri de prioritate diferite) pachetelor si poate selecta latimea de banda a
fiecarei cozi. Nivelul O este cel mai scazut, iar nivelul 63 este cel mai ridicat. Acesta poate, de asemenea, sa
elimine Tn proportii diferite atunci cand latimea de banda larga este blocata.

Qos

Realtime Monitor 0

Command 0
> Connection

> PPPoE

> DDNS
> IP Fitter
> SMTP(Email)
> UPnP
> SNMP
> Bonjour
> Multicast
> 802.1x
[ o |
Event

Storage

System

Information

Figura 6-50

V& rugdm sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru

Functia

Monitor in timp
real

Valoarea variaza de la 0 la 63. Routerul sau comutatorul pot oferi
servicii diferite pentru diverse pachete de date.

Parametru

Functia
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Comanda Valoarea variaza de la 0 la 63. Routerul sau comutatorul pot oferi
servicii diferite pentru diverse pachete de date.
Activare Bifati-l pentru a activa QoS.
QoS fara fir
6.2.15 HTTPs

in interfata de setare HTTPs, utilizatorii pot face ca PC-ul sa se conecteze in mod normal prin HTTPs prin crearea
unui certificat sau prin Tncarcarea unui certificat semnat, care sa garanteze securitatea datelor de comunicare si sa

ofere protectie pentru informatiile utilizatorului si securitatea dispozitivului cu mijloace tehnice fiabile si stabile.

Pasul 1
Creati certificatul sau incarcati certificatul semnat.

1.

Va rugam sa urmati pasii de mai jos daca selectati "Creare certificat".

Selectati "Setup > Network > HTTPs", iar sistemul va afisa interfata HTTPs, care este prezentata in Figura 6-

51.

alhua

TECHNOLOGY

Camera

3 TCPAP [T] Enable HTTPs

> Connection Create Certificate
> DDNS Request Created
> IP Filter
Request Created ‘ | 3 ‘ | Download
> SMTP(Email)
Install Signed Certificate
> UPnP
> SNMP Certificate Path Browse...
» Bonjour Certificate Key Path Browse... | ‘
Certificate Installed
Certificate Installed I:|

Attribute

Storage

System

Information

Refresh ‘ ‘ Save

Figura 6-51
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HTTPs
Country CH *g.0. CN
IP or Domain name | 10.15.15.211| !
Validity Period 365 Day*Range :1-5000
Frovince | none
Location none
Organization | none
Crganization Unit none
Email
Creat Cancel

Figura 6-52

3. Completati "Tara", "Provincia" si alte informatii corespunzatoare; faceti clic pe "Creare" dupa completare. Se va
afisa promptul "Create Successfully", ceea ce inseamna ca certificatul serverului a fost creat cu succes. Nota:
Asigurati-va ca "IP sau numele de domeniu" este acelasi cu cel al dispozitivului.

4. Faceti clic pe "Install" (Instalati) si certificatul va fi instalat la capatul dispozitivului, dupd cum se arata in

Figura 6-53.
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TECHNOLOGY

@lhua

Camera

> TCPIP [[] Enable HTTPs

> Connection Create Certificate
e ——
Vi Request Created

> IP Filter

Request Created
> SMTP{Email)

> UPnP

> SHMP Certificate Path
> Bonjour Cerificate Key Path

Certificate Installed
Certificate Installed

Attribute

Event

Storage

System

Information

| L=none; O=none; OU=none; EM=;
| Issuer: HAP=test C=CN; ST=test; L=test O=test: -

Manual de utilizare Dahua Network Camera Web 3.0

Delete Download

Install Signed Certificate

Issue to: HIP=10.15.15.211; C=CN; 8T=none;

iy

Refresh Save

@ Save As

Figura 6-53

Faceti clic pe "Descarcare". Va aparea caseta de dialog "Salvati ca", salvati fisierul in computer.

@Q'|d b Libraries

Organize »
B Desktop
4. Downloads

i=| Recent Places

| « & Libraries
I | Documents
s .j'"u' Music
I =] Pictures

i B Videos

48 Computer
b & Local Disk (C:)

I = DISK1_VOL2 (Dx)
I = DISK1_VOL3 (E)

Libraries

[

Documents
*-—-'ua e Library

__Jm Music
: Library

Pictures

File name: RootCert.cer

Open a hbrary to see your files and arrange them by folder,...

Save as type: | (".cer)

= Hide Folders

[ Save

| |

Cancel I

Figura 6-54
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Faceti dublu clic pe pictograma descarcata a "RootCert.cer". Sistemul va afisa interfata de informatii a
"Certificatului”, care este prezentata in Figura 5-55.

Certificate ﬁ

General |Detai|s | Certification Path |

@ﬁ Certificate Information

This CA Root certificate is not trusted. To enable trust,
install this certificate in the Trusted Root Certification
Authorities store.

Issued to:  test

Issued by: test

Valid from 2016/ 7/ 8 to 2020/ 7/ 7

[Insmll Certificate.. l Issuer Statement

Figura 6-55

Faceti clic pe "Install Certificate" (Instalati certificatul) si va apéarea interfata "Certificate Import Wizard"
(Asistent pentru importul certificatului), care este prezentata in Figura 6-56.
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Certificate Import Wizard &,

Welcome to the Certificate Import

Wizard
g This wizard helps you copy certificates, certificate trust
= lists, and certificate revocation lists from your disk to a
- certificate store,

A certificate, which is issued by a certification autharity, is
a confirmation of your identity and contains information
used to protect data or to establish secure network
connections, A certificate store is the system area where
certificates are kept.

To continue, dick Mext,

ik Mext = ] l Cancel

s
o
(a1

Figura 6-56

8. Faceti clic pe "Next" (Urmatorul). Selectati "Trusted Root Certification Authorities”, care este prezentat in
Figura 6-57.
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Certbeate impor Wi

Certificate Store

Certificate stores are system areas where certificates are kept.

Windows can automatically select a certificate store, or you can specify a location for
the certificate,

(71 Automatically select the certificate store based on the type of certificate
@) Place all certificates in the following store

Certificate store:

Trusted Root Certification Autharities E Browse.., ]

Learn mare about cerfificate stores

| <Back | mext> | | cancel

Figura 6-57

Faceti clic pe "Next" (Urmatorul). Sistemul va afisa interfata "Completing the Certificate Import Wizard", care
este prezentata in Figura 6-58.
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Completing the Certificate Import
Wizard

ﬁ' : | The certificate will be imported after you dick Finish.

You have spedfied the following settings:

Certificate Store Selected by User Qgiti=s gzl de=giiile

Content Certificate

| <Back | Fmsh | [ cancel

Figura 6-58

10. Faceti clic pe "Finish" (Terminare) si va aparea caseta de dialog "Security Warning" (Avertisment de
securitate), care este prezentata in Figura 6-59.
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Security Warning |g

You are about to install a certificate from a certification authority (C4)
¢ ll claiming to represent:

test

Windows cannot validate that the certificate is actually from "test”. You
should confirm its erigin by contacting "test”. The following number
will assist you in this process:

Thumbprint (shal): 60811FD2 E82313A8 663514ED 2CASGEGE TD425FAG
Warning:

If you install this root certificate, Windows will automatically trust any
certificate issued by this CA. Installing a certificate with an unconfirmed
thumbprint is a security risk. If you click "Yes" you acknowledge this

risk,

Do you want to install this certificate?

Yes Mo

Figura 6-59

11. Faceti clic pe "Yes" (Da). Va apéarea caseta de dialog "Import reusit", faceti clic pe "Ok" pentru a finaliza
descarcarea certificatului, care este prezentata in Figura 6-60.

Certificate Import Wizard Iﬁ

|:0] The import was successful,
et

Figura 6-60

o Va rugam sa urmati urmatorii pasi daca selectati "Instalare certificat semnat".

1. Selectati "Setup > Network > HTTPs". Sistemul va afisa interfata HTTPs, care este prezentata in Figura 6-
61.
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@Jhua

Camera

> TCPIP [7] Enable HTTPs

> Connection Create Certificate
e Request Created
> IP Filter

Request Created gled; ‘ | z ‘ ‘ Download
> SMTP(Email)

Install Signed Certificate

> UPnP

Certificate Path er pe Browse...

Certificate Key Path D Browse... | Upload ‘
> Multicast Certificate Installed

= Cerificate Installed I:l

Aftribute
Event
Storage Refresh | | Save
System
Information

2. Selectati certificatul semnat si calea cheii de certificat prin "Réasfoire", apoi faceti clic pe "Incarcare".
3. Instalati certificatul radacina, consultati pasii 6~11 pentru mai multe detalii.
Bifati "Enable HTTPs", faceti clic pe "Save". Sistemul va afisa caseta de dialog "Trebuie s& reporniti
dispozitivul", iar apoi configuratia este valida.

Reboot

ﬂ The configuration takes effect, the device is restarting now, please dont leave this page or close the browser...

Figura 6-62

5. Utilizati HTTP
Utilizati HTTP pentru conectare.
Introduceti https://xx.xx.xx.xx Tn browser si va aparea interfata normala de conectare; browserul va solicita o eroare

de certificat daca certificatul nu este instalat, care este prezentata in Figura 6-63.
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()~ ] hitps/101515.211/

File Edit VWiew Favorites Tools Help

S Favorites | <y [Bl BuRss » ) RIS v

| {& Certificate Error: Navigation Blocked | |

A
|.® There is a problem with this website's security certificate.
The security certificate presented by this website was not issued by a trusted certificate authority.

Security certificate problems may indicate an attempt to fool you or intercept any data you send to the
Server,

We recommend that you close this webpage and do not continue to this website.
'@ Click here to close this webpage.

'&;‘D Continue to this website (not recommended).

@ More information

Figura 6-63

Nota:

"XX.XX.XX.Xx" corespunde IP-ului sau numelui domeniului dvs.

6.3 Eveniment

6.3.1 Detectarea video

6.3.1.1 Detectarea miscarii

Pasul 1

Selectati "Setup > Event > Video Detection > Motion Detection" si sistemul va afisa interfata "Motion Detection",
care este prezentata in Figura 6-64.
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Camera Motion Detection| Video Tampering
Network

Scene Changing

[C] Enable
— Warking Period
> Audio Detection - —
Anti-Dither 5 Second (0~100)
Smart Plan
> Face Detection I Record
> People Counting Record Delay 10 Second (10~300)
> bedtMep [¥] Relay-out
Zan i By 10 Second (40-300)
> Abnormality
[ Send Email
Storage
[7] snapshat
System
Information Default || Refresh H Save
Figura 6-64
Pasul 2
Selectati "Activare" pentru a activa functia de detectare a miscarii.
Pasul 3

Setati zona de detectare a miscarii.
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1. Faceti clic pe "Setup" si sistemul va afisa interfata "Setting Area", prezentata in Figura 6-65

Area

Sensitivity

Threshold

| Region1 |

28—
Bg——@s

(&) 60

Figura 6-65

2. Seteaza numele zonei, pentru a seta zona valida de detectare a miscarii in functie de situatia reala si poate
seta valoarea sensibilitatii si, respectiv, a pragului.

Cu cat sensibilitatea este mai mare, cu atat este mai usor de generat detectarea miscarii, cu cat pragul este
mai mic, cu atat este mai usor de generat detectarea miscarii; in mod implicit, intreaga imagine video este
zona valida de detectare a miscarii.

Nota:

®  Culorile diferite reprezinta zone diferite; fiecare zona poate seta o zona de detectie diferita.
® Linia rosie din oscilograma inseamna declansarea detectarii miscarii; linia verde inseamna ca nu se
declanseaza detectarea miscarii.

3. Faceti clic pe "Salvare" pentru a finaliza setarea zonei.

Pasul 4

Pentru a seta alti parametri de detectare a miscarii, consultati urméatoarea fisa pentru mai multe detalii.

Parametru

Functia
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Perioada de lucru

Nota:

Permite setarea perioadei de alarma, care poate activa evenimentul de alarma

numai in intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru"”.

2. Se stabileste perioada de lucru in conformitate cu urmatoarele metode:

®  Apasati butonul stang al mouse-ului si trageti-I pe interfata de configurare
pentru a-l seta.

® Click"

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul saptamanii (Tn mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii séptdmani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Anti-dither Sistemul memoreaza un singur eveniment in timpul perioadei anti-dither. Valoarea
variaza de la Os la 100s.
Zona 1. Faceti clic pe "Setup" si sistemul va afisa interfata "Set Area".

2. Seteaza numele zonei, pentru a seta zona valida de detectare a miscarii in
functie de situatia reald, si poate seta sensibilitatea si respectiv pragul acesteia.
Cu cét sensibilitatea este mai mare, cu atat este mai usor de declansat
detectarea miscarii, cu cat pragul zonei este mai mic, cu atat este mai usor de
generat detectarea miscarii, intreaga imagine video este zona valida a
detectarii miscarii Tn mod implicit.

Nota:

Culorile diferite reprezinta zone diferite; fiecare zona poate seta zone de detectie

diferite.

Linia rosie din oscilogramé inseamna declansarea detectarii miscarii, linia verde

inseamna céa nu se declanseaza detectarea miscarii.

3. Faceti clic pe "Salvare" pentru a finaliza configurarea zonei.

Inregistrare

Verificati-o si astfel, atunci cand apare alarma, sistemul va inregistra automat.
Trebuie sa setati perioada de inregistrare in Storage>Schedule si sa selectati
inregistrarea automata in interfata de control al inregistrarii.

Intarziere la
inregistrare

Sistemul poate intarzia inregistrarea pentru un timp specificat dupa terminarea
alarmei. Valoarea variaza de la 10s la 300s.

lesire releu

Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei
astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma

Sistemul poate intarzia iesirea alarmei pentru un timp specificat dupa terminarea
alarmei. Valoarea variaza de la 10s la 300s.

Trimite e-mail

Dacd activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Legatura audio

Verificati-o si sistemul va reda fisierul audio de alarma atunci cand apare alarma.
Puteti seta fisierul audio Thregistrat sau incarcat in "camera setting > audio > alarm
audio".

Legatura flash

Verificati si blitul se va aprinde cand apare alarma, iar blitul se va stinge pana la

sfarsitul alarmei dupa o intarziere corespunzatoare.
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Parametru Functia

PTZ ®  Aici puteti seta miscarea PTZ atunci cand apare o alarma. Cum ar fi sa mergeti
la presetarea x atunci cand exista o alarma.
® Tipul de eveniment include: presetare, tur si model.

Instantaneu Trebuie sa bifati casuta aici, astfel incét sistemul sa poaté salva fisierul instantanel
de detectare a miscarii. Trebuie sa setati perioada de snapshot in Storage>Schedule

Pasul 5
Faceti clic pe "Salvare" pentru a finaliza setarea detectarii miscarii.

6.3.1.2 Manipularea video
Pasul 1
Selectati "Setup > Event > Video Detection > Video Tampering" si sistemul va afisa interfata "Video Tampering"

care este prezentata in Figura 6-66.
ua

- TECHNOLOGY

Camera Wotion Detection JVideo Tampering{ Scene Changing

Network
[1 Enable Video Tampering 7] Enable Defocus Detection
> Audio Detection AR
[¥] Record
Record Delay 10 Second (10~300)
> Face Detection [¥] Relay-out
> People Counting Alarm Delay 10 Second (10~300)
7. HemMap [”] sendEmail
G [] Snapshot
» Abnormality
Storage Default ‘ ‘ Reifresh H Save
System
Information
Figura 6-66
Pasul 2
Setati parametrul de falsificare video; consultati urmatoarea fisa pentru mai multe detalii.
Parametru Functia
Activarea Trebuie sa bifati caseta pentru a activa alarma de detectare a mastii video.

manipularii video

Activati detectarea | Trebuie sa bifati caseta pentru a activa alarma de detectare a defocalizarii.
defocalizarii

Parametru Functia
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Perioada de lucru | Nota:

Permite setarea perioadei de alarma, care poate activa evenimentul de alarma

numai in intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru"”.

2. Se stabileste perioada de lucru in conformitate cu urmétoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul stang al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Exista sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul saptamanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptaméana, inseamna ca setarea poate fi aplicata
intregii séptdmani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Inregistrare Verificati-o si astfel, atunci cand apare alarma, sistemul va inregistra automat.
Trebuie sa setati perioada de inregistrare in Storage>Schedule si sa selectati
inregistrarea automata in interfata de control al inregistrarii.

Intarziere la Sistemul poate intarzia inregistrarea pentru un timp specificat dupa terminarea
inregistrare alarmei. Valoarea variaza de la 10s la 300s.
lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma Sistemul poate intarzia iesirea alarmei pentru un timp specificat dupa terminarea
alarmei. Valoarea variaza de la 10s la 300s.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Legatura audio Verificati-o si sistemul va reda fisierul audio de alarma atunci cand apare alarma.
Puteti seta fisierul audio inregistrat sau incarcat in "camera setting > audio > alarn
audio".

Legatura flash Verificati si blitul se va aprinde cand apare alarma, iar blitul se va stinge pana la

sfarsitul alarmei dupé o intarziere corespunzatoare.

PTZ ®  Aici puteti seta miscarea PTZ atunci cand apare o alarma. Cum ar fi sa mergeti
la presetarea x atunci cand exista o alarma.

® Tipul de eveniment include: presetare, tur si model.

Instantaneu Trebuie sa bifati casuta aici, astfel Tncat sistemul sa poata salva fisierul instantane
de detectare a miscarii. Trebuie sa setati perioada de snapshot in Storage>Schedule

Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea manipularii video.

6.3.1.3 Schimbarea scenei

Pasul 1

Selectati "Setup > Event > Video Detection > Scene Changing" si sistemul va afisa interfata "Scene Changing",
prezentata in Figura 6-67.
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@lhua

Camera Motion Detection § Video Tampering | Scene Changing

Network
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> Face Detect 7] Relay-out
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Storage Default | | Refresh ‘ | Save

System

Information

Figura 6-67

Pasul 2
Bifati "Activare" pentru a activa functia de schimbare a scenei.
Pasul 3

Acesta este pentru a seta parametrii de schimbare a scenei, consultati urmatoarea fisa pentru mai multe detalii.
Parametru Functia

Perioada de lucru | Nota:

Permite setarea perioadei de alarma, care poate activa evenimentul de alarma

numai in intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru"”.

2. Se stabileste perioada de lucru in conformitate cu urmétoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul stang al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Exista sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul saptamanii (Tn mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii séptdmani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Inregistrare Verificati-o si astfel, atunci cand apare alarma, sistemul va inregistra automat.
Trebuie sa setati perioada de inregistrare in Storage>Schedule si sa selectati
inregistrarea automata in interfata de control al inregistrarii.

intarziere la Sistemul poate intarzia inregistrarea pentru un timp specificat dupa terminarea
inregistrare alarmei. Valoarea variaza de la 10s la 300s.
lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma Sistemul poate ntarzia iesirea alarmei pentru un timp specificat dupa terminarea
alarmei. Valoarea variaza de la 10s la 300s.
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Parametru

Functia

Trimite e-mail

Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

PTZ ® Aici puteti seta miscarea PTZ atunci cand apare o alarma. Cum ar fi sa mergeti
la presetarea x atunci cand exista o alarma.
® Tipul de eveniment include: presetare, tur si model.
Instantaneu Trebuie sa bifati casuta aici, astfel incét sistemul sa poata salva fisierul instantaney
de detectare a miscarii. Trebuie sa setati perioada de snapshot in Storage>Schedule
Pasul 4

Faceti clic pe "Salvare" pentru a finaliza configurarea schimbarii scenei.

6.3.2 Detectarea audio

Pasul 1

Selectati "Setup > Event > Audio Detection" si sistemul va afisa interfata "Audio Detection" care este prezentata in

Figura 6-68.

hua

TECHNOLOGY
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Pasul 2
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Figura 6-68

Seteaza parametrii de detectare audio, consultati urmatoarea fisa pentru mai multe detalii.

Parametru

Functia
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Activare intrare
anormala

Selectati "Activare intrare anormala” si va declansa o alarma atunci cand
detecteaza o intrare audio anormala.

Activati schimbarea

Selectati "Enable Intensity Change" (Activare modificare intensitate) si va declansa

intensitatii o alarma atunci cand detecteaza ca modificarea intensitatii audio depaseste pragul.

Sensibilitate Poate fi considerata o anomalie audio atunci cand modificarea volumului de intrare
depaseste volumul mediului continuu; utilizatorii trebuie sa ajusteze in functie de
testul mediului real.

Prag Acesta este de a seta intensitatea volumului mediului filtrat, in cazul in care

zgomotul ambiental este prea mare, atunci valoarea trebuie sa fie setata mai mare,
utilizatorii pot ajusta in functie de testul mediului real.

Perioada de lucru

Nota:

Permite setarea perioadei de alarma, poate activa evenimentul de alarma numai in

intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru”.

2. Se stabileste perioada de lucru Tn conformitate cu urmatoarele metode:

®  Puteti introduce valoarea numericéa a timpului sau puteti apasa butonul stang al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul saptamanii (Tn mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii séptdmani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Anti-dither

Sistemul memoreaza un singur eveniment in timpul perioadei anti-dither. Valoarea
variaza de la Os la 100s.

Inregistrare

Verificati-o si astfel, atunci cand apare alarma, sistemul va inregistra automat.
Trebuie sa setati perioada de nregistrare in Storage>Schedule si sa selectati
inregistrarea automata in interfata de control al inregistrarii.

Intarziere la
inregistrare

Sistemul poate intarzia inregistrarea pentru un timp specificat dupa terminarea
alarmei. Valoarea variaza de la 10s la 300s.

lesire releu

Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei
astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma

Sistemul poate ntarzia iesirea alarmei pentru un timp specificat dupa terminarea
alarmei. Valoarea variaza de la 10s la 300s.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.
PTZ ® Aici puteti seta miscarea PTZ atunci cand apare o alarma. Cum ar fi sa mergeti
la presetarea x atunci cand exista o alarma.
® Tipul de eveniment include: presetare, tur si model.
Instantaneu Trebuie sa bifati casuta aici, astfel Tncat sistemul sa poata salva fisierul instantaney

de detectare a miscarii. Trebuie sa setati perioada de snapshot in Storage>Schedule
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Pasul 3

Faceti clic pe "Salvare" pentru a finaliza configurarea detectarii audio.

6.3.3 Plan inteligent
Planul inteligent este comutatorul principal pentru analiza inteligenta, cum ar fi "Face Detection", "Heat Map", "IVS",

"People Counting” si asa mai departe, functiile inteligente corespunzatoare pot fi valabile dupa activarea planului
inteligent.
Pasul 1

Selectati "Setup > Event > Smart Plan". Sistemul va afisa interfata "Smart Plan", care este prezentata in Figura 6-
69.

@lhua
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Figura 6-69
Pasul 2

Faceti clic pe "Salvare" pentru a finaliza configurarea planului inteligent.

6.3.4 Analiza comportamentului inteligentei
Cerintele de baza ale selectiei scenei.

® Proportia totala a tintei nu trebuie sa depaseasca 10% din imagine.

® Dimensiunea obiectivului din imagine nu poate fi mai mica de 10 pixeli x 10 pixeli, dimensiunea obiectivului
abandonat nu poate fi mai mic& de 15 pixeli x 15 pixeli (imagine CIF); In&ltimea si Iatimea obiectivului nu pot
depasi 1/3 din imagine; se recomanda ca inaltimea obiectivului sé& fie de aproximativ 10% din inaltimea
imaginii.

® Diferenta de valoare a luminozitatii dintre tintd si fundal nu poate fi mai mica de 10 niveluri de gri.

® Asigurati-va ca tinta apare cel putin peste 2 secunde continuu in cdmp; distanta de miscare trebuie sa fie mai
mare decét latimea tintei in sine si asigurati-va ca nu este mai mica de 15 pixeli (imagine CIF).

® Incercati sa reduceti complexitatea analizei scenei de monitorizare, daca este posibil; nu se recomandéa
utilizarea functiilor IVS in mediul in care tintele sunt dense si schimbarea luminii este foarte frecventa.
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® incercati s& vé feriti de zone precum sticla, lumina reflectatd de sol, suprafata apei, ramuri, umbra,
perturbarea tantarilor etc. incercati sa va feriti de scena cu lumina de fundal pentru a evita lumina directa.

6.3.4.11IVS

6.3.4.1.1 Tripwire

Acesta va declansa alarma atunci cand tinta traverseaza linia de avertizare in conformitate cu directia de miscare
care a fost setata.

Este nevoie de ceva timp de la aparitia tintei pana la confirmarea tintei, deci trebuie sa lasati spatiu pe ambele parti
ale liniei de avertizare atunci cand setati linia de avertizare, va rugam sa nu setati linia de avertizare in apropierea
obstacolelor.

Scena de aplicare: poate fi aplicata scenei cu tinta rara si nu exista aproape niciun bloc intre tinte, cum ar fi
apararea perimetrului fara pilot. Pasul 1

Selectati "Setup > Event > IVS > [VS" si sistemul va afisa interfata "IVS".

Pasul 2

Faceti clic pe " " pentru a seta numele regulii si selectati tipul de regula ca "Tripwire", este prezentat in Figura
6-70.
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Figura 6-70

Pasul 3

Faceti clic pe "Draw Rule" (Desenare reguld) pentru a desena un fir de protectie in scena de monitorizare,
faceti clic pe butonul din dreapta al mouse-ului pentru a finaliza setarea firului de protectie. Pasul 4
Faceti clic pe "Draw Target" pentru a desena modelul de dimensiune al tintei filtrate in imaginea video.
Pasul 5

Pentru a seta parametrii firului de declansare, va rugam sa consultati urmatoarea fisa pentru mai multe detalii.
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Parametru Functia
Urmarirea Selectati "Urmarire obiect" pentru a activa functia, consultati "2.4 Reglarea
obiectelor

ferestrei video" pentru mai multe detalii. Nota:
Functia este acceptatd numai de unele modele.

Perioada de lucru

Nota:

Permite setarea perioadei de alarma, care poate activa evenimentul de alarma

numai Tn intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru".

2. Se stabileste perioada de lucru Tn conformitate cu urmatoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul sténg al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul saptamanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii séptamani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Directie

Este pentru a seta directia firului de declansare, puteti selecta A->B, B->A. A<->B.

Urmarire obiect

Selectati "Object Track" (Urmarire obiect) si se va activa functia de urmarire a
obiectului; atunci cand obiectul in miscare declanseaza regula si genereaza alarma,
se va selecta modul de afisare a urmaririi obiectului, cum ar fi 1P+3 sau 1P+5 in
interfata de previzualizare, scena ferestrei de urmarire va urmari obiectul in miscare
pana cand obiectul paraseste raza de vizibilitate a camerei. Pentru mai multe detalii,
consultati "2.4.8 Fisheye/Trigger Track".

Inregistrare

Verificati-l si astfel, atunci cand apare alarma, sistemul va Tnregistra automat.

Intarziere la Sistemul poate intarzia inregistrarea pentru o perioada specificata dupa terminarea
inregistrare alarmei.
lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma

Sistemul poate ntarzia iesirea alarmei pentru o perioada specificata dupa
terminarea alarmei.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.
Instantaneu Selectati "Instantaneu” si sistemul va declansa automat alarma si instantaneul atunci
cand apare alarma.
Pasul 5

Faceti clic pe "Salvare" pentru a finaliza configurarea tripwire.

6.3.4.2 Intrusiune
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Intrusul include cruce si apare.

® Cross inseamna ca va declansa alarma atunci cand tinta intrd sau iese din zona.

® Apare inseamna ca va declansa alarma atunci cand tinta apare in zona.

® in ceea ce priveste intervalul de raportare a functiei IVS in zona, sistemul va declansa o alarma daca
detecteaza acelasi eveniment in timpul intervalului; contorul de alarme va deveni zero daca nu se intampla
acelasi eveniment in interval.

Acesta trebuie sa lase spatiu pentru miscarea tintei ih zona periferica daca trebuie sa detecteze evenimentele de

intrare si iegire, ceea ce este similar cu linia de avertizare.

Scena de aplicare; poate fi aplicat la scena Tn care tinta este rara si nu exista aproape nici un obstacol intre tinte,

cum ar fi apararea perimetrului fara pilot.

Pasul 1

Selectati "Setup > Event > [VS > |VS" si sistemul va afisa interfata "IVS".

Pasul 2

Faceti clic pe " " pentru a seta numele regulii, selectati tipul de regula ca "Intrusion", care este prezentat in
Figura 6-71.

alhua

TECHNOLOBY

Camera

Network
No. Rule Name ‘Rule Type £
| 1 Rulet | Intrusian | i
» EventManage
> Video Detection
> Audio Detection
> Smart Plan
- Parameter Setup
> Face Detection Working Period
> People Counting
> HeatMap Action | Appears ¥ Cross
> Alarm Direction Enter8Exit b
> Abnormality -
storage ’ ! A Object Track
System . - - | Record
Information Record Delay | 10 Second (10~300)
TargstFilter ® MaxSize 8191 * 5191 Draw Target Relay-out
10 Second (10~300
MinSize 0 N Alarm Delay ( i
| Send Email
< Snapshot
| Default H Refresh H Save

Pasul 3
Faceti clic pe "Desenare reguld" pentru a desena o zona in imaginea
de monitorizare. Pasul 4

Faceti clic pe "Draw Target" pentru a desena modelul de dimensiune al tintei filtrate in imaginea video.
Pasul 5

Acesta este de a seta parametrii de intruziune, va rugdm sa consultati urmatoarea foaie pentru mai multe detalii.
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Parametru Functia
Urmarirea Selectati "Urmarire obiect" pentru a activa functia, consultati "2.4 Reglarea
obiectelor

ferestrei video" pentru mai multe detalii. Nota:
Functia este acceptatd numai de unele modele.

Perioada de lucru

Nota:

Permite setarea perioadei de alarma, poate activa evenimentul de alarma numai in

intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru".

2. Se stabileste perioada de lucru Tn conformitate cu urmatoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul sténg al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul saptamanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii séptamani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Actiune

Acesta este de a seta actiunea de intruziune, puteti selecta apare si cruce.

Directie

Acesta este de a seta directia de intruziune, puteti selecta intra, iesi si intra & iesi.

Urmarire obiect

Selectati "Object Track" (Urmarire obiect) si se va activa functia de urmarire a
obiectului; atunci cand obiectul in miscare declanseaza regula si genereaza alarma,
se va selecta modul de afisare a urmaririi obiectului, cum ar fi 1P+3 sau 1P+5 in
interfata de previzualizare, scena ferestrei de urmarire va urmari obiectul in miscare
pana cand obiectul paraseste raza de vizibilitate a camerei. Pentru mai multe detalii,
consultati "2.4.8 Fisheye/Trigger Track".

Inregistrare

Verificati-| si astfel, atunci cand apare alarma, sistemul va Tnregistra automat.

Intarziere la Sistemul poate intarzia inregistrarea pentru o perioada specificatéd dupa terminarea
inregistrare alarmei.
lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma

Sistemul poate intarzia iesirea alarmei pentru o perioada specificata dupa
terminarea alarmei.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Parametru Functia

Instantaneu Selectati "Instantaneu” si sistemul va declansa automat alarma si instantaneul atunci

cand apare alarma.
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Pasul 5
Faceti clic pe "Salvare" pentru a finaliza configurarea intruziunii.

6.3.4.3 Obiect abandonat

Obiectul abandonat inseamna ca sistemul va declansa o alarma daca obiectul abandonat in scena de monitorizare
depéaseste timpul care a fost setat de utilizatori.

Obiectul abandonat si obiectul lipsa pot fi confuze intr-o situatie Tn care atat prim-planul, cat si fundalul sunt
complicate.

De asemenea, declanseazé alarma ca obiect abandonat in cazul in care un pieton sau un vehicul raméane
nemiscat prea mult timp. Pentru a filtra acest tip de alarma, in general obiectul abandonat este mai mic decét
persoanele si vehiculul; prin urmare, poate filtra persoanele si vehiculul prin setarea dimensiunii. in plus, se poate
evita alarma falsa cauzata de stationarea scurta a persoanelor prin prelungirea corespunzéatoare a timpului de
alarma.

Scena de aplicare: Acesta poate fi aplicat la scena Tn care tinta este rara si nu exista o schimbare evidenta si
frecventa a luminii. Alarma falsa va creste in scena cu densitate mare a tintei si blocarea frecventa; alarma falsa va
creste In scena in care se afla mai multe persoane. In ceea ce priveste zona de detectare, incercati sa o faceti
simpld, functia nu este potrivitd pentru zona care este prea complicata.

Pasul 1

Selectati "Setup > Event > IVS > |VS" si sistemul va afisa interfata "IVS".
Pasul 2

Faceti clic pe " " pentru a seta numele regulii, selectati tipul de regula ca "Abandoned Object" (Obiect
abandonat) care este prezentat in Figura 6-72.

hua

~ TECHNOLOGY

Camera

Network ] -
5351 1341.50 L4 No.  Rule Name Rule Type
@ 1 Rulet Abandoned Ob[~| @ *
> Video Detection -
> Audio Detection 1
1« gh e 7 - Parameter Setup
ik ennle Coupting = | .2 Working Period
> Alarm — Keep Time 10 Secand (6~3500)
> Abnormality ——
storage i "] Record
System = = Record Delay | 10 Second (10~300)
Information [ Relay-out
TargetFilter @ MaxSize 5191 * ["] Send Email
Ounses 0 4o w—
‘ Default H Refresh H Save

Pasul 3
Faceti clic pe "Draw Rule" pentru a desena o zona in zona de
monitorizare. Pasul 4
www.ultramaster.ro 102



@hua Manual de utilizare Dahua Network Camera Web 3.0

Faceti clic pe "Draw Target" pentru a desena modelul de dimensiune al tintei filtrate in imaginea video.
Pasul 5

Acesta este pentru a seta parametrul obiectului abandonat, va rugdm sa consultati urmatoarea fisa pentru mai
multe detalii.

Parametru Functia

Perioada de lucru | Nota:

Acesta este pentru a seta perioada de alarma, poate activa evenimentul de alarma

numai in timpul intervalului de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru”.

2. Se stabileste perioada de lucru Tn conformitate cu urmatoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul sténg al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul sdptamanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii saptamani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Pastrati timpul Acesta trebuie sa stabileasca cel mai scurt timp de la abandonarea obiectului pana
la declansarea alarmei.

Inregistrare Verificati-| si astfel, atunci cand apare alarma, sistemul va Tnregistra automat.

ntarziere la Sistemul poate intarzia inregistrarea pentru o perioada specificata dupa terminarea

inregistrare alarmei.

lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarmé Sistemul poate intarzia iesirea alarmei pentru o perioada specificata dupa
terminarea alarmei.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termind alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Instantaneu Selectati "Instantaneu” si sistemul va declansa automat alarma si instantaneul atunci

cand apare alarma.

Pasul 5
Faceti clic pe "Salvare" pentru a finaliza configurarea obiectului abandonat.

6.3.4.4 Obiectul lipsa
Obiectul disparut inseamna ca sistemul va declansa o alarma daca depaseste o anumita perioada de timp dupa ce
tinta este indepartaté de la locul initial.
Sistemul poate face statistici ale zonelor imobile din zona de prim-plan si poate distinge daca este vorba de un
obiect lipsa sau de un obiect abandonat in functie de asemanarea dintre prim-plan si fundal, va declansa o alarma
atunci cand depéaseste timpul stabilit de utilizatori.
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Deoarece sistemul distinge obiectul abandonat de obiectul disparut in functie de similitudinea prim-planului si a
fundalului, acesta poate cauza erori intre obiectul abandonat si obiectul disparut intr-o situatie h care atat prim-
planul, céat si fundalul sunt complicate.

Scena de aplicare: poate fi aplicat la scena n care tinta este rara si nu exista o schimbare evidenta si frecventa a
luminii. Alarma falsa va creste in scena n care densitatea tintei este mare si existd obstructii frecvente; alarma
falsa va creste In scena in care se afla mai multe persoane. In ceea ce priveste zona de detectare, incercati sa o
faceti simpla, functia nu este potrivitéd pentru zona care este prea complicata. Pasul 1

Selectati "Setup > Event > [VS > |VS" si sistemul va afisa interfata "IVS".
Pasul 2

Faceti clic pe " " pentru a seta numele regulii si selectati tipul regulii ca "Missing Object", care este prezentat in
Figura 6-73.

@lhua

Camera
Network

E No Rule Name Rule Type
M 1 Ruet Ml_samgOb_je_ctE] i

1134150

> Video Detection

io Detection

~ Parameter Setup

> People Counting 1 Working Period

> HeatMap
> Al == Keep Time 10 Second (6~3600)
> Abnarmality - —
Storage ] Record
System e o o RecordDelay | 10 | Second (10~300)
Information [ Relay-out
MamBely |10 Secon (10-300)
TargetFiller @ MaxSize G131 = & Draw Target [] Send Email
_ 7] Snapshat
(Z) Min Size o Clear (2 snapshol
‘ Default | | Refresh | | Save

Pasul 3

Faceti clic pe "Draw Rule" pentru a desena o zona in scena de

monitorizare. Pasul 4

Faceti clic pe "Draw Target" pentru a desena modelul de dimensiune al tintei filtrate in imaginea video.
Pasul 5

Acesta este pentru a seta parametrii obiectului lipsa, va rugdm sa consultati urmatoarea foaie pentru mai multe
detalii.

Parametru Functia
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Perioada de lucru | Nota:

Permite setarea perioadei de alarma, poate activa evenimentul de alarma numai in

intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru".

2. Se stabileste perioada de lucru in conformitate cu urmétoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul sténg al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul sdptamanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii saptamani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Pastrati timpul Acesta trebuie sa stabileasca cel mai scurt timp de la disparitia obiectului pana la
declansarea alarmei.

Inregistrare Verificati-| si astfel, atunci cand apare alarma, sistemul va Tnregistra automat.

ntarziere la Sistemul poate intarzia inregistrarea pentru o perioada specificata dupa terminarea

inregistrare alarmei.

lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarmé Sistemul poate intarzia iesirea alarmei pentru o perioada specificata dupa
terminarea alarmei.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Instantaneu Selectati "Instantaneu” si sistemul va declansa automat alarma si instantaneul atunci

cand apare alarma.

Pasul 5

Faceti clic pe "Salvare" pentru a finaliza configurarea obiectului lipsa.

6.3.5 Detectarea fetei
Pasul 1

Selectati "Setup > Event > Face Detection" si sistemul va afisa interfata "Face Detection", care este prezentata in

Figura 6-74.
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Network ] Enable
> Video Detection ‘Working Period
> Audio Detection
[] Enable Face Enhancement
[] Record
Record Delay 10 Second (10~300)
] Relay-out
> HeatMa
alisp Alarm Delay 10 Second (10~300)
> Alarm _
[] Send Email
> Abnormality
[¥] Snapshot
Storage
System
. ) ‘ Default | | Refresh ‘ | Save
Information
Target Filter @ Max Size 1 ® Draw Target

Pasul 2

Selectati "Activare" pentru a activa functia de detectare a

fetei. Pasul 3

Faceti clic pe "Draw Target" pentru a desena modelul de dimensiune al filtrului tintd Tn imaginea video.

Pasul 4

Seteaza parametrii de detectare a fetei, consultati urmatoarea fisa pentru mai multe detalii.
Parametru Functia
Perioada de lucru | Nota:

Permite setarea perioadei de alarma, care poate activa evenimentul de alarma

numai Tn intervalul de timp care a fost setat.

1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru".

2. Se stabileste perioada de lucru Th conformitate cu urmatoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apasa butonul stang al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul sdptadmanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii saptamani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Activarea
Tmbunatatirii fetei

Selectati "Enable Face Enhancement” si va garanta ca fata este clara cu prioritate
atunci cand fluxul este setat foarte jos.

Inregistrare

Verificati-| si astfel, atunci cand apare alarma, sistemul va inregistra automat.

Intarziere la
inregistrare

Sistemul poate intarzia inregistrarea pentru o perioada specificata dupa terminarea
alarmei.
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Parametru

Functia

lesire releu

Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei
astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma

Sistemul poate ntarzia iesirea alarmei pentru o perioada specificatd dupa
terminarea alarmei.

Trimite e-mail

Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Instantaneu

Selectati "Instantaneu” si sistemul va declansa automat alarma si instantaneul atunci
cand apare alarma.

Pasul 5

Faceti clic pe "Salvare" pentru a finaliza configurarea detectarii fetei.

6.3.6 Numararea persoanelor
6.3.6.1 Numararea persoanelor

Etapa 1

Selectati "Setup > Event > People Counting > People Counting" si sistemul va afisa interfata "Entrance/Exit", care
este prezentata in Figura 6-75.

TECHNOLOGY

Camera
Network =

Video Detection
> Audio Detection

> 8mart Plan

> Alarm
> Abnormality
Storage

system

Information

Pasul 2

f.j- "= =T [¥| Enable
[¥] Enable OSD
tat . =
— Working Period
Lens Direction | Inclined |z|
} Rule Name | NumberStat
d L k. Direction A=B |z|
Z = L 1 T | Flowrate Alarm -
' Enter Mumber 0
I. Leave Number 0
I‘ Stranded Mumber |0
[ —
. Record Delay 10 Second (10~300)
Target Filter @ Max Size i 5167 ] Relay-out
©) Win Size (960-2560) Alarm Delay 10 Second (10~300)
[] Send Email
[¥] Snapshot
Default | | Refresh | | Save
Figura 6-75

Selectati "Activare" pentru a activa functia statistica de intrare si iesire.
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Pasul 3

Faceti clic pe "Desenare regula” pentru a desena o zona in imaginea

de monitorizare. Pasul 4

Faceti clic pe "Draw Target" pentru a desena modelul de dimensiune al tintei filtrate in imaginea video.
Pasul 5

Pentru a seta parametrii de intrare si iesire, va rugdm sa consultati urmatoarea fisé pentru mai multe detalii.

Parametru

Functia

Activeaza OSD

Selectati "Activare OSD" si se vor afisa statisticile privind numarul de persoane care
intra si ies in imaginea de monitorizare.

Perioada de lucru

Nota:

Permite setarea perioadei de alarma, poate activa evenimentul de alarma numai in

intervalul de timp care a fost setat.
1. Faceti clic pe "Configurare" si sistemul va afisa interfata "Perioada de lucru”.
2. Se stabileste perioada de lucru Tn conformitate cu urmatoarele metode:

®  Puteti introduce valoarea numerica a timpului sau puteti apdsa butonul stang al
mouse-ului pentru a trage pe interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de
selectare din fata perioadei, iar apoi perioada este valabila.

®  Selectati numarul sdptamanii (in mod implicit este selectatd duminica, daca
este selectata intreaga saptamana, inseamna ca setarea poate fi aplicata
intregii saptamani; de asemenea, puteti selecta caseta de selectare din fata
numarului saptamanii pentru a implementa o setare independenta pentru
anumite zile).
3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Instalare
Modul

Trebuie sa selectati montarea pe perete daca existd un unghi intre obiectivul
dispozitivului si suprafata orizontala, selectati plafonul daca obiectivul dispozitivului
este orientat vertical in jos.

Denumirea regulii

Este pentru a stabili numele regulii.

Directie Se selecteaza directia statisticilor de intrare si iesire; A->B sau B->A, directia sagetii
inseamna intotdeauna directia de intrare.
Alarma debit Acesta este de a seta numarul de intrare, numarul de iesire, numarul blocat; acesta

va declansa alarma atunci cand depaseste numarul limitat.

Inregistrare

Verificati-| si astfel, atunci cand apare alarma, sistemul va Tnregistra automat.

Intarziere la Sistemul poate intarzia inregistrarea pentru o perioada specificata dupa terminarea
inregistrare alarmei.
lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire al alarmei

astfel incat sistemul sa poata activa dispozitivul de alarma corespunzator atunci
cand apare alarma.

Intarziere alarma

Sistemul poate intarzia iesirea alarmei pentru o perioada specificata dupa
terminarea alarmei.

Trimite e-mail Daca activati aceasta functie, sistemul poate trimite un e-mail pentru a va avertiza
cand apare si se termina alarma. Utilizatorul poate seta adresa de e-mail in
Retea>SMTP.

Instantaneu Selectati "Instantaneu” si sistemul va declansa automat alarma si instantaneul atunci

cand apare alarma.
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Pasul 6
Faceti clic pe "Salvare" pentru a finaliza configurarea numararii persoanelor.

6.3.6.2 Raport
Scopul este de a genera o forma de raport in functie de statisticile privind
numarul. Pasul 1

Selectati "Setup > Event > People Counting > Report" si sistemul va afisa interfata "Report", care este prezentata
in Figura 6-76.

E) 1 IE]

TECHROLOGY

Camera People Counting

Network
Report Type | Day |z|

> eo Detection Start Time | 2016-05-23 00 End Time |2016-05-23 EH| 16 : ¢ =Daily Report Max Range Is 24 Hours

> Audio Detection
Flow Direction [/] Enters [V] Exits [J] DisplayNumber  ReportiType @ BarChart () LineChar

» Smari Plan

> Alarm
> Abnormality

Storage

System

Information
Figura 6-76

Pasul 2
Este pentru a seta conditia de cautare, va rugam sa consultati urmatoarea foaie pentru mai multe detalii.

Parametru Nota

Puteti selecta raportul zilei, raportul lunii si raportul anului; de asemenea, puteti selecta
Tip raport graficul cu bare sau graficul liniar pentru a afisa raportul.

Timp Acesta poate seta ora de inceput / sfarsit in intervalul de timp statistic.

Acesta poate selecta numarul de intrare, iesire si afisare; datele elementului verificat pot fi
Directia debitului | afisate in raport.

Cautare Cautati datele statistice privind fluxul in functie de setare pentru a forma raportul.
Export Exportati raportul salvat.
Pasul 3

Faceti clic pe "Cautare" pentru a completa statisticile raportului, faceti clic pe "Export" pentru a exporta raportul.

6.3.7 Harta termica

6.3.7.1 Harta termica
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Este statistica densitatii obiectului in miscare care poate genera un raport, gama de culori este de la albastru la

rosu, albastru Tnseamna valoarea termica minima si rosu inseamna valoarea termica maxima.
Oglindirea, schimbarea unghiului de vizualizare si datele originale ale hartii termice vor fi sterse.
Pasul 1

Selectati "Setup > Event > Heat Map > Heat Map" si sistemul va afisa interfata "Heat Map", care este prezentata in

Figura 6-77.

Camera

Network 4] Enabls

Warking Period

> Abnormality

Storage

System

Information

Default H Refresh ” Save

@

Figura 6-77
Pasul 2
Selectati "Activare" pentru a activa functia de harta termica.
Pasul 3

Aceasta este pentru a stabili perioada de lucru.

1. Faceti clic pe "Setup" (Configurare) si sistemul va afisa interfata "Working Period" (Perioada de lucru), care

este prezentata in figura 6-78.
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Working Period
0 >, 4 ] 8 0 12 14 16 18 20 22 24
.

Monday

SEltL”da‘dllIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII

Tuesday

‘Wednesday

Thursday

Friday

[ Clan ¥ Sunday I~ Monday I Tuesday I Wednesday [~ Thursday I Friday I Saturday
W Periodt: | 00 : 00 : 00 |-| 23 : 59 - 59 |
[ Period2 | 00 : 00 : 00 |-| 23 : 59 : &9 |
[ Peripd3: | 00 : 00 : 00 |-| 23 : 59 : 69 |
I Period4: | 00 : 00 : 00 |-| 23 : 69 : &9 |
[ Periods: | 00 : 00 : 00 |-| 23 : 59 - 59 |
I Periods: | 00 : 00 : 00 |-| 23 : 69 : &9 |
| Save || Cancel |
Figura 6-78

N

Se stabileste perioada de lucru in conformitate cu urmatoarele metode:

Puteti introduce valoarea numerica a timpului sau puteti apasa butonul stang al mouse-ului pentru a trage pe

interfata de configurare pentru a seta.

® Existd sase perioade care pot fi setate in fiecare zi, selectati caseta de selectare din fata perioadei, iar apoi
perioada este valabila.

®  Selectati numarul saptamanii (in mod implicit este selectatd duminica, daca este selectata intreaga

saptamana, inseamna ca setarea poate fi aplicatad intregii séptdmani; de asemenea, puteti selecta caseta de

selectare din fata numarului saptamanii pentru a implementa o setare independenta pentru anumite zile).

3. Faceti clic pe "Salvare" pentru a finaliza configurarea perioadei de lucru.

Pasul 4

Faceti clic pe "Salvare" pentru a finaliza configurarea hartii termice.

6.3.7.2 Raport
Acesta are rolul de a genera o forma de raport in functie de datele hartii
termice. Pasul 1

Selectati "Setup > Event > Heat Map > Report" si sistemul va afisa interfata "Report", care este prezentata in
Figura 6-79.
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Camera

Network

StartTime | 2016-05-23

> Audio Detection

End Time | 2016-05-23 *Report Max Range Is 1 Week

» Abnormality

Storage

System

Information

Figura 6-79

Pasul 2
Aceasta este pentru a seta ora de incepere
si ora de terminare. Pasul 3

Faceti clic pe "Cautare" pentru a finaliza raportul statistic, faceti clic pe "Export" pentru a exporta raportul statistic.

6.3.8 Alarma
Va rugam sa retineti ca unele produse de serie nu accepta aceasta functie.

5.3.2.1 Alarma PIR

Interfata de activare a alarmei PIR este prezentata in Figura 6-80.

www.ultramaster.ro

112



@hua
@Jhua

Camera
Network
Event

> Video Detect

> Audio Detect

> VS Analyse

> Face Detect

> People Counting

> Heat Map

> Abnormality

Storage
System

Information

PIR Alarm
I” Enable

Working Period
Anti-Dither

W Flasn
Flash Delay
¥ Recard
Record Delay
¥ Relay-out
Alarm Delay
I~ send Email
™ Audio Linkage

" Snapshot
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Relay Activation Flash Set Audio Detect

1] Second (0~100)

_10_ | Second {10~300)

10 Second (10~300})

10 Second (10~300})

Default ‘ | Refresh | | Save

Figura 6-80

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru

Functia

Activare

Dupa activare, activarea releului va functiona. Verificati-o si activati
alarma PIR.

Perioada de
lucru

® Aceasta functie devine activa in perioadele specificate.

® Existd sase perioade intr-o zi. Va rugam s& desenati un cerc pentru
a activa perioada corespunzatoare.

® Selectati data. Daca nu selectati, configuratia curenta se aplica
numai zilei de astazi. Puteti selecta coloana toata saptdmana pentru
a se aplica intregii saptamani.

® Faceti clic pe butonul OK, sistemul revine la interfata de detectare a
miscarii; va rugam sa faceti clic pe butonul de salvare pentru a iesi.

Nota: Utilizatorul poate seta prin glisarea mouse-ului in timp ce nu

elibereaza stdnga mouse-ului.

Anti-dither

Sistemul memoreaza un singur eveniment in timpul perioadei anti-dither.
Valoarea variaza de la Os la 100s.

Flash

Dupa activare, sistemul va porni automat blitul atunci cand apare alarma.

Intarziere flash

e Blitul se va stinge cu o perioada de timp de intarziere atunci cand
legatura de alarma este terminata.

e Timpul este calculat cu unitatea de secunda si variaza intre
10s~300s.

nregistrare

Sistemul activeaza automat canalul de detectare a miscarii pentru a
inregistra odata ce apare alarma (functioneaza cu functia de detectare a
miscarii).

Intarziere la
inregistrare

Sistemul poate intarzia inregistrarea pentru un timp specificat dupa
terminarea alarmei. Valoarea variaza de la 10s la 300s.
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Parametru Functia

lesire releu Activati functia de activare a alarmei. Trebuie sa selectati portul de iesire
al alarmei astfel incat sistemul sa poata activa dispozitivul de alarma
corespunzator atunci cand apare alarma.

intarziere Sistemul poate ntarzia iesirea alarmei pentru un timp specificat dupa

alarma terminarea alarmei. Valoarea variaza de la 10s la 300s.

Trimite e-mail Dupa ce aceasta functie este activata, sistemul poate trimite un e-mail

pentru a va avertiza cand apare si se termina alarma.

Legatura audio

Bifati-l si sistemul va reda fisierul audio de alarma atunci cand apare
alarma. Utilizatorii pot seta fisierul audio Tnregistrat in "Camera Setting >
Audio > Alarm Audio".

Instantaneu

Dupa ce ati activat instantaneul, sistemul va realiza automat instantaneul
daca apare o alarma.

6.3.8.1 Legatura alarmelor

Camera
Network

PIR Alarm

Relay Activation Flash Set Audio Detect

I” Enable
Ve Relay-in Alarm1 hd
> Video Detect
> Audio Detect Working Period
> IVS Analyse Anti-Dither 0 Second (0~100) Sensor Type |NO hd
» Face Detect I Flash
3 Eeopla Coing Flash Delay 10 Second (10~300)
ALY ¥ Record
ol Record Delay 10 Second (10~300)
2 peacarahly ¥ Relay-out
SRR Alarm Delay 10 Second (10~300)
System ™ Send Email
Information
™ Audio Linkage
I Snapshot
Default | ‘ Refresh | ‘ Save
Figura 6-81
Parametru Functia
Activare Verificati-o si activati legatura de alarma.
Relay-in Alarma implicita 1, unele produse pot alege alarma 2.
Doua tipuri de senzori, care sunt normal deschis (NO) si normal inchis (NC), comutati de la
Tip senzor normal deschis la normal inchis, deschideti alarma. Comutarea de la normal inchis la normal
deschis, inchide alarma.
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Parametru Functia

Verificati-o si setati miscarea PTZ atunci cand apare alarma. Cum ar fi s& mergeti la
PT7 presetarea x atunci cand exista o alarma.

Tipul de eveniment include: presetare, tur si model si asa mai departe.

6.3.8.2 Set flash

@’hua

Camera
Network

PIR Alarm Relay Activation Flash Set Audio Detect

m Weak =] D Strong

3 Video Delect | | [V sunday M Monday W Tuesday B wednesday ¥ Thursday M Friday [ Saturday
> Audio Detect I Period 1 00 : 00 : 00 |-| 23 : 59 ; &9

Default Refrash

» VS Analyse ‘

» Face Detect

> People Counting
» HeatMap

» Abnormality
Storage
System

Information

Figura 6-82
Parametru Functia
ON/OFF ON Tnseamna ca blitul este pornit; OFF inseamna ca blitul este oprit.
Bara slaba- Trageti aceasta bara pentru a regla luminozitatea blitului.
puternica
Toate Verificati si inseamna ca blitul de zi functioneaza.
Perioada Perioada in care blitul este pornit.

6.3.8.3 Detectarea audio

Nota: Detectarea audio nu va functiona atunci cand "Talk" este activat pe interfata de previzualizare.

www.ultramaster.ro 115



Cayhua Manual de utilizare Dahua Network Camera Web 3.0

-
alhua [ ive | mwpsck | sewp | msm | togew |

PIR Alarm Relay Activation Flash Set Audio Detect
Camera

Network I” Enabls
E Threshold
> Video Detect
Waorking Period
> Audio Detect
> VS Analyse I Flash
> Face Detect Flash Delay Second (10~300)
> People Counting V¥ Record
> Heat Map Record Delay Second (10~300)
7 Relay-out
» Abnormality Alarm Delay Second (10~300)
Storage ™ Send Email
System I™ Audio Linkage

Information ™ snapshot

Default | | Refresh

Figura 6-83

parametru Functia

Activare Verificati-l si activati detectarea audio.

Acesta va declansa alarma si va stabili o serie de legaturi atunci cand volumul depaseste
Prag pragul stabilit.

6.3.9 Anomalie
Anomaliile includ Nu exista card SD, Avertizare capacitate, Eroare card SD, Deconectare, Conflict IP si Acces

neautorizat.

Nota:

Numai dispozitivul cu functie de card SD are aceste trei stari: Niciun card SD, avertizare capacitate si eroare card
SD. Dispozitivul fara functie de card SD nu are cele trei stari de mai sus. A se vedea de la figura 6-84 la figura 6-

86.
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@lhua

Camera SD Card Network llegal Access

Network

Event Type No 5D Card [~]
> Video Detection [T Enable

Audio Detection [¥] Relay-out
Alarm Delay |10 Second (10~3200)
[7] Send Email
> Face Detection
Default H Refresh H Save

> People Counting
> HeatMap

Storage
System
Information

Figura 6-84

alhua

TECHNOLOGY

Network

Camera SD Card
Network

Event Type | SD Card Error E

> Video Detection [T] Enable
Audio Detection [¥] Relay-out
Alarm Delay 10 Second (10~300)

[C] Send Email

Default | | Refresh | | Save
People Counting

Heat Map

Alarm

Storage

System

Information

Figura 6-85
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@Jhua rr— e G T——

Camera SD Card
Network

Event Type Capacity Waming
> Video Detection [[] Enable
> Audio Detection Capacity Limit 10 %5(0~99)
> Smart Plan [¥] Relay-out
>V Alarm Delay 10 Second (10~300)
> Face Detection [C] Send Email
> People Counting

Default | | Refresh | | Save

> HeatMap

Storage

System

Information

Figura 6-86

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru | Functia

Activare Verificati alarma atunci cand cardul SD este anormal.

Relay-out Verificati pentru a activa alarma de iesire a releului.

Intarziere lesirea de alarma poate intarzia pentru timpul specificat dupa oprirea alarmei.
iesire releu | Valoarea variaza de la 10s la 300s.
Nota:

Nicio carteld SD, avertizare capacitate, eroare carteld SD, intarziere iesire releu
toate pornesc de la aparitia alarmei.

Trimiteti Dupa ce ati activat aceasta functie, sistemul poate trimite un e-mail pentru a
e-mail alarma utilizatorul specificat.
Aceasta functie nu este valabila atunci cand reteaua este offline sau apare un
conflict IP.
Card SD Utilizatorul poate seta capacitatea cardului SD care raméane libera. Atunci cand
Capacitate | spatiul ramas pe cardul SD este mai mic decét aceasta limita, se declanseaza o
Limite alarma.

Atunci cand dispozitivul este offline sau exista conflicte IP, alarma anormala este similara cu cazul erorii cardului
SD.
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@lhua

Camera SD Card Network llegal Access

Network
Event Type Disconnection E

> Video Detection [¥] Enable
> Audio Detection [C] Record

Plan Record Delay 10 Second (10~300)
> [ Relay-out
> Face Detection Alarm Delay 10 Second (10~300})
> People Counting

Default ‘ | Refresh ‘ | Save

> HeatMap
> Alarm

Storage
System

Information

Figura 6-87

Cand parola de conectare a fost gresitd de cateva ori, apare alarma de acces neautorizat. Aceasta operatiune este
similara cu eroarea cardului SD. Permiteti erori de autentificare de mai multe ori, deoarece atunci cand se
depaseste aceasta limita, contul de utilizator va fi blocat.

hua

- TECHNOLOGY

Camera SD Card
Network

lllegal Access

[¥] Enable
Videa Detection Login Error 3 time (3~10)
> Audio Detection [¥] Relay-out
Alarm Delay 10 Second (10~300)
[7] Send Email

> Face Detection

Default || Refresh H Save
> People Counting

> HeatMap

> Alarm

Storage

System

Information

Figura 6-88

6.4 Gestionarea stocarii

6.4.1 Program
Inainte de configurarea programului, utilizatorul trebuie si seteze modul de inregistrare automat sau manual.

Nota:

Daca modul de inregistrare in controlul inregistrarii este dezactivat, atunci dispozitivul nu va realiza
instantanee in conformitate cu programul. 6.4.1.1 Programul de inregistrare Etapele programului de
inregistrare:

Pasul 1. Faceti clic pe Record Schedule (Programare inregistrare), consultati Figura 6-89.
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Record Schedule

[¥/] General @ [¥] Motion

[¥] Alarm B
o 2 4 6 8 10 12 14 16 18 20 22 24
Sunday . = — —

. Sichedule,

n Monday [
» Destination

> Record Control Tuesday
System Wednesiay P
Information Thursday .

Friday |
Saturday

Holiday EESERpIi

Figura 6-89

Pasul 2. De luni pana duminica selectati ora de inregistrare, faceti clic pe configurare in dreapta, a se vedea Figura
6-90.

®  Setati perioada Tn functie de nevoile reale. Exista sase perioade disponibile in fiecare zi.

®  Prin bifare sau debifare, puteti adauga sau sterge trei tipuri de program de inregistrare: General, Miscare si
Alarma.

Nota:

Configurarea perioadei se poate face prin glisarea in interfata programului de inregistrare fara a elibera stanga
mouse-ului.

Setup kd
Y I¥ sunday I Monday [ Tuesday I~ Wednesday [ Thursday [ Friday [ Saturday [ Holiday
Periad 1: 00 : 00 : 00 |-| 23 : 59 : 59 | [ ceneral ¥ Motion M Alarm
Period 2: 00 : 00 : 00 |-| 23 : 59 : 59 | [ General [T Motion [T Alarm
Period 3: 00 : 00 : 00 |-| 23 : 59 : 59 | [ General [~ Motion [T Alarm
Period 4; 00 : 00 : 00 |-| 23 : 69 : 59 | [ ceneral [T Motion [T Alarm
Period 5: 00 : 00 : 00 |-| 23 : 59 : 59 | [ General [~ Motion [ Alarm
Period 6 00 : 00 : 00 |-| 23 : 69 : 59 | [ ceneral [T Motion [T Alarm
Save | | Cancel
Figura 6-90

Pasul 3. Faceti clic pe OK, reveniti la interfata de inregistrare a programului. A se vedea Figura 6-91.
® Culoarea verde reprezinta inregistrarea/snapshot-ul general.

® Culoarea galbena reprezinta inregistrarea/snapshotul detectarii miscarii.
® Culoarea rosie reprezinta inregistrarea/snapshot-ul alarmei.

www.ultramaster.ro 120



Cayhua Manual de utilizare Dahua Network Camera Web 3.0

TECHNOLOGY

Record Schedule

General | Motion [¥] Alarm B

i} 2 4 6 8 10 12 14 16 18 20 2 24
S [ I T i S ) D S E T Setup
> Destination o | 2o
> Record Conirol Tesdan || Seiup
System Wednesday [ Setup
Information Thursday |- Setup
Friday | Setup
Saturday [ LT m—
Holiday Sefup

Figura 6-91

Pasul 4. In interfata programului de inregistrare, faceti clic pe OK. Sistemul solicita salvarea cu succes.

6.4.1.2 Programare instantanee
Configurare instantanee ca:

Pasul 1. Faceti clic pe fila Snapshot Schedule, consultati Figura 6-92.

@Jhua

Camera Record Schedule

Snapshot Schedule Holiday Schedule
Network General | Motion Alarm H
Event

0 oL 4 6 8 10 12 14 16 18 20 22 24

S EfTJT,]IJ,—D 0T A A TS T ,—UT,]II,—[%

3 o Monday | Selup

> Destiration [ oL -

S oy B [ —
System Wednesﬂay ; ) 5 N G S s : Seum
Information BT s —

Friday [l 0 O 3 B RS R B Y R e |
L1 18] 1 O 0T 2 5 125 2 A 2 1 5 VA 0 2 1 T |
1 Setup

o161 =t S 5 T S 5 S 6 6 e |

Figura 6-92

Pasul 2. De luni pana duminica selectati ora instantanee, faceti clic pe configurare in dreapta. A se vedea figura 6-
93.

®  Setali perioada de instantanee in functie de nevoile reale. Exista sase perioade disponibile in fiecare zi.

® Prin bifarea sau debifarea, utilizatorul poate adauga sau sterge trei tipuri de program de instantanee: General,

miscare si alarma.
www.ultramaster.ro 121



Cayhua Manual de utilizare Dahua Network Camera Web 3.0

TECHNOLOGY

Nota: Configurarea perioadei se poate face prin glisarea in interfata planificarii instantanee fara a elibera stanga
mouse-ului.

Setup k3
A ¥ sunday I~ Mmonday I Tuesday I Wednesday I Thursday [ Friday [ Saturday [ Holiday
Period 1: 00 : 00 : 00 |(-| 23 : 59 : 59 | [ General [ motion I Alarm
Period 2: 00 - 00 - 00 |-| 23 - 59 : 59 | [~ General I Motion I Alarm
Period 3: 00 : 00 : 00 |-| 23 : 59 : 89 | [C General [ Motion I Alarm
Period 4: [][J .00 [][J -| 23 : 59 : 59 | [ General " Motion I~ Alarm
Period 5: 00 : 00 : 00 |-| 23 . 59 : 59 | [C Genmeral [ Motion I Alarm
Period 6: 00 : 00 : 00 |- 23 ¢ 59 ™ General ™ Wotion TI™ Alarm
Save ‘ ‘ Cancel
Figura 6-93

Pasul 3. Faceti clic pe OK, reveniti la interfata de planificare a instantaneelor. A se vedea Figura 6-94.
® Culoarea verde reprezinta inregistrarea/snapshot-ul general.

® Culoarea galbena reprezinta inregistrarea/snapshotul detectarii miscarii.
® Culoarea rosie reprezinta inregistrarea/snapshot-ul alarmei.

@Jhua

Camera Record Schedule

Network

General @ [¥] Motion [¥] Alarm B

Event
1} 2 4 6 8 10 12 14 16 18 20 22 24

B i i 1020 2 0 10 0 00 0 ) [TTTTL]
Sunday

- Monday
» Destination e
> Record Control A :
System Wednesday :-—5
Information LT RN
Friday !
Saturday ; L
Holiday 10

Figura 6-94

Pasul 5. In interfata instantanee, faceti clic pe OK. Sistemul solicita salvarea cu succes.

6.4.1.3 Programul de vacanta
Programul de sarbatori poate seta o anumita data ca sarbatoare.
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Pasul 1. Faceti clic pe fila Program de vacanta, consultati Figura 6-95.

Camera Record Schedule Snapshot Schedule Holiday Schedule

Network

[[] Record [T] Snapshot

Calendar

Event

T 1 [ 1 T
> Destination |1 (]2 (13]|]|4| |5

Sun Mon Tue Wed Thu Fri Sat
> Record Control i7;:g}igi;1ﬂfi11;;12

S (14 {15] 18] |17 [12] | 10

Information

Figura 6-95

Pasul 2. Selectati data pe care doriti sa o stabiliti ca sarbatoare. Data selectata va fi evidentiata in galben.

Pasul 3. Verificati inregistrare/Snapshot, faceti clic pe Salvare. Sistemul solicitd salvarea cu succes.

Pasul 4. Verificati interfata Record Schedule/Snapshot Schedule, faceti clic pe configurare langa Holiday si faceti
referire la configurarea de luni pana duminica.

Pasul 5. Finalizati configurarea vacantei, apoi inregistrati/snapshots in functie de data din programul de vacanta.

6.4.2 Destinatie
6.4.2.1 Cale

Interfata de destinatie este prezentata ca in Figura 6-96.

Calea poate configura calea de stocare a inregistrérilor si a instantaneelor. Exista trei optiuni: Local, FTP si NAS.
Puteti selecta un singur mod. Sistemul poate salva in functie de tipurile de evenimente. Aceasta corespunde celor
trei moduri (general/miscare/alarma) din interfata Programare. Va rugam sa bifati caseta pentru a activa functiile de
salvare.

Nota: Numai dispozitivul care accepta cardul SD are caracter local.

@lhua

Camera Path

LI Record Snapshot
Event o
Event Type Scheduled Motion Detect Alarm Event Type Scheduled Motion Detect Alarm
Local v ¥ Local v ¥ V]
FTP ] ] ] FTP ] ] L]
» NAS [l O [l NAS &l [l [l
>
Detautt || Refesn || sawe
System
Information
Figura 6-96
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Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru | Functia
Tip Acesta include: programat, detectare miscare si alarma.
eveniment
Local A fost salvat pe cardul SD.
FTP Este salvat in serverul FTP.
NAS Este salvat in discul NAS.
6.4.2.2 Local

Interfata locala este prezentata ca in Figura 6-97.
Aici puteti vizualiza informatii locale despre cardul Micro SD sau discul NAS. De asemenea, puteti opera numai
citire, numai scriere, hot swap si formatare.

alhua

TECHNOLOGY

Camera

Bmteork Status Attribute Used Capacity/Total Capacity
Disk1 Normal Read & Wiile — | 6207.7TH/7573.1H
System
Infermation
Read Only | ‘ Read & Write ‘ | Hot Swap | | Refresh
Figura 6-97

6.4.23 FTP

Interfata FTP este prezentata ca in Figura 6-98.

Trebuie sa bifati caseta pentru a activa functia FTP. Cand are loc deconectarea de la retea sau exista o defectiune.
Stocarea de urgenta poate salva inregistrarea/fotografia pe cardul SD local. Faceti clic pe butonul de testare
pentru a verifica daca serverul FTP poate fi conectat pentru testare.
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Camera
Network

Event

> Schedule

> Record Control

System

Information

Manual de utilizare Dahua Network Camera Web 3.0

Path

Enable
Server Address |
Port 21 | (0~65535)
User Name -anonymity |
Password

Remote Directory share

Emergency (Local) e

Deraut || Reesn || saw

6.4.2.4 NAS

Figura 6-98

Trebuie sa bifati caseta pentru a activa functia NAS. Selectati NAS storage, completati adresa serverului NAS si
calea de stocare corespunzatoare, apoi puteti stoca fisiere video sau informatii picturale in serverul NAS.

Consultati Figura 6-99.

@Jhua

Camera
Network

Information

Path

Enable
Server Address

Remote Directory

Figura 6-99

Parametru

Functia

Adresa serverului

Setati adresa IP a serverului NAS.

La distanta
Director

Setati directorul de stocare, clipurile video si imaginile pot fi stocate in directorul serverului
corespunzator.

6.4.3 Controlul inregistrarilor
Interfata de control a inregistrarii este prezentata in figura 6-100.
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Camera Record Control

Netwerk
Event

Pack Duration

Manual de utilizare Dahua Network Camera Web 3.0

] Minute (1~120)

Fre-event Record 5 Second (0~5)
S Disk Full Overwrite [+]
_ Record Mode @ Auto © Manual &) Off
> Destination
Recard Control Record Stream Main Stream Iz‘
System Default | | Refresh | | Save
Information
Figura 6-100
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
Pachet Aici puteti selecta dimensiunea fisierului in intervalul Tmin~120min.
Durata Configurarea implicita este de 8 minute.
Pre- Va rugam sa introduceti aici valoarea de preinregistrare.

inregistrare

De exemplu, sistemul poate inregistra cele patru secunde video din buffer.
Inregistrarea incepe din a cincea secunda.

Nota:

Configurati timpul de preinregistrare, atunci cand apare alarma sau
detectarea miscarii, daca nu exista nicio inregistrare, sistemul va inregistra
inregistrarea din cele n secunde anterioare.

inregistrare

Disc plin Exista doua optiuni: opriti inregistrarea sau suprascrieti fisierele anterioare
atunci cand HDD-ul este plin.
®  Stop: HDD-ul de lucru curent este suprascris sau HDD-ul curent este
plin, se va opri inregistrarea.
®  Suprascriere: HDD-ul de lucru curent este plin; acesta va suprascrie
fisierul anterior.
Modul de Exista trei moduri: Auto/manual/inchidere.

Flux de
inregistrare

Exista doua optiuni: fluxul principal si fluxul secundar.

6.5 Sistem
6.5.1 Generalitati

Interfata generala este prezentata ca in Figura 6-101.
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@lhua T ———— . ——

Date&Time

Camera General

Network

Device Name YZCADZ021W00009
Event ot R i

Language English El

Video Standard PAL E|

TVOut Open E

Default ‘ | Refresh ‘ | Save

» PTZ ings
> Default

» Import/Export

> Upgrade

Information

Figura 6-101
V& rugdm sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
Numele Acesta este pentru a seta numele dispozitivului.

dispozitivului | Nota: Diferitele dispozitive au nume diferite.

Video Aceasta este pentru a afisa standardul video, cum ar fi PAL.
Standard

Limba Puteti selecta limba din lista derulanta.

TV Out Puteti deschide sau inchide functia, care poate fi sustinuta numai de

dispozitivele cu iesire TV.

® Functia inteligenta va fi dezactivata atunci cand este deschisa iesirea
TV.

® Se va inchide automat iesirea TV atunci cand functia inteligenta este
activata.

® Unele dispozitive accepta SDI si HDCVI.

Interfata Data si ora este prezentata ca in Figura 6-102.
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Camera
Network

Event
Storage

> Account
> PTZ Settings
> Default
> Import/Export
> Auto Maintain

> Upgrade

Information

General

General

Date Format
Time Format

Time Zone

[7] DST Enable
DST Type
Start Time

End Time

NTP Server

Port

Current Time

Update Period
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Date&Time

Year-Month-Day [~]
24-Hour-based System Iz‘
GMT+08:00 [=]

2000 - 05 - 22 19:37:19
@ Dale () Week

Jan [=][1 =] o0 - o0 -

Jan [=]2 =] oo : oo :

[C] Synchronize with NTP

clock.isc.org
123
10 Minute (0~30)

Default | | Refresh | | Save

Figura 6-102

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Parametru

Functia

Formatul datei

Aici puteti selecta formatul datei din lista derulanta.

Format de Exista doua optiuni: 24-H si 12-H.
timp
Fusul orar Zona orara a dispozitivului.

Ora curenta

Este pentru a seta ora sistemului. Acesta devine valabil dupa ce ati setat.

PC de
sincronizare

Puteti face clic pe acest buton pentru a salva ora sistemului ca ora curenta a
PC-ului.

Activare DST

Aici puteti seta ora de inceput si de sfarsit a orei de vara. Puteti seta in
functie de formatul datei sau al saptamanii.

Sincronizarea

Puteti bifa caseta pentru a activa functia NTP.

cu NTP

Server NTP Puteti seta adresa serverului de timp.

Port Acesta este pentru a seta portul serverului de timp.

Perioada de Seteaza perioadele de sincronizare intre dispozitiv si serverul de timp.
actualizare
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6.5.2 Cont

® Pentru numele de utilizator si grupul de utilizatori, lungimea maxima este de 31 de caractere, care pot fi
formate din cifra, literd, subliniere, cratima, punct si @.

® Parola poate avea intre 0 si 32 de caractere, numai cifre si litere. Utilizatorul poate modifica parola altui
utilizator.

®  Utilizatorul si grupul pot fi adaugate manual la 18 si respectiv 8.

® Gestionarea utilizatorilor adoptd modul grup/utilizator. Numele utilizatorului si numele grupului trebuie sa fie
unice. Un utilizator poate fi inclus intr-un singur grup.

®  Utilizatorul conectat Tn prezent nu isi poate modifica propriul drept.

6.5.2.1 Utilizator
In aceasté interfatd puteti activa autentificarea anonimé, adauga/elimina utilizator si modifica numele de utilizator. A
se vedea figura 6-103.

alhua

~ TECHNOLOGY

Camera Account

Network

[C] Anonymous Login

Event
User Name

Storage

No. Remark

1 admin admin admin 's account % -]

» General

> Seftings

> Default
> Import/Export
» Auto Maintain
> Upgrade -
Information Authority List

Live Playback Record Control Backup PTZ Account

Alarm Log Search Clear Log Upgrade Auto Maintain General

Video/Audio Schedule/Destination Network Abnormality Video Detect PTZ Settings

Default/import/Export Conditions Vs

Figura 6-103

Activati autentificarea anonima: Activati autentificarea anonima si introduceti IP-ul. Nu este necesar niciun

nume de utilizator sau parola, va puteti conecta prin anonimat (cu drepturi limitate). Puteti face clic pe logout

pentru a va incheia sesiunea. Adaugati utilizator: Permite addugarea unui nume la grup si setarea drepturilor
utilizatorului. A se vedea figura 5-86.

Utilizatorul ascuns "implicit" este destinat exclusiv utilizarii in interiorul sistemului si nu poate fi sters. Atunci cand nu
exista niciun utilizator de conectare, utilizatorul ascuns "implicit" se conecteaza automat. Puteti seta anumite
drepturi, cum ar fi monitor, pentru acest utilizator, astfel incat sa puteti vizualiza anumite canale fara a va conecta.
Aici puteti introduce numele de utilizator si parola si apoi puteti selecta un grup pentru utilizatorul curent.

Va rugam sa retineti ca drepturile de utilizator nu trebuie sa depaseasca configurarea drepturilor de grup.
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Pentru o configurare convenabild, asigurati-va ca utilizatorul general are drepturi de configurare mai mici decéat
administratorul.

Add User

Iser Mame
Passward

Canfirm Passwaord

Group IEE|I'|'|iI'| j
Remark
Authority List I Al
V¥ Live i’
¥ Playback
V¥ Record control
¥ Backup B
Save Cancel
Figura 6-104

Modificare utilizator

Se modifica proprietatea utilizatorului, grupul de apartenenta, parola si drepturile. A se vedea figura 6-105.
Modificarea parolei

Aceasta este pentru a modifica parola utilizatorului. Trebuie sa introduceti vechea parola si apoi sé introduceti noua
parola de doua ori pentru a confirma noua configurare. Va rugam sa faceti clic pe butonul OK pentru a salva.

Va rugam sa retineti ca parola variaza de la 0 la 32 de cifre. Aceasta trebuie sa includa numai cifre si litere.
Utilizatorul care are drepturi de cont poate modifica parola altor utilizatori.
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Modify User

User Mame

™ Modify Password
Group
Femark

Authority List

|E|dmin j

|a:!min j
admin s account
I A
M Live
¥ Playback
¥ Record contral

¥ Backup

Save Cancel
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6.5.2.2 Grup

Figura 6-105

Interfata de gestionare a grupului poate adauga/elimina grupul, modifica parola grupului etc. Interfata

este prezentata ca in figura 6-106.

@hua

- TECHNOLOGY

Camera Account

Network o
7] Anonymous Login

Event
User hame Group

Storage Group Name: Remark Modify Delete
admin administrator group 2 (—]
2 user user group =
> P1Z
> Default
> Import/Export
> Auto Maintain
» Upgrade Al
Information Authority List
Live Playback Record Control Backup PTZ Account
Alarm Log Search Clear Log Upgrade Auto Maintain General
VideolAudio Schedule/Destination Metwork Abnormality Video Detect PTZ Settings
Defaultimport/Export Conditions Vs
Figura 6-106

Adaugare grup: Se adauga un grup si se stabilesc drepturile corespunzitoare. A se vedea figura 6-107.
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Va rugam sa introduceti numele grupului si apoi bifati caseta pentru a selecta drepturile corespunzatoare. Acestea
includ: previzualizare, redare, control inregistrare, control PTZ etc.

Add Group

Group

Remark

Modificarea grupului

Authority List

[ an
I Live fi
" Playback
" Record control
™ Backup E
Save Cancel
Figura 6-107

Faceti clic pe butonul de modificare a grupului, puteti vedea o interfatd prezentata ca in Figura 6-
108. Aici puteti modifica informatiile grupului, cum ar fi observatiile si drepturile.

6.5.3 PTZ

Modify Group [ X
Group Iatlmin j
Remark adrinistrator group
Authority List ¥ Al
W Live fi
¥ Playback
¥ Record contral
¥ Backup E
Save Zancel
Figura 6-108

Va rugam sa retineti ca numai unele produse de serie suporta aceasta functie.
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Interfata setarilor PTZ este prezentata ca in Figura 6-109.

@lhua

Camera PTZ Settings

Hotwors Protacol

Event
Address

Storage
Baudrate

" Data Bit
> General

> Account Stop Bit
__Pizsetings pany
> Default
> Import/Export

> Auto Maintain

> Upgrade

Information
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PELCOD

Figura 6-109
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru | Functia
Protocol Selectati protocolul dome corespunzator.
Adresa Setati adresa domei corespunzatoare. Valoarea implicita este 1.
Va rugam sa retineti ca configurarea dvs. de aici trebuie sa fie Tn conformitate
cu adresa domului; Tn caz contrar, nu puteti controla domul de viteza.
Baud Rate | Selectati rata de baud a domului. Setarea implicita este 9600.
Bit de date | Setarea implicita este 8.
Bit de oprire | Setarea implicita este 1.
Paritate Configurarea implicita este niciuna.

6.5.4 Implicit

Interfata de configurare implicita este prezentata in Figura 6-110.
Va rugam sa retineti ca sistemul nu poate restaura anumite informatii, cum ar fi adresa IP a retelei, contul si asa

mai departe.
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Camera Default

Network
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Event At

Storage

> General
> Account
> PTZ Settings
> ull
> Import/Export
> Auto Maintain
> Upgrade

Information

6.5.5 Import/Export

Figura 6-110

Interfata este prezentata ca in Figura 6-111.

Camera Import/Export

LR Backup Path

Event

Import

Storage

> General
> Account
> PTZ Settings
> Default

> Auto Maintain

> Upgrade

Information

Figura 6-111
Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.
Parametru Functia
Import Acesta este pentru a importa fisierele de configurare locale in sistem.
Export Acesta este pentru a exporta configuratia de sistem corespunzatoare pe
PC-ul local.

5.5.6 Telecomanda

Nota:

Acesta este acceptat de unele dispozitive.
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anua (TR gy ST (VTR S

@

Camera Remote
Network

Event Learn Remote hat | Learn

Storage

ArmiDisarm |Arm j |1l]5

» General
> Account
> Default
> Import/Export

> Auto Maintain

> Upgrade
Information

Figura 6-112

Parametru Functia
Invatati ) . . _

Legatura telecomenzii sau a alarmei fara fir cu echipamentul.
Clar . :

Dezlegati telecomanda cu echipamentul.

Porniti armarea dupa ora aleasa, dezarmarea intra Tn vigoare imediat. Nota:
Armare/Dezarmare Cu starea de dezarmare, toate alarmele urmatoare nu se vor declansa: alarma de detectare

a miscarii, alarma de mascare, alarma locala, alarma PIR, alarma wireless.

6.5.6 intretinere auto

Interfata de intretinere automata este prezentata in Figura 6-113.
Aici puteti selecta intervalul de repornire automata si de stergere automata a fisierelor vechi din lista derulanta.

Daca doriti sa utilizati functia de stergere automata a fisierelor vechi, trebuie sa setati perioada de fisier.

Camera Auto Maintain
HsEaDk [¥] Auto Reboot Tuesday

Event
[[] Auto Delete Old Files

Manual Reboot

Refresh | ‘

Storage

> General

> Account
> PTZ Settings
> Default
> Import/Export

> Upgrade

Information

Figura 6-113
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Parametru Functia
Repornire Verificati-I si setati timpul de repornire automata.
automata
Stergere
automata a Verificati si stabiliti perioada Tn intervalul 1~31 de zile.
fisierelor vechi

6.5.7 Actualizare

Interfata de actualizare este prezentata ca in Figura 6-114.
Va rugam sa selectati fisierul de actualizare (extensia fisierului este ".bin") si apoi faceti clic pe butonul de

actualizare pentru a incepe actualizarea firmware-ului.

Important
Programul de actualizare necorespunzator poate duce la defectarea dispozitivului!

@Jhua

Camera Upgrade

Metmor Select Firmware File

Event

Storage

> General
> Account
> PTZ Seftings
> Default
> Impori/Export
> Auto Maintain

Information

Figura 6-114

6.6 Informatii

6.6.1 Versiune

Interfata versiunii este prezentata ca in Figura 6-115.
Aici puteti vizualiza caracteristicile hardware ale sistemului, versiunea software, data lansarii etc. Va rugam sa

retineti ca urmatoarele informatii sunt doar pentru referinta.

@lhua

Camera Version

Network

Device Type IPC-HF3300

Event
Software Version 2.420.0000.0.R, build : 2014-03-14

Storage
WEB Version 3.2.1.175653
System
_ ONVIF Version 241
SN PZC1EW24200002

_ Versior
> Log

Copyright 2011,All Rights Reserved

> Online User

Figura 6-115
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6.6.2 Jurnal

Aici puteti vizualiza jurnalul sistemului. Consultati Figura 6-116.

@Jhua

Camera

Herwork Start Time | 2014 - 03 - 30 || 11 - 17 - 02 EndTime | 2014 - 03 - 31 |[ 11 - 17 : 02
SR No. Log Time User Name Event
System
> Online User
Detailed Information
M41/1p MGoTo (%)
Figura 6-116
Va rugam sa consultati urméatoarea fisa pentru informatii privind parametrii jurnalului.
Parametru Functia
Ora de Setati ora de incepere a jurnalului solicitat. (Cea mai veche ora este 2000/1/1)
incepere
Ora de sfarsit | Seteaza ora de sféarsit a jurnalului solicitat. (Cea mai recenta ora este
2037/12/31)
Tip Tip jurnal.
Cautare Puteti selecta tipul de jurnal din lista derulanta si apoi faceti clic pe butonul

de cautare pentru a vizualiza lista.
Puteti face clic pe butonul de oprire pentru a incheia operatiunea de cautare

curenta.
Informatii Puteti selecta un element pentru a vizualiza informatiile detaliate.
despre jurnal
Clar Puteti face clic pe acest buton pentru a sterge toate fisierele jurnal afisate.
Va rugam sa retineti ca sistemul nu accepta stergerea in functie de tip.
Backup Puteti face clic pe acest buton pentru a copia de rezerva fisierele jurnal pe

PC-ul curent.

6.6.3 Utilizator online

Interfata online a utilizatorului este prezentata in Figura 6-117.
Aici puteti vizualiza utilizatorul online curent, numele grupului, adresa IP si ora de conectare.
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@hua

@hua

Camera Online User

IP Address User Login Time
10.18.116.47 2000-05-22 18:33:46

Network . User Local Group
Event 1 admin admin
Storage

System

> Version

> Log

Figura 6-117

www.ultramaster.ro 138



@hua

7 Alarma
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Va rugam sa retineti ca unele produse de serie nu accepta aceasta functie.

Faceti clic pe functia de alarma, puteti vedea o interfata prezentata ca in Figura 7-1.
Aici puteti seta tipul de alarma al dispozitivului si configurarea sunetului de alarma.

@

Alarm Type No. Time Alarm Type Alarm Channel

[] Motion Detection 7] DiskFull

[ Disk Error [] Video Tampering

[] External Alarm [] Wegal Access

[] Audio Detection 1 vs

[C] Scene Changing
Operation

71 Prompt
Alarm Tone

[7] Play Alarm Tone

Va rugam sa consultati urmatoarea fisa pentru informatii detaliate.

Tip

Parametru

Functia

Tip de
alarma

Detectarea miscarii

Sistemul alarmeaza atunci cand apare alarma de
detectare a miscarii,

Discul este plin

Sistemul alarmeaza atunci cand discul este plin.

Eroare disc Sistemul inregistreaza informatii de alarma atunci cand
se produce o eroare de disc.

Video Sistemul alarmeaza atunci cand imaginile video sunt

Manipularea falsificate.

Alarma externa

Dispozitivul de intrare a alarmei trimite o alarma.

Acces ilegal

Sistemul alarmeaza atunci cand exista acces ilegal.

Detectarea audio

Sistemul alarmeaza atunci cand exista detectare audio.

IVS

Sistemul alarmeaza atunci cand este declansat un
eveniment IVS.

Schimbarea scenei

Sistemul va Tnregistra informatii despre alarma atunci
cand declanseaza schimbarea scenei.

Tip

Parametru

Functia
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Functionare

Prompt

Atunci cand se declanseazé o alarma, in meniul

principal al interfetei de alarma va aparea SE , iar
sistemul Tnregistreaza automat informatiile despre
alarma. Pictograma dispare atunci cand utilizatorul face
clic pe bara de meniu a alarmei.

Nota:

Daca este afisata interfata de alarma, atunci cand alarma
este declansata, nu va exista nicio imagine prompta, dar
inregistrarea alarmei va fi in lista din dreapta.

Tone de
alarma

Redarea tonului de
alarma

Faceti clic pe acesta si selectati calea fisierului audio
care urmeaza sa fie redat in calea tonului, atunci cand
se declanseaza evenimentul de alarma subscris, acesta
va reda fisierul audio selectat pentru a va anunta ca a
fost declansat un eveniment de alarma.

Tone Path

Puteti personaliza calea de stocare a tonului de alarma.
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8 Deconectare

Faceti clic pe butonul de deconectare, sistemul revine la interfata de conectare. A se vedea figura 8-1.

Usemame: | admin

Password:

Figura 8-1
Nota
®  Acest manual este doar pentru referinta. In interfata cu utilizatorul pot exista usoare diferente.
® Toate modelele si software-ul de aici pot fi modificate fara notificare scrisa prealabila.
® Toate marcile comerciale si marcile comerciale inregistrate mentionate sunt proprietatea proprietarilor lor
respectivi.
® Daca exista vreo incertitudine sau controversa, va rugadm sa consultati explicatia finala a noastra.
® Varugam sa vizitati site-ul nostru pentru mai multe informatii.

@hua

Zhejiang Dahua Vision Technology Co., Ltd

Adresa : No.1199 Bin"an Road, Binjiang District, Hangzhou, RPC.
Cod postal: 310053

Tel: +86-571-87688883

Fax: +86-571-87688815
Email:overseas@dahuatech.com

Site web: www.dahuasecurity.com
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